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Technical Support
How to Get Technical Support
Start with your manuals
Themanuals supplied byMTS providemost of the information you need to use andmaintain your
equipment. If your equipment includes software, look for online help and README files that contain
additional product information.

Technical support methods
MTS provides a full range of support services after your system is installed. If you have any questions
about a system or product, contact Technical Support in one of the following ways.

Type of
Support Details

Web site www.mts.com > Contact Us > In theSubject field, choose To escalate a problem;
Problem Submittal Form

E-mail Worldwide: tech.support@mts.com
Europe: techsupport.europe@mts.com

Telephone Worldwide: 1 800 328 2255 - toll free in U.S.; +1 952 937 4000 - outside U.S.
Europe: +800 81002 222, International toll free in Europe

Outside the U.S.
For technical support outside the United States, contact your local sales and service office. For a list of
worldwide sales and service locations and contact information, use theGlobal MTS link at theMTS
web site:

www.mts.com > About MTS Systems > Global Presence > Choose a Region

Before You Contact MTS
MTS can help youmore efficiently if you have the following information available when you contact us
for support.

Know your site number and system number
The site number contains your company number and identifies your equipment type (such asmaterial
testing or simulation). The number is typically written on a label on your equipment before the system
leavesMTS. If you do not know your MTS site number, contact your sales engineer.

Example site number: 571167
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When you havemore than oneMTS system, the system job number identifies your system. You can
find your job number in your order paperwork.

Example system number: US1.42460

Know information from prior technical assistance
If you have contactedMTS about this problem before, we can recall your file based on the:

l MTS case number

l Name of the person who helped you

Identify the problem
Describe the problem and know the answers to the following questions:

l How long and how often has the problem occurred?

l Can you reproduce the problem?

l Were any hardware or software changesmade to the system before the problem started?

l What are the equipment model numbers?

l What is the controller model (if applicable)?

l What is the system configuration?

Know relevant computer information
For a computer problem, have the following information available:

l Manufacturer’s name andmodel number

l Operating software type and service patch information

l Amount of systemmemory

l Amount of free space on the hard drive where the application resides

l Current status of hard-drive fragmentation

l Connection status to a corporate network

Know relevant software information
For software application problems, have the following information available:

l The software application’s name, version number, build number, and (if available) software
patch number. This information can typically be found in the About selection in the Helpmenu.

l The names of other applications on your computer, such as:

l Anti-virus software

l Screen savers

l Keyboard enhancers

l Print spoolers

l Messaging applications
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If You Contact MTS by Phone
A Call Center agent registers your call before connecting you with a technical support specialist. The
agent asks you for your:

l Site number

l Email address

l Name

l Company name

l Company address

l Phone number where you can be reached

If your issue has a case number, please provide that number. A new issue will be assigned a unique
case number.

Identify system type
To enable the Call Center agent to connect you with themost qualified technical support specialist
available, identify your system as one of the following types:

l Electrodynamicmaterial test system

l Electromechanical material test system

l Hydromechanical material test system

l Vehicle test system

l Vehicle component test system

l Aero test system

Be prepared to troubleshoot
Prepare to perform troubleshooting while on the phone:

l Call from a telephone close to the system so that you can implement suggestionsmade over
the phone.

l Have the original operating and application softwaremedia available.

l If you are not familiar with all aspects of the equipment operation, have an experienced user
nearby to assist you.

Write down relevant information
In case Technical Support must call you:

l Verify the case number.

l Record the name of the person who helped you.

l Write down any specific instructions.
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After you call
MTS logs and tracks all calls to ensure that you receive assistance for your problem or request. If you
have questions about the status of your problem or have additional information to report, please
contact Technical Support again and provide your original case number.

Problem Submittal Form
Use the ProblemSubmittal Form to communicate problemswith your software, hardware, manuals, or
service that are not resolved to your satisfaction through the technical support process. The form
includes check boxes that allow you to indicate the urgency of your problem and your expectation of an
acceptable response time.We guarantee a timely response—your feedback is important to us.

You can access the ProblemSubmittal Form at www.mts.com > Contact Us (upper-right corner) > In
theSubject field, choose To escalate a problem; Problem Submittal Form
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Preface
Before You Begin
Safety first!
Before you use your MTS product or system, read and understand the safety information provided with
your system. Improper installation, operation, or maintenance can result in hazardous conditions that
can cause severe personal injury or death, or damage to your equipment and specimen. Again, read
and understand the safety information provided with your system before you continue. It is very
important that you remain aware of hazards that apply to your system.

Other MTS manuals
In addition to thismanual, youmay receive additional manuals in paper or electronic form.

Youmay also receive anMTS SystemDocumentation CD. It contains an electronic copy of the
manuals that pertain to your test system.

Controller and application softwaremanuals are typically included on the software CD distribution disc
(s).

Documentation Conventions
The following paragraphs describe some of the conventions that are used in your MTSmanuals.

Hazard conventions
Hazard noticesmay be embedded in thismanual. These notices contain safety information that is
specific to the activity to be performed. Hazard notices immediately precede the step or procedure that
may lead to an associated hazard. Read all hazard notices carefully and follow all directions and
recommendations. Three different levels of hazard noticesmay appear in your manuals. Following are
examples of all three levels. (for general safety information, see the safety information provided with
your system.)

Danger: Danger notices indicate the presence of a hazard with a high level of risk which, if
ignored, will result in death, severe personal injury, or substantial property damage.

Warning: Warning notices indicate the presence of a hazard with amedium level of risk
which, if ignored, can result in death, severe personal injury, or substantial property damage.

Caution: Caution notices indicate the presence of a hazard with a low level of risk which, if
ignored, could causemoderate or minor personal injury or equipment damage, or could
endanger test integrity.
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Other special text conventions

Important:

Important notices provide information about your system that is essential to its proper function.
While not safety-related, if the important information is ignored, test resultsmay not be reliable,
or your systemmay not operate properly.

Note:

Notes provide additional information about operating your system or highlight easily
overlooked information.

Recommended:

Recommended notes provide a suggested way to accomplish a task based on what MTS has
found to bemost effective.

Tip:

Tips provide helpful information or a hint about how tomost efficiently accomplish a task.

Access:

Access provides the route you should follow to a referenced item in the software.

Example: Examples show specific scenarios relating to your product and appear with a shaded
background.

Special terms
The first occurrence of special terms is shown in italics.

Illustrations
Illustrations appear in thismanual to clarify text. They are examples only and do not necessarily
represent your actual system configuration, test application, or software.

Electronic manual conventions
Thismanual is available as an electronic document in the Portable Document File (PDF) format. It can
be viewed on any computer that has Adobe Acrobat Reader installed.

Hypertext links
The electronic document hasmany hypertext links displayed in a blue font. All blue words in the body
text, along with all contents entries and index page numbers, are hypertext links. When you click a
hypertext link, the application jumps to the corresponding topic.
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Introduction to TW Essential
MTS TWEssential (TWS) provides streamlined test design and execution for electromechanical and
static hydraulic testing. TWS is for systems equipped with MTS Insight andMTS Insight+ controllers.

TWE and other MTS Software Applications
TWS functionality is based on the robust feature set of MTS TestSuite TW Elite (TWE). TWS look-
and-feel is based on the streamlined test flow of MTS TestWorks 4 (TW4).

Template Compatibility
All templates created with TWE can run on TWS. All standard templates provided byMTS, except
Multicycle andMultihead templates, are editable in TWS. In addition, the legacy converter can convert
TW4method/samples into template/tests that can be edited in TWS.

Using TWE for Advanced Features
Using some advanced features in TWS, such as creating arrays and enabling remote start, requires
the extended editing capabilities of TWE. For more information, contact anMTS Service Engineer.

Overview of MTS TestSuite File Structure
TheMTS TestSuite file hierarchy comprises several individual components. Each component stores a
specific set of information. For example, a test contains a set of activities (known as the procedure),
and the test run contains the data acquisition information and variable values that were obtained when
the test was run. Furthermore, each component has a relationship with at least one other component.

In the following table, each of themain components of theMTS TestSuite structure are described. In
the following sections of this document, the data stored in these components and the relationships
between these components is described in detail.

Name Icon Description

Project A project is a collection of tests and test templates. By creating separate projects,
you can organize similar tests and test templates and various project-level
settings, such as the language or unit types used.

Test A test is the core component of MTS TestSuite software. The test contains the
test definition along with any test runs, analysis definitions, or analysis runs that
have been created.

Test
Template

Test templates eliminate the need to re-create existing information and provide an
easyway to run standard tests.

Test run A test run contains all data that was gathered during a single run of the test.

Components of the MTS TestSuite Architecture
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Project
A project is the highest level component in theMTS TestSuite file heirarchy. A project contains the
following:

l A collection of tests

l A collection of test templates

l Project settings, such as the name and location of directories in which the tests, test
templates, report templates, external files, and data exports are stored

To view or edit your available projects and their associated settings, clickPreferences, select
Configuration, and then select theProject tab. The other tabs on the Configuration window contains
settings that are application-wide and persist regardless of which project you have selected.

A Project Contains Project Settings, Tests, and Test Templates

Test
A Test is stored within a project folder, and contains the following components:

l Test Definition—Contains themain components of the test, such as the procedure,
variables, resources, functions, and report templates.

l Test Run(s)—Contains information that was gathered during the test run, such as variable
values.
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A Test Contains the Test Definition and Test Run(s)

Test Definition
The test definition is stored within the test. The test definition contains the followingmain components
that define the test:

l Procedure—A collection of test activities that are performed step-by-step when the test is
run.

l Resources—A collection of test resourcesmapped to the controller resources that will be
used during the test.

l Variables/ Inputs / Calculations—Containers that can hold values that may change during
the test run, such as time or axial displacement. Variables facilitate datamanipulation and
communication between different components of the test.
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Note: Variablesmay also be referred to as Inputs, Input Variables, orCalculations.
l Test-Run chart—A customizable user interface that shows data when the test is run.

l Report templates—A collection of Microsoft Excel Template files that define the layout of
generated reports.

l Functions—A sequence of instructions that receives arguments and produces a result.

Test Run
A test run is the record of a test performed on a single, selected specimen. Test runs are stored in the
test and include:

l A copy of the test definition, including the procedure, at the time the test run is created.

l A copy of the name of the selected specimen and its values at the time the test run is created.

l Input values during the test run.

l The state of the test run.

l Results data, such as data acquisitions and calculations.
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Components of a Test Run
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TW Essential Application Main Window
Themain window of the TWS application is divided into the following sections:

l The top section containsmenus, toolbar, a system control panel, and test status information.

l The left section contains the test definition tree, which is used to guide your progress as you
define your test.

l Themiddle section contains panels for project editing.

l The bottom section contains theMeters, Error List,Application Log, and Test Log panels.

TWS Main Window
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Item Name Description

1 Menu bar
andQuick
Access
panel

Providesmenus and quick-access icons that allow you to perform tasks such
as opening tests, opening tests from templates, and saving tests as templates.

2 Controller
panel

Allows you to reset or override interlocks, display fault status, view the direction
in which the crosshead ismoving, position the crosshead, and start, stop, and
hold the test. If your system has a clutch, the clutch indicator also appears (not
shown).

Note:When control is provided by a handset, the controls will be locked
and overlaid by the Handset Exclusive Control icon:

3 Crosshead
Controls
panel

Allows you tomanually position the crosshead. You can configure the Jog and
Return buttons at Preferencesmenu > Configuration > Control Panel tab.
For more information, see “Crosshead Controls Panel” on page 270.

4 Test
Controls
panel

The Test Controls buttons allow you to start, pause, and stop the test.

5 Test Run
Status
panel

Shows test run information, including name, status, and running time. This
panel includes a control that allows you to terminate the current test run.

6 Tabs The various tabs and subtabs across the display are used to select a test,
define a test, monitor a test, and review test results.

7 Test
definition
tree

On theDefine tab, the test definition tree has two navigationmodes. The two
navigationmodes areAdvanced Mode andBasic Mode.Advanced Mode
shows the entire test definition tree.Basic Mode shows a simplified version of
the test definition tree.

8 Toolbox
panel

The Toolbox panel appears when you click theDefine > Test flow > Test
run > Procedure tab. The Toolbox panel contains a list of all activities
available when designing tests.

9 Work area This is the work area in which you performmost of the tasks associated with
the test definition tree.When designing a test, you can view the workflow in a
Flowchart View or anOutline View by selecting the appropriate toggle button
next to the search box. To quickly locate an activity in a large procedure, you
can use the search box.

Main Window Options
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Item Name Description

To create a test, drag test activities from the Toolbox panel to the work area.

10 Properties
panel

Allows you to define or change the information, characteristics, and
appearance of the selected procedure activities and runtime display
components. For example, you can use theProperties panel to change the
amplitude of aGo To + DAQ + Detection command test activity in a
procedure.

11 Meters TheMeters show the current numeric value of the selected signal. The two
default meters show load and crosshead extension. Right-click themeter to
add or remove ameter, reset, change units or decimal places, and to configure
the properties.

12 Error List TheError List shows error and warningmessages that describe both critical
and non-critical conditions in the test definition. TheError List is dynamic and
changes according to the part of the application you are using.

13 Application
Log

TheApplication Log shows status information about application events in
recent history, such as logging into the application, exiting the application, and
interlock conditions present prior to opening tests. The application stamps each
message with the type of message, generation date, and time. You can type
notes into theMessage Log, clear the log, and export the contents to a
Microsoft Excel file. Messages persist from one session to another.

14 Test Log The Test Log shows status information about test events for the current test,
such as changes in program states. The application stamps eachmessage
with the type of message, generation date, and time. You can type notes into
the Test Log, clear the log, and export the contents to aMicrosoft Excel file.
Messages persist from one session to another.

General Conventions
Entry-Type Toggle Button
The entry-type toggle button appears throughout the application. The following table indicates the icon
and itsmeaning. Click the button to toggle between two entry options.

Icon Description

Input selection; click to select or enter a input.

Item selection; click to select an item from the drop-downmenu.

Direct numeric entry; click to enter a numeric value.

Variable Toggle Buttons
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Copy and Paste
You can copy tabular data, charts, chart data, functions, and variables to the clipboard.

Charts
To copy a chart or test control, right-click the item and clickCopy orCopy Image to the Clipboard.

Chart data
To copy data values from a chart instead of the chart image, right-click the chart and clickCopy
Values to the Clipboard.

Tabular data
To copy an entire log or table, right-click the item, clickSelect All, and pressCtrl+c to copy orCtrl+x
to cut, or right-click again and clickCopy.

To copy a single row of a log or table, double-click the row to select it, right-click at the same location,
and selectCopy.

You can select a block of rows two ways:

l Click in the column at the first row of the block, hold themouse button down, roll over the block
of rows, and release themouse button. Right-click and selectCopy.

l Select the first row of the block, press and hold theShift key, and select the last row of the
block. Right-click and selectCopy.

To select multiple rows that are not in a block, hold theCtrl key and click in the column at each row you
want to select. Right-click and selectCopy.

Naming Conventions

Unique names
In general, the components you create and name in the application, such as report templates and
tests, must have unique nameswithin the test. Components that are stored within the test, such as
variables, and procedure activitiesmust also have unique names.

For items that require unique names, the naming restrictions and the scope of the uniqueness vary by
type of item.

Variable identifier name
The following guidelines apply for naming a variable identifier:

l It must be unique within the test.

l It is not case-sensitive.

l It can contain both alphabetical and numeric characters.

l It can contain a hyphen (-) or underscore (_).

l It cannot contain spaces, apostrophes, quotes, or other special characters.

l It cannot start with a number.
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Variable display name
The following guidelines apply for naming a variable display name:

l It must be unique within the test but canmatch its variable identifier.

l It is case-sensitive.

l It can contain both alphabetical and numeric characters.

l It can contain special characters, including spaces, apostrophes, quotes, or other special
characters.

l It can start with a number or special character.

Project name
The following guidelines apply for naming a project:

l The namemust be unique among existing projects.

l It is case-sensitive.

l It must follow Microsoft file naming conventions and restrictions.

l It can contain both alphabetical and numeric characters.

l It can contain spaces, commas, ‘-’, ‘_’, ‘.’, ‘!’, ‘@’, ‘#’, ‘$’, ‘%’, ‘^’, ‘(’, ‘)’, ‘=’, ‘+’, ‘;’, ‘~’, ‘{’, and ‘}’.

l It cannot contain apostrophes, quotes, ‘&’, ‘*’, ‘[’, ‘]’, ‘:’, ‘|’, ‘<’, ‘>’, ‘\’, ‘/’, and ‘?’.

l It can start with a number or special character.

Test name
The following guidelines apply for naming a test:

l It is case-sensitive.

l It can contain both alphabetical and numeric characters.

l It can contain spaces, ‘-’, ‘_’, ‘.’, ‘!’, ‘@’, ‘#’, ‘%’, ‘^’, ‘(’, ‘)’, ‘=’, ‘+’, and ‘;’.

l It cannot contain apostrophes, quotes, ‘$’, ‘*’, ‘[’, ‘]’, ‘:’, ‘|’, ‘<’, ‘>’, ‘\’, ‘/’, and ‘?’.

l It can start with a number or special character.

Procedure activity name
The following guidelines apply for naming a procedure activity:

l It must be unique within a given path, such as a parallel path, conditional (If-Then) path, or
main procedure path.

l It is case-sensitive.

l It can contain both alphabetical and numeric characters.

l It can contain special characters, including spaces, apostrophes, quotes, or other special
characters.

l It can start with a number or special character.
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Runtime display activity name
The following guidelines apply for naming a runtime display activity:

l It is case-sensitive.

l It can contain both alphabetical and numeric characters.

l It can contain spaces, apostrophes, quotes, or other special characters.

l It can start with a number or special character.

Report template name
The following guidelines apply for naming a report template:

l It is case-sensitive.

l It must follow Microsoft file naming conventions and restrictions.

l It can contain both alphabetical and numeric characters.

l It can contain spaces, apostrophes, ‘-’, ‘_’, ‘.’, ‘!’, ‘@’, ‘#’, ‘$’, ‘%’, ‘^’, ‘&’, ‘*’, ‘(’, ‘)’, ‘{’, ‘}’, ‘=’, ‘+’, ‘;’,
and ‘~’.

l It cannot contain quotes, ‘[’, ‘]’, ‘:’, ‘|’, ‘<’, ‘>’, ‘\’, ‘/’, and ‘?’.

l It can start with a number or special character.

Tables
Sort Columns
To sort table columns:

1. To sort the table by the order of information in a column, click the column header cell.

A down-arrow indicates descending order. An up-arrow indicates ascending order.

2. To reverse the sort order for information in a column, click the column header cell again.

Filter Data
Use the column filter to select the data you want to see and hide the rest. A filter changes only the
display. The data does not change.

1. To apply a filter, click the filter icon in the column header to open the Filtermenu.
The filter menu lists all of the unique values in that column. Themenu also provides options for
showing values that are blanks or not blanks.
Themenu also provides a Custom filter. You can specify logical operators such as “All”,
“Custom”, and “Read-Only” in the Operator column. “MatchesRegular Expression” uses the
.NET standard expression syntax.

2. Select a specific value to show all table entries that have the value or that meet the criteria.

For example, if the table has a Units column and you want to filter the current view of the table
to only show those rows that have Units of mm, selectmm in the Filtermenu for the Units
column.



Introduction

MTS TestSuite™ TWEssential User Guide 31

If you select a custom filter operator, select an operator and an operand. For example, you
select the Value column and Custom filter. Select the operatorDoes not equal and operand
0.000. The result is that the table shows the rows that have non-zero values. You can increase
the criteria by clickingAdd a condition and selecting another operator and operand. You can
increase the filter further by applying filters to additional columns.

3. To display all table values, select theAll command on the Filtermenu.

Docking and Undocking Panels
Undocking and Docking Panels Overview
You can open and arrangemultiple panels at the same time in your workspace. Moving panels around
the screen is referred to as undocking or floating. Undocked panels are active, and you can perform
actions in them. For example, you can undock a view and thenmodify the display properties.

Symbol Description

Up Arrow Highlights the top of the work area and docks the panel as a separate work area in the
highlighted area.

Right
Arrow

Highlights the right side of the work area and docks the panel as a separate work area in
the highlighted area.

Left
Arrow

Highlights the left side of the work area and docks the panel as a separate work area in
the highlighted area.

Down
Arrow

Highlights the bottom of the work area and docks the panel as a separate work area in
the highlighted area.

Work
Area

Highlights the work area and docks the panel as a separate tab in the highlighted work
area.

Docking Symbols

If you havemultiple monitors, the panel docks on the device to which themouse is pointing.

Undocking a Panel
To undock a panel:

1. Click on the tab or title bar of the panel you want to undock.

2. Drag the view to where you want it.

Arrows appear on the screen that indicate that you have undocked a panel. You do not have
to use the arrow buttons to undock a panel.
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Undocking a Panel

3. Resize the panel as necessary.

4. Repeat the previous steps to undock other panels as necessary.

Docking a Panel
To dock a panel:

1. Drag any side or corner of the panel.

Docking symbols appear in themiddle and on each side of the work area that indicate that you
have undocked a panel.

Docking Symbols

2. When your mouse pointer reaches a docking symbol, a region of the work area becomes
highlighted. To dock the panel in that region, release your mouse.

Note: There can bemultiple work areas, each with its own set of docking symbols.
If you havemultiple monitors, the panel docks on the device to which themouse is pointing.

3. Repeat the previous steps to dock other panels as necessary.

Manage MTS TestSuite Files
MTS TestSuite Folders and Files Management Overview

Access
Preferencesmenu > Configuration > Project tab (default location)

In most cases, themanagement of TestSuite files is done using theMTS TestSuite application. Some
files, such as templates and reports, can bemanaged using theWindows operating system.
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Caution: Using theWindowsOS tomanipulate the files in a test folder can corrupt the test
and its associated files.

Corrupting the test canmake the test unusable and/or result in the loss of test-run data.

Do not manipulate any of the files in the test folder. Any changes to the test should be performed
using the TestSuite application.

MTS TestSuite folders

File type Folder
Extension

From TestSuite
Application

From
Windows
Explorer

Legacy Templates

Note: Once a legacy template is
converted, it has a .TSTemplate
extension and can bemanaged like
other templates.

.Test*
(v2.0 or
earlier)

.Project
(v1.6 or
earlier)

New test from
template, save as

No file
manipulation
allowed except
delete

Project Directory Files .Project Import legacy
projects (v1.6 or
earlier), new, open,
delete

No file
manipulation
allowed except
delete

Test .Test New, open, save as,
delete

No file
manipulation
allowed except
delete

MTS TestSuite Folder Management

*

When usingWindowsXP to view TestSuite folders, the folder names are determined by the TestSuite
application’s naming convention and are appended with the folder extension.When usingWindows 7
or WindowsVista to view TestSuite folders, the folder names are the user-defined display names and
the file extensions do not appear.
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MTS TestSuite files

File type File
Extension

From TestSuite
Application

From
Windows
Explorer

User Templates

Note: Template files are not fully self-
contained; they contain references to
other files (such as, Report Templates).

.TSTemplate Create new test
from, save as

Copy, move,
paste, delete,
rename

MTS Templates

Note: Template files are not fully self-
contained; they contain references to
other files (such as, Report Templates).

.TSTemplate Create new test
from, save as

Contact MTS

Exported Tests .tsproj Import/export Copy, move,
paste, delete,
rename

Exported Test Runs .tsproj Import/export Copy, move,
paste, delete,
rename

Exported Unit Sets .tsunitset Import/export Copy, move,
paste, delete,
rename

Report Templates .xltx Add, edit, remove
from test

Copy, move,
paste, delete,
rename

Reports .xlsx Generate reports,
open, print,
delete, rename

Copy, move,
paste, delete,
rename

External Files (create test from) .xml Create test from
the .xml file

Copy, move,
paste, delete,
rename

Data Export (exported raw data) .txt .csv Export Copy, move,
paste, delete,
rename

MTS TestSuite File Management
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Move Test Files to a New Directory
Use the following procedure tomove a large number of tests from one location to another. The
following procedure is not recommended for day-to-day testing but may be used tomove a large
number of test to a new (empty) location (such as a network drive).

Important: You can use theWindowsOS tomove test files only if the destination directory is
empty. Tomove a test into a directory that already contains tests, use theSave As feature in the
TestSuite application.

1. Use theWindowsOS to create a new, empty directory where you want to store the test files.

2. If this new location is where you want to store and run all tests, set the default Test Directory
setting to this new location.

A. On thePreferencesmenu, clickConfiguration, and click theProject tab.
B. Set the default Test Directory setting to the new directory that you just created.

3. UseWindowsOS tomove the tests to the new directory.

A. Make sure that the new directory is empty.

B. Move the tests to the new directory.

Note:When using theWindowsXP OS, each test appears as a Test folder,
such as TST1.Test, that is numbered in the order that it was created. The user-
defined test names are only visible when the test directory is viewed through
the TestSuite application.When usingWindows 7 or WindowsVista, the user-
defined test names appear in the OS.

4. Tomove additional tests into the directory, youmust use theSave As function in the
TestSuite application.

Important: Each Test folder contains a number of files required to run the test. Do not
manipulate any of the files in the test folder.

Diagnostics
Diagnostic Files Overview
TheMTS TestSuite applications include a feature to create a diagnostics file that you can send toMTS
Technical Support for analysis. The diagnostic file is useful for troubleshooting and correcting
problems. You can include the following in a diagnostic file:

l Diagnostic logs

l Station configuration

l Report templates

l Specimens (not applicable to the TWE or TWX applications)

l Test runs

If required, you can configure the content of the diagnostics file in collaboration with MTS Technical
Support.
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Note:
Contact MTS Technical Support to assist you with transmitting the diagnostics file.

Create a Diagnostic File
A test must be open to create a diagnostic file. You cannot create one while a test is loaded.

1. In the Tools menu, clickCreate Diagnostic File.
2. ClickBrowse in the Create Diagnostic Package window.
3. ClickFile > Save As, select an existing diagnostic (.tsdiag) file to overwrite or enter a new

diagnostic file name, and clickSave.
4. Expand the test hierarchy in the Create Diagnostic Package window and select the check

boxes for the information you want to include in the file.

If necessary, contact MTS for assistance with selecting information.

5. ClickSave.
A message notifies you of successful file creation and its location, or if errors are detected.

6. ClickOK.

Application Log, Test Log and Error List
Application Log Overview

Access
C:\MTS TestSuite\GlobalLog\App.log

The information in the Application Log is automatically stored in a log (.log) file. Each new entry in the
log is automatically written to the file when the entry occurs. The default file location is C:\MTS
TestSuite\GlobalLog. The default file name is App.log.

When you start a session, the application looks in the default location for the default log file. If the file is
there, the application opens the file and loads the contents into the Application Log. If the default file is
not there (it is renamed or moved or cleared), the application creates and opens a new (empty) default
log file.

The default log file is perpetual. As long as it is not renamed, moved, or cleared, it continues to
accumulate the Application Log information.

Logging Levels
The Application Log warnings and errors pertain to loading or running the test. The following
information can be displayed:

l Errors—Thesemessages show information about critical conditions that prevent a test run or
stop a test in progress.

l Warnings—Thesemessages show information about conditions that may require attention,
but do not prevent a test run or stop a test in progress.
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l Information—Thesemessages typically verify the start, result, or completion of a user-
initiated action, or inform the user of the start, result, or completion of a system-initiated action.
They can also be notes added by users.

The application records eachmessage with a date and time stamp. Messages are also persisted from
one session to another.

Application Log information
The Application Log provides the following information for eachmessage:

l Severity—Shows a corresponding icon for themessage type.

l Time—Includes the date and time themessage was logged.

l Category—Shows the source of themessage:AppLog indicates that themessage was
generated by an event related to the application. TestRunLog indicates that themessage
was generated by an event related to the test run.

l Message—Shows a description of the logged event.

Log menu options
The Application Log includes the following right-clickmenu options:

l Select All Rows—Selects all rows in the log. You can copy or export the selected rows.

l Copy—Copies the selected rows. Paste in the desired application.

l Clear View—Hides the contents of the log (automatically selects theNew Messages log
source) during your current session. Only new messages are subsequently displayed. All
messages are restored when you selectCurrent Log as the log source.

l Export Log—Exports your log file in Microsoft Excel format.

l Add Note—Adds a user-enteredmessage to the log. A separate window is used to type your
note. The note is added to theAppLog category.

l Open Existing Log File—Navigate to the log location, such asMTS TestSuite > GlobalLog,
to open a log in a new window.

Log sources
The Application Log shows information from the following sources that appear on the Log Source list:

l Current Log—Shows themessages for all test runs for the current session.

l New Messages—Hides the existingmessages and shows newly generatedmessages.

l From Existing File—Opens aWindowsExplorer window so that you can show a log (.log)
file from a previous test session.

Sorting log information
To sort the contents of the log based on a particular column, click the column header. To reverse the
sort order, click the column header again. To return the log to the standard sort order, click the Time
column header.
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Filtering log information
To filter the contents of the log, click the filter icon in the column heading. A menu of available filter
options is shown. After you filter a column, the filter icon turns blue.

When you click a filter option, the Application Log filters out all themessages (rows) except those for
the selected option.

Test Log Overview

Access
C:\MTS TestSuite\GlobalLog\FaultError.log

The information in the Test Log is automatically stored in a log (.log) file. Each new entry in the log is
automatically written to the file when the entry occurs. The default file location is C:\MTS
TestSuite\GlobalLog. The default file name is FaultError.log.

When you start a session, the application looks in the default location for the default log file. If the file is
there, the application opens the file and loads the contents into the Test Log. If the default file is not
there (it is renamed or moved or cleared), the application creates and opens a new (empty) default log
file.

The default log file is perpetual. As long as it is not renamed, moved, or cleared, it continues to
accumulate the Test Log information.

Logging Levels
The Test Log warnings and errors pertain to loading or running the test. The following information can
be displayed:

l Errors—Thesemessages show information about critical conditions that prevent a test run or
stop a test in progress.

l Warnings—Thesemessages show information about conditions that may require attention,
but do not prevent a test run or stop a test in progress.

l Information—Thesemessages typically verify the start, result, or completion of a user-
initiated action, or inform the user of the start, result, or completion of a system-initiated action.
They can also be notes added by users.

The application records eachmessage with a date and time stamp. Messages are also persisted from
one session to another.

Test Log information
The Test Log provides the following information for eachmessage:

l Severity—Shows a corresponding icon for themessage type.

l Time—Includes the date and time themessage was logged.

l Category—Shows the source of themessage. TestRunLog indicates that themessage was
generated by an event related to the test run.

l Message—Shows a description of the logged event.
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Log menu options
The Test Log includes the following right-clickmenu options:

l Select All Rows—Selects all rows in the log. You can copy or export the selected rows.

l Copy—Copies the selected rows. Paste in the desired application.

l Clear View—Hides the contents of the log (automatically selects theNew Messages log
source) during your current session. Only new messages are subsequently displayed. All
messages are restored when you selectCurrent Log as the log source.

l Export Log—Exports your log file in Microsoft Excel format.

l Add Note—Adds a user-enteredmessage to the log. A separate window is used to type your
note. The note is added to the TestRunLog category.

l Open Existing Log File—Navigate to the log location, such asMTS TestSuite >
GlobalLog, to open a log in a new window.

Log sources
The Test Log shows information from the following sources that appear on the Log Source list:

l Current Log—Shows themessages for all test runs for the current session.

l New Messages—Hides the existingmessages and shows newly generatedmessages.

l From Existing File—Opens aWindowsExplorer window so that you can show a log (.log)
file from a previous test session.

Sorting log information
To sort the contents of the log based on a particular column, click the column header. To reverse the
sort order, click the column header again. To return the log to the standard sort order, click the Time
column header.

Filtering log information
To filter the contents of the log, click the filter icon in the column heading. A menu of available filter
options is shown. After you filter a column, the filter icon turns blue.

When you click a filter option, the Test Log filters out all themessages (rows) except those for the
selected option.

Error List Overview
TheError List tab lists warnings and errors pertain to defining and configuring the test.

l Errors—Shows information about critical conditions that do not allow you to load or run a test.

l Warnings—Shows information about conditions that may require attention, but do not
prevent you from loading or running a test.

The contents of the Error list are dynamic and change according to the part of the application you are
using.

The application does not store the contents of the Error list in a file. Eachmessage is removed when
the corresponding condition is corrected.
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Error List information
TheError List tab provides the following information for each error:

l Message type icon—Shows the corresponding icon for themessage type.

l Sequence number—Shows the numbered order in which the application detects the error or
warning.

l Description—Contains the text that describes the error or warning.

Error Location
In addition to the Error list, the application alsomarks the problem conditionswith error and warning
icons on or near the offending selection or setting in the user interface. If you double-click an item in the
list, the program control point moves to (or near to) the location of the error.

Error Identification
TheError list identifies error conditions for the current context or object selected. For example, you
can use theError list and the Test Definition object to view a summary of the errors in a test.

If you double-click an item in theError list, the view changes to show the location of the error. Error
and warning icons are placed on or near the property, selection, or setting where the error exists so
that you can quickly locate the source of the error.

Meters
Meters Overview
TheMeters tab containsmeters that show various data retrieved from signals on your system. On
most systems, the Crosshead/Axial Force and Load/Axial Displacement meters are available when
you first open theMeters tab. However, you can add other meters that show a variety of information
such as interlock status, power status, or even the current time and date. After you add ameter, you
can configure themeter type, unit type shown, number of decimal places shown, sensitivity (of
Peak/Valleymeters only), and font settings.

Adding a Meter
1. Click theMeters tab.
2. Right-click any existingmeter.

3. Hover overAdd Meter.
4. Select themeter you want to add.

Note: This list contains themost commonly-usedmeters. To add other meters, click
More to open theMeter Configurationwindow. Then, move each desiredmeter over
to the list of Selectedmeters on the right side on the window.When you are finished,
clickOK.
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Resetting a Meter
You can reset the values recorded in Peak, Valley, Peak/Valley, RunningMaximum/Minimum, and
Mean/Amplitudemeters. Keep inmind that if the crosshead or actuator is not at the zero position,
resetting certain metersmay not always return the displayed value to zero. For example, if the axial
displacement of the crosshead or actuator is resting at 10mmand you reset amaximumaxial
displacement meter, themeter will continue to show 10mm. This occurs because immediately after
you reset themeter, the axial displacement signal remains at 10mm, which is considered the
maximum. In this scenario, if you returned the axial displacement to 0 before you reset themeter, the
maximumaxial displacement meter would return to 0 after you reset themeter.

1. Click theMeters tab.
2. Right-click the Peak, Valley, Peak/Valley, RunningMaximum/Minimum, or Mean/Amplitude

meter that you want to reset.

3. SelectReset to reset themeter you selected or selectReset All to reset all meters that can
be reset on theMeters tab.

Removing a Meter
1. Click theMeters tab.
2. Right-click themeter you want to remove.

3. SelectRemove.

Configuring Meters
After you add ameter to theMeters tab, you can configure themeter type, units shown, number of
decimal places shown, sensitivity, and font used in themeter.

Changing the Meter Type

1. Click theMeters tab.
2. Right-click an existingmeter.

3. Hover overMeter Type.
4. Select the desiredmeter type. For more information about the availablemeter types, see

“Meter Types” on page 42.

Changing the Units Displayed on a Meter

1. Click theMeters tab.
2. Right-click an existingmeter.

3. Hover overUnit.
4. Select the unit type you want themeter to use.
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Changing the Decimal Places Displayed on a Meter

1. Click theMeters tab.
2. Right-click an existingmeter.

3. Hover overDecimal Places.
4. Select the number of decimal places you want displayed on themeter.

Changing the Color and Font of Meters

1. Click theMeters tab.
2. Right-click an existingmeter.

3. SelectProperties. TheMeter Configurationwindow appears.

4. Adjust the Label Font Size, Value Font Size, Foreground Color, andBackground Color
as desired.When youmodify these settings, they are applied to all meters available on the
Meters tab.

Changing the Sensitivity of a Meter
The sensitivity setting defines how much the signal must change before a level is considered a peak or
valley. The sensitivity setting can be used to keep the activity from seeing signal noise as a new peak or
valley. When adjusting the sensitivity, keep inmind that setting the sensitivity too low may cause signal
noise to be recognized as peaks and valleys, and setting the sensitivity too highmay cause low
amplitude signals to bemissed.

1. Click theMeters tab.
2. Right-click the Peak, Valley, or Peak/Valleymeter you want to adjust.

3. Hover over Sensitivity.
4. Select the desired sensitivity.

Meter Types
Themeter type determineswhat type of information is shown on themeter. When you first launch the
application, the Crosshead/Axial Force and Load/Axial Displacement meters appear on theMeters
tab. By default, themeter type of thosemeters is set to Timed. Thismeter type shows the real-time
axial displacement of the system’s crosshead or actuator. However, if you change themeter type to
RunningMaximum/Minimum, themeter shows theminimumandmaximumaxial displacement
experienced by the crosshead or actuator.

Item Description

Timed Displays signal values at timed intervals.

Minimum Displays the runningminimum value that was observed since themeter was
added or reset.

Maximum Displays the runningmaximum value that was observed since themeter was

Available Meter Types
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Item Description

added or reset.

Peak Displays the peak value for themost recent cycle monitored.

Valley Displays the valley value for themost recent cycle monitored.

Peak/Valley Displays both the peak and valley values for themost recent cycle monitored.

Running
Maximum/Minimum

Displays both the runningminimumandmaximum values that were observed
since themeter was added or reset.

Mean/Amplitude Displays themidpoint value and the difference between the peak and valley
values for themost recent cycle monitored.

Licenses
License Utility Overview

Access
Programs >MTS TestSuite > License Administrator

During installation, the ActivationWizard prompts you to activate the license for your MTS TestSuite
software. The process for obtaining the license file depends on whether the PC was connected to the
Internet. After installation, you can add andmanage licenses at any time with theMTS TestSuite
License Administrator utility.

With theMTS TestSuite License Administrator utility, you can activate andmanage your licenses and
obtain information about currently installed licenses. You can view the Applications, Templates,
Privileges, Activities, and other special features for which you are licensed.

Tip:
Always save your TestSuite license(s) into a plain text file usingWindowsNotepad. If you save a
license using other text editors (such asWordPad, Notepad++, or Microsoft Word), characters
in the licensemay be altered slightly or additional charactersmay even be appended to the end
of the license. If this occurs, the licensemay not be recognized when you paste it into the
License Administrator utility.
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Open License Administrator Utility

Activate a License with an Internet Connection
If you have an activation key and the PC onwhich you are installing a license has an Internet
connection, perform the following steps to obtain, install, and activate a license.

1. ClickPrograms >MTS TestSuite > License Administrator.
2. ClickActivate. The TestSuite Activation wizard is launched.

TestSuite Activation Wizard

3. Click I want to activate the software over the Internet panel and clickNext. The window
to enter your activation key is displayed.
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4. Enter the activation key and clickNext.

Activation Wizard Activation Key

Amessage indicates the license is being obtained from the server, and a progress bar is
displayed. The ActivationWizard installs and activates the license.

5. When activation is complete, clickFinish to exit the ActivationWizard.

6. ClickClose to exit theMTS TestSuite License Administrator.

Request and Activate a License without an Internet Connection
If the PC onwhich you are activating a license does not have an Internet connection, follow these steps
to request and activate a license file.

1. ClickPrograms >MTS TestSuite > License Administrator.
2. ClickActivate.
3. Click I want to request a license file and clickNext.
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4. Enter the activation key and clickNext.

Complete License Activation Window

5. To copy the License Request Contents, which is a PC-identifying string, clickCopy to.
6. Paste the copied License Request into a text editor such asNotepad, and save the Request

File to a USB drive.

7. ClickFinish to exit the ActivationWizard.

8. Plug the USB drive into a PC that has Internet access. Go to theMTS LicensingWeb site:

www.mts.com/testsuite/licensing/

9. Open the Request File on the USB drive. Select and copy the contents.

10. Paste the content into the text box in theWeb page and clickDownload License File. Save
the license file to the USB drive.

11. Bring the USB drive back to the PC without an Internet connection onto which you are
installing software.

12. Open the Activation wizard again. Select the I have a license file I want to install option
and clickNext.

13. Browse to the location of the license file. Select the license bin file and clickOpen.
14. ClickNext. The ActivationWizard installs and activates the license.

15. ClickFinish to exit the ActivationWizard.

16. ClickClose to exit theMTS TestSuite License Administrator.

Remove a License
To remove a license, use theMTS TestSuite License Administrator utility.

http://www.mts.com/testsuite/licensing/
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1. ClickPrograms >MTS TestSuite > License Administrator.
2. In the upper part of the window, select the license you want to remove and clickRemove. To

remove all licenses, clickRemove All.
3. You are prompted to confirm removing the license. ClickOK.
4. ClickClose.

End-User License Agreement (EULA)
Access
Help > End-User License Agreement

When you first install and launch anMTS TestSuite application, the EULA window is shown. You can
scroll to view the terms of the agreement, or print the license agreement.

End-User License Agreement Window

To Accept or Reject the EULA
l To accept the terms of the agreement, clickAccept. The EULA window closes and the
application is available for use.

l To reject the EULA, clickReject. The EULA window andMTS TestSuite application close.
You cannot access the application until you accept the EULA.

l If you do not want to view the EULA each time theMTS application is launched, click theDo



Introduction

48 MTS TestSuite™ TWEssential User Guide

not show this again check box. You can access the EULA at any time from theHelpmenu.

Version Information Overview
TheMTS TestSuite window provides the following information about the installed application:

l Name of the installed application

l Release date

l Application version number

l Platform version number

l Current user and role

l Copyright information

 Version Information Window

Version Information Overview
TheMTS TestSuite window provides the following information about the installed application:

l Name of the installed application

l Release date

l Application version number

l Platform version number

l Current user and role

l Copyright information



Introduction

MTS TestSuite™ TWEssential User Guide 49

 Version Information Window
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Managing Users
User Management Overview
If your organization needs tomanagemultiple users of theMTS TestSuite application, you can
manage users with or without their Windows user accounts. The default User Management option is
none (theNo User Management option), and users are not required to log in to theMTS TestSuite
applications.WindowsUser Management automatically logs in users based on their Windows log in.
By default, the user who installs theMTS TestSuite application is automatically added as anMTS
TestSuite Administrator. Adding the default Administrator user provides the ability to switch to User
Management if desired. Only a user with Administrator role or User Management privileges can add
users and assign roles.

Note:
If your organization does not set up Local or WindowsUser Management, all users who launch
anMTS TestSuite application have Administrator privileges.

An Administrator grants users privileges through the assignment of a specific role. Each privilege
controls access to performing certain taskswithin the application. A user may be assigned one or more
roles; however, a user must select one of the roles when the application starts if Local User
Management is the selected User Management option.

Manage User Accounts Window

Access
Preferences > User Management >Manage User Accounts

Use theManage User Account window to add users andmanage roles.
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 Manage User Accounts Window

The PrimaryMTS TestSuite Administrator is displayed in blue.

Section Description

User
Management
options

l No User Management—(Default) All users can access the application
without having to log in if during installation, theAnyone who uses this
computer (all users) option was selected. All users are automatically
assigned an Administrator role. If theOnly for me option was selected
during installation, only the user who installed the application can launch it.

l Local User Management—Users aremanaged by theMTS TestSuite
application independently of Microsoft Windows user accounts. Youmust
addMTS TestSuite users.

l Windows User Management—Users aremanaged by their Windows
User accounts. There is a one-to-onemapping betweenWindows andMTS
TestSuite users. Youmust addMTS TestSuite users.

User
accounts list

Displays all of the currently definedMTS TestSuite users.

Add User Opens the Create new MTS TestSuite user window so you can add a new user and

Manage User Accounts Window Description
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Section Description

button assign the user a Role.

Remove
User button

Removes the user selected in theManage User Accounts window.

Properties
button

Opens the Change User Properties window. You can change the name, password,
and assigned roles.

Manage
Roles button

Opens theManage Roleswindow. You can view the privileges associated with the
default roles, work with custom roles, and view all users currently assigned to a role.

Add a Local User and Assign a Role
Note: To perform these steps, youmust be assigned the Administrator role or be assigned a
custom role with User Management privileges.

To add a local user and assign a role:

1. ClickPreferences > User Management > Manage User Accounts. TheManage User
Accounts window appears.

2. Click the Local User Management option.
3. ClickAdd User. The Create new MTS TestSuite user window appears.

 Create New MTS TestSuite User Window

4. Enter theUser Name for the user.
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5. Enter aPassword for the user and enter the password again in theConfirm Password box.
6. (Optional) Enter aComplete Name andDescription of the user.
7. Select one or moreRoles for the user.
8. ClickOK. Repeat this procedure for each user you need to add.

Add a Windows User and Assign Roles
Note: To perform this task, youmust be assigned the Administrator role or be assigned a
custom role with User Management privileges.

To add aWindows user and assign roles:

1. ClickPreferences > User Management > Manage User Accounts. TheManage User
Accounts window appears.

2. Click theWindows User Management option.
3. ClickAdd User. The AddMTS TestSuite Users window appears.

 Add MTS TestSuite Users Window

4. Select the role you want to assign to the new users.

5. To add a user:

l To findWindows users you want to add, enter the networkDomain name, and then
in the FindWindowsUsers panel, clickFind. When the search results return, select
the user or users you want to add. Click the arrows tomove the selected users from
theWindowsUsers panel to the New MTS TestSuite Users panel.

l If you know the user name, enter theUser Name and networkDomain Name, and
then clickAdd in the Add User Manually panel. Repeat for additional users.
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6. ClickOK.

Change a Role Assigned to a User
To change a role assigned to a user:

1. ClickPreferences > User Management > Manage User Accounts. TheManage User
Accounts window appears.

2. Select the user in theManage User Accounts window and clickProperties. The Change
User Properties window appears.

3. Select the roles by selecting and clearing the corresponding check boxes.

4. ClickOK.

Remove a User
To remove a user:

1. ClickPreferences > User Management > Manage User Accounts. TheManage User
Accounts window appears.

2. Select the user in theManage User Accounts window.

3. ClickRemove User. You are prompted to confirm removing the user.

4. ClickOK.

Managing Roles
Note: To perform this task, youmust be assigned the Administrator role or be assigned a
custom role with User Management privileges.

TheMTS TestSuite application provides several default (predefined) roles. You cannot edit or delete
default roles; however, you can create custom roles that you can edit or delete.

Manage Roles Window
Use theManage Roleswindow tomanage custom roles and view users assigned to roles.

Access

1. ClickPreferences > User Management > Manage User Accounts.
2. Either the Local orWindows User Management optionmust be selected.
3. ClickManage Roles.
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Manage Roles Window

Create a Custom User Role
To create a custom user role:

1. ClickPreferences > User Management > Manage User Accounts. TheManage User
Accounts window appears.

2. ClickManage Roles. TheManage Roleswindow appears.
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3. ClickCreate Role. The Add Role window appears.

 Add Role Window

4. Enter aName andDescription for the new role.

5. Select thePrivileges to assign to the role.
6. ClickOK.

Default Roles
Use default roles to assign standardized user privileges. Default roles are predefined categories of
user privileges. You cannot edit or delete default roles; however, you can create custom roles that you
can edit or delete.

Note: The privileges that appear vary depending on the selected role. Only privileges for which
you are licensed are shown.
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Default Role
Name Privileges

Administrator At least oneWindows user account must be assigned to the Administrator role.
Only the Administrator can add users and assign them roles. The Administrator can
also change their own role or assign the Administrator role to another user. The
user who installs the application is automatically added as a user and an
Administrator.

The Administrator role has all privileges, including:

l Edit Calibration Values (MTS Insight/Criterion only)

l Change Laboratory Preferences

l Change Polarity

l Create Diagnostic File

l Delete Project

l Delete Test

l Delete Test Run

l Edit Procedure

l Express Editor

l Launch Fatigue Analyzer

l Launch Fracture Analyzer

l Launch Reporter Add-In

l Launch TW Elite 

l Launch TW Essential

l Launch TW Express

l LaunchMultipurpose Elite

l LaunchMultipurpose Express

l Tuning (MTS Acumen only)

l Save Test as Template

l User Management

l View Reports

Engineer Includesmost privileges, except for laboratory preferences, calibration, and user
management.

The Engineer role has the following privileges:

l Change Polarity

Default User Roles



User and Role Management

60 MTS TestSuite™ TWEssential User Guide

Default Role
Name Privileges

l Create Diagnostic File

l Delete Project

l Delete Test

l Delete Test Run

l Edit Procedure

l Express Editor

l Launch Fatigue Analyzer

l Launch Fracture Analyzer

l Launch Reporter Add-In

l Launch TW Elite

l Launch TW Essential

l Launch TW Express

l LaunchMultipurpose Elite

l LaunchMultipurpose Express

l Tuning (MTS Acumen only)

l Save Test as Template

l View Reports

Operator Creates new projects or tests from templates and run those tests.

TheOperator role has the following privileges:

l Create Diagnostic File

l Launch TW Elite

Launch TW Essential

l Launch TW Express

l LaunchMultipurpose Elite

l LaunchMultipurpose Express

l Tuning (MTS Acumen only)

l View Reports

Note: Operatorsmay start the system application but have limited
capabilities using it. Operator privileges are the same throughout theMTS
TestSuite software applications.
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Edit a Custom User Role
To edit a custom user role:

1. ClickPreferences > User Management > Manage User Accounts. TheManage User
Accounts window appears.

2. ClickManage Roles. TheManage Roleswindow appears.

3. To edit a user-defined role, select the role and clickEdit Role. In the Edit Role window:
A. If necessary, change theName orDescription for the role.
B. Select the privileges to assign to the role.

C. ClickOK.

View Users Assigned to a Role
To view users assigned to a role:

1. ClickPreferences > User Management > Manage User Accounts. TheManage User
Accounts window opens.

2. ClickManage Roles. TheManage Roleswindow opens.

3. Select a role in theRoles list and clickUsers in Role. The Users in Role window shows a list
of users assigned to that role.

 User In Role Window

4. ClickClose.
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Remove a Custom User Role
Note: You cannot remove a role if a user is assigned to the role. Assign the user to another role
and then remove the custom role.

1. ClickPreferences > User Management > Manage User Accounts. TheManage User
Accounts window appears.

2. ClickManage Roles. TheManage Roleswindow appears.

3. To remove a user-defined role, select the role and clickRemove Role.
4. ClickClose.

Privileges
Note: The privileges that appear vary depending on the selected role. Only privileges for which
you are licensed are shown.

Privilege
Name Description

Edit
Calibration
Values

(Applicable onMTS Insight/Criterion only.) Allows anMTS Field Service Engineer
to work with TEDS Device files.

Change
Laboratory
Preferences

Allows you to configure default units and nameswithin projects and tests. It enables:

l Preferences > Configuration > Default Names
l Preferences > Configuration > Unit Set Manager

Change
Polarity

Allows you to change the signal sense of signals in the connected station.

Create
Diagnostic
File

Allows you to create a diagnostic file, which is used byMTS Technical Support for
diagnostic purposes. It enablesTools > Create Diagnostic File.

Delete
Project

Allows you to delete a project. It enables the ability to delete a test using
Configuration > Project.

Delete Test Allows you to delete a test. It enables the ability to delete a test using File > Delete
Test.

Delete Test
Run

Allows you to delete a test run.

Edit
Procedure

Allows you to edit select report templates and a limited set of variable properties
(Display Name, Default Value, Default Option, Unit, Pretest, Result, Editable Post-
Test, Range, Formatting). The Formula Assistant feature (applicable onMTS
Insight/Criterion only) is also available to apply calculation options to a variable.

Privileges
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Privilege
Name Description

Express
Editor

Allows you to edit select report templates and a limited set of variable properties
(Display Name, Express Editor Default Value, Default Option, Unit, Pretest, Result,
Editable Post-Test, Range, Formatting). The Formula Assistant feature (applicable
onMTS Insight/Criterion only) is also available to apply calculation options to a
variable.

Launch
Fatigue
Analyzer

Launches the Fatigue Analyzer application.

Launch
Fracture
Analyzer

Launches the Fracture Analyzer application.

Launch
Multipurpose
Elite

Allows you to start theMultipurpose Elite application.

Launch
Multipurpose
Express

Allows you to start theMultipurpose Express application.

Launch
Reporter
Add-In

Allows you to start the Reporter Add-in to theMicrosoft Excel application.

Launch TW
Elite

Allows you to start the TW Elite application.

Launch
TW Essential

Allows you to start the TW Essential application.

Launch TW
Express

Allows you to start the TW Express application.

Save Test as
Template

Allows you to save a test as a template.

Tuning (MTS
Acumen
Only)

(Applicable toMTS Acumen systems only) Allows you to tune control modes.

User
Management

Allows you to view information related to users, roles, and privileges. It enables
Preferences > User Accounts.

View
Reports

Allows you to view reports generated by an activity in a test procedure. It enables
theView Report option from the context menu.





Preferences and Default Settings

MTS TestSuite™ TWEssential User Guide 65

Preferences and Default
Settings

ConfigurationWindow 66

Project Management 67

Audit Trail 70

E-Mail Overview 72

Control Panel Settings 74

UnitsManagement 75

Remote Server Settings 79



Preferences and Default Settings

66 MTS TestSuite™ TWEssential User Guide

Configuration Window
Access
Preferences > Configuration > Project tab

Use the tabs in the Configuration window to select preferences and default settings. The window
opens to theProject tab by default.

Configuration Window

Tab Description

Project Modifies the settings file of the selected project. Project settings determine the
organization and flow of data within a project. Project settingsmap data paths for
the sub folders within projects.

Test/Template Defines alternative ways to start the test (other than pressing the start button)
using keyboard commands and digital inputs. For more information about using
remote start, see “Using Remote Start” on page 67.

Opens the current test when the application starts. Allows you to define the Default
Log Type (Basic or Audit Trail).

Language Selects a language for theMTS TestSuite application.

Configuration Window Tabs
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Tab Description

Email Sets up e-mail for theRun Report andSend E-mail activities.

The From e-mail property sets the default for the From e-mail address property in
theRun Report andSend E-Mail activities. The other settings are for specifying
the e-mail server. Checkwith your e-mail administrator for the correct settings. You
can send a test e-mail to verify the SMTP server settings are working properly.

Default
Names

Selects default base names for new projects, tests, and test runs.

Control Panel Configures the RampRate for the Jog Buttons and the RampRate for theReturn
Crosshead to Zero activity.

Unit Set
Manager

Manages unit sets.

Using Remote Start
The settings for theDigital Input control support the Remote Test Start feature. The Remote Test
Start feature allows the test to start from a digital signal in place of an operator pressing the run button.

Note: Remote Test Start is an advanced feature. It can only be enabled with MTS TWElite,
which has extended editing capabilities, or by anMTS Service Engineer.

If you haveMTS TWElite (TWE) and you want to enable the Remote Test Start feature for a template
used with MTS TWS, perform the following:

1. Open the template in MTS TWE.

2. Ensure theDigital Input control is selected, and a digital input and transition type are
selected inPreferences > Configuration > Test/Template.

3. On theDefine tab, select Test Definition > General Settings.
4. ClickEdit.
5. Select Enable Remote Test Start using Digital Input.

6. Save the template in MTS TWElite.

7. Open the template in MTS TWS. The test can now be started remotely from the defined digital
input signal.

Project Management
Working with Projects

Access
Preferences > Configuration > Project tab
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System Default Project
When you install MTS TestSuite software, theMTS installer creates the system default project and is
labeled Project 1. This project is the location where the installer places or updates example tests. The
system default project cannot be deleted. However, you can change the properties of the system
default project.

Add a project
To add a project, click the + button in the upper right side of theProjects list. The project is
automatically created using the default naming convention specified on theDefault Names tab.

Delete a project
To delete a project, select the project you want to delete and click the – icon in the upper right corner of
theProjects list.

Alternately, you can right-click the project you want to delete and selectRemove.

Important:When you delete a project, all the folders within that project’s folder are deleted. If
the Test Directory for the project is configured to store tests within the project’s directory
(default), those tests will also be deleted. For more information about the Test Directory, see
“Test Directory” on page 69

Note: You cannot delete a project if a test within the project is open.

Note: You cannot delete the system default project (that is, Project 1).

Open a project
To open a project, double-click the project name, or right-click the project you want to open and select
theOpen Projectmenu option.

Note: If a test is open, you cannot open another project.

Edit a project
To edit a project, select the project in theProjects list and change the associated project settings as
desired. Your changes are saved when you click theApply orOK buttons in the Configuration
window.

Set a project as the default project
You can change the default project, which is the project that automatically openswhen theMTS
TestSuite software starts. This selection is stored specific to your user credentials. If you do not have a
default project set, the application uses the system default project as your initial default.

To set a project as the default project, right-click the project name you want to set as the default, and
selectSet Default Project.

Project Tab

Access
Preferences > Configuration > Projects tab
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Use theProject tab tomanage projects. With this tab, you can see all the projects, add and remove
them, and see individual project settings.

As you select projects in theProjects list, the settings for the selected project are shown to the right.
By default, the directory settings are global locations shared between all projects but you can change
this setting for a particular project.

Note:
If you change any of the default directories for a project, an asterisk (*) appears next to the
project.

Setting Description

Name Specifies the name of the project. This name is shown in theProjects list, as well as
in the title bar of theMTS TestSuite application.

Creator Displays the name of the person who created the project. Thismay be empty if user
management s disabled. This field is read-only.

Created Displays the date and time that the project was created. This field is read-only.

Last
Modified

Displays the date and time that the project was last modified. This field is read-only.

Test
Directory

Specifies the directory in which the project looks for and stores tests. By default, this
directory exists under the project’s directory, but can be set to any valid directory,
including a network location.

Note: If tests are stored in a project directory (default), they are deleted if the
project is deleted.

Note: This field is read-only if there is a test open when the project settings
view is shown.

Custom
Template
Directory

Specifies the directory in which theMTS TestSuite application looks for existing
custom templates and stores new custom templates.

Note: MTS supplied templates are available from theMTS Templates list on
the start page or fromMTS Templates list on theSelect tab.

Report
Template
Directory

Specifies the directory in which theMTS TestSuite application looks for and stores
report templates.

Report
Directory

Specifies the directory in which theMTS TestSuite application stores generated
reports. By default, this field is blank and reports are stored in a test runs subdirectory
of the project.

External
Files

Specifies the directory in which theMTS TestSuite application looks for external files
(such as XML files used to create tests).

Project Settings
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Setting Description

Directory

Data
Export
Directory

Specifies the directory in which theMTS TestSuite application saves data export files
created by the Export Data activity.

Description (Optional) Displays a description entered about the project.

Audit Trail
Access
When activated, the Audit Trail feature allows you to check the integrity of your data files from a
selection in the Filemenu. If the application detects any change, the files that do not match are listed in
amessage window. It also writes information about the controller’s TEDS devices to the test log every
time the test is run, includingmodel and serial number, version andmanufacturer number, and
calibration date.

Note: The Audit Trail is an advanced feature. It can only be enabled with MTS TWElite (TWE),
which has extended editing capabilities, or by anMTS Service Engineer.

If you haveMTS TWE and you want to enable the Audit Trail feature for a template used with MTS
TWS, perform the following:

1. Open the template or test in MTS TWE.

2. Ensure the Log Type isAudit Trail inPreferences > Configuration > Test/Template.
3. Select Test Definition > General Settings.
4. ClickEdit.
5. For Log Type, selectAudit Trail.
6. Save the template in MTS TW Elite.

7. Open the template in MTS TWS. The Filemenu now includes aCheck Test Audit Trail
selection.

Set the Log Type to Audit Trail for a Test
Note: This setting only applies to the current test.

1. Click theGeneral Settings tab.
2. ClickEdit.
3. In the Log Type list, clickAudit Trail. The Check Test Audit Trail option becomes available in

the Filemenu.
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Set the Default Log Type to Audit Trail
When the Default Log Type is set toAudit Trail, each new test that is created has its log type set to
Audit Trail rather than Basic.

Note: This setting does not affect the current test.

1. On thePreferencesmenu, clickConfiguration.
2. Click the Test tab.
3. In the Default Log Type list, clickAudit Trail.

Check the Test Audit Trail
1. Make sure that the Log Type for the test is set toAudit Trail.
2. ClickFile > Check Test Audit Trail. Files that do not match the audit trail are listed in a

window. If verification is successful, a message states all files associated with the test have
been verified.

3. ClickOK.

Define a Keyboard Shortcut to Start the Test
You can define a keyboard shortcut to start tests from your keyboard. To do this:

1. On thePreferencesmenu, clickConfiguration.
2. Click the Test tab.
3. Select the Function Key Shortcut check box.
4. Click inside the field next to the Function Key Shortcut checkbox and define the shortcut by

typing one of the following key combinations.

Note:
You cannot use a keyboard shortcut to resume a test.

Function keys
F1 - F10

Shift key combinations
l Shift Ins

l Shift Del

l Shift F1 - Shift F12

Control key combinations
l Ctrl Ins

l Ctrl Del

l Ctrl 1 - Ctrl 9
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l Ctrl A - Ctrl Z

l Ctrl F1 - Ctrl F12

l Ctrl Shift 0 - Ctrl Shift 9

l Ctrl Shift A - Ctrl Shift Z

l Ctrl Shift F1 - Ctrl Shift F12

Alt key combinations
l Alt Backspace

l Alt Left Arrow

l Alt Up Arrow

l Alt Right Arrow

l Alt Down Arrow

l Alt 0 - Alt 9

l Alt F1 - Alt F12

E-Mail Overview
Access
Preferences > Configuration > E-Mail tab

You can set up e-mail activities to automatically notify interested parties of test progress. You can
insert variables into the e-mail message and attach themessage log. You can also send a report
attached to an e-mail. TheSend E-Mail and theRun Report activities require you to configure your
SMTP server settings if you want to use the e-mail activities in your test workflow. The e-mail
configuration uses the SMTP to relay e-mail messages for delivery.

Configuring SMTP Server for E-Mail Activity
Request the relevant SMTP server settings from your system administrator. To configure e-mail
notification:

1. ClickPreferencesmenu > Configuration option > E-Mail tab.
2. Enter the default e-mail address in the From address box.

3. Enter the name of your server in theServer name field.
4. Enter the TCP Port in theSMTP port number field. If your server supports secure

connections, make sure theEnable SSL check box is selected.
5. Adjust the default value in the Timeout field if necessary.
6. If your server requires authentication to relaymail to non-local (external) users, select theMy

server requires authentication check box. The Account Name andPassword fields are
displayed.
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A. Enter your Account Name.

B. Enter your Password.

7. Enter an e-mail address in theSend test e-mail to address field and clickSend.
l If successful, an e-mail sends the SMTP settings to the specified test e-mail address.
A message window instructs you to check your Inbox. ClickOK.

l If the test e-mail is not successful, a message window instructs you to check the
Application Log for details on the error message. ClickOK. Correct the error and
resend the test e-mail.

E-Mail Settings

Access
Preferencesmenu > Configuration > E-Mail tab

Use theE-Mail tab of the Configuration window to enter e-mail server settings.

E-Mail Tab—Configuration Window

The following table describes the fields for configuring E-Mail for test activities.
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Setting Description

From address The default address fromwhich e-mail is sent. The From address entered in the
E-Mail Configuration window automatically populates the From address in the
Properties panels of theSend E-Mail andSend Report to E-Mail of the Run
Report activities.

Server name The name of the SMTP server for your organization.

SMTP port
number

The SMTP (SimpleMail Transfer Protocol) port number is typically TCP Port 25. If
the server is set up for SMTP, the port number is typically 465.

Enable SSL If you server does not support SSL (Secure Sockets Layer), clear theEnable SSL
check box.

If your e-mail server supports secure connections, leave theEnable SSL check
box selected.

Default: Enabled

Timeout
(seconds)

Adjust the default timeout value at the recommendation of your e-mail system
administrator.

Default: 120 seconds

My server
requires
authentication

Select the check box if your server requires authentication to relaymail to e-mail
addresses that are external to your organization. Enter yourAccount Name and
Password.

Clear the check box if your server does not require authentication; that is, you are
sending e-mail only internally.

Default: Enabled

Send test e-
mail to
address

Enter the e-mail address to which you want to send a test e-mail. This is highly
recommended to ensure you have correctly configured this option prior to using
theSend E-Mail activity in a test.

The body of the test message contains your SMTP server settings.

The test e-mail address is cleared when you exit the Configuration window.

E-Mail Settings

Control Panel Settings
Access
Preferencesmenu > Configuration > Control Panel tab

Use theControl Panel tab to configure the operation of the Jog and Return buttons on the Application
control panel.
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Note:When connected to anMTS FlexTest controller, the Return panel allows specifying the
RampRate for the Return to zero position. When connected to anMTS Insight controller, the
RampRate for the Returnmust be specified by anMTS Field Service Engineer.

Units Management
Unit Set Overview

Access
Preferencesmenu > Configuration > Unit Set Manager tab

Standard unit set
Use theUnit Set Manager tab to assign a unit set at the system level and at the project level. Unit
sets are a collection of dimensions and associated units. For example, the unit set Si (mm-N) has a
length dimension of millimeters (mm).

MTS TestSuite applications contain several built-in unit sets.These sets are read-only and cannot be
modified.

l If a unit set is not defined as the system default, the application uses theMTS TestSuite
Default unit set.

l Variables and charts can point to specific units or use the default unit set for the project.

Custom unit set
You can add custom unit sets that can be exported to or imported from other projects. You can select
various units for the dimensions in your custom set. For more information about adding a custom unit
set, see “Add a CustomUnit Set” on page 77.

Predefined Unit Sets
MTS TestSuite includes the following predefined unit sets:

Unit Set Description

cgs Centimeters-Grams-Seconds. Defines a set of units that is based upon centimeters,
grams, and seconds. Force is expressed as “dyn.”

mks Meters-Kilograms-Seconds. Defines a set of units that is based uponmeters,
kilograms, and seconds. Force is expressed as “N.”

MTS 793 Millimeters-Kilograms-Seconds. Defines a set of units that is based uponmillimeters,
kilograms, and seconds. Force is expressed as “kN.”

MTS
TestWorks
4

Millimeters-Kilograms-Seconds. Defines a set of units that is based uponmillimeters,
kilograms, and seconds. Force is expressed as “kgf.”

SI (mm- Systeme International d’Unites. Defines a set of units that contains customary

Predefined Unit Sets
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Unit Set Description

kN) international (metric) units. It provides force-related units in “kN” and length-related
units in “mm.”

SI (mm-N) Systeme International d’Unites. Defines a set of units that contains customary
international (metric) units. It provides force-related units in “N” and length-related
units in “mm.”

US (in-kip) Defines a set of units that contains customaryU.S. engineering units. It provides force-
related units in “kip” and length-related units in “in.”

US (in-lbf) Defines a set of units that contains customaryU.S. engineering units. It provides force-
related units in “lbf” and length-related units in “in.”

MTS
TestSuite

Meters-Kilograms-Seconds. Defines a set of units that is based uponmeters,
kilograms, and seconds. Force is expressed as “N.”

Unit Set Manager Overview

Access
Preferencesmenu > Configuration > Unit Set Manager tab

The UnitsManager window enables you to assign unit sets, such as International System of Units (SI),
United States Customary System of Units (US), or custom unit sets as your MTS TestSuite or project
default. You can copy a predefined unit set andmanage your custom unit sets using the following
buttons:

l Add
l Delete
l Edit
l Copy
l Export
l Import

Default Unit Set Selections
To assign a unit set as the default for MTS TestSuite, in theMTS TestSuite Default box, click the list
arrow and select a unit set from the dropdown list. Perform the same action to assign a unit set as the
default for Project Default for "Project 1".

Manage Unit Sets
To view the specific units of measurement defined for a unit set, click the name of a unit set in the Unit
Sets panel; the units are then displayed in the Units column.

A project with an assigned unit set uses the unit set for all dimensions in the project procedures. A
project without an assigned unit set uses the set defined as the system default.

To sort a list, click the column title.
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Unit Set Manager Properties

Item Description

MTS TestSuite
Default

Shows the current default unit set for the applications. Click the list arrow to
assign another predefined or custom unit set.

Project Default
for
<ProjectName>

Shows the current assigned unit set for the project. Click the list arrow to assign
another predefined or custom unit set.

Name Shows the predefined unit sets and the custom unit sets.

Type Shows the type of unit set: predefined or custom.

Dimension Shows the type of dimension.

Unit Shows the unit selections for that type of dimension. If the unit set is a custom unit
set, click the list arrow to display selections for that type of dimension.

Add Open the Add CustomUnit Set window where you can add a custom unit set.
Enter a display name and description, and select between an International
System of Units (SI) or a United States Customary System of Units (US).

Delete Delete a custom unit set. You cannot delete a predefined system unit set.

Edit Open the Edit CustomUnit Set window where you can change the display name
or description. You cannot change the type of unit system or the individual unit
settings.

Copy Open the CopyUnit Set window tomake a copy of the highlighted unit set. If you
copy a predefined unit set, the copy becomes a custom unit set in which you can
change the unit settings.

Export Export a custom unit set to another project or analysis. Click the required custom
unit set (.tsunitset) to export.

Note: If your project uses a custom unit set, it also exports with the project.

Import Import a custom unit set from another project or analysis. Click the required
custom unit set to import (.tsunitset).

Apply Save any changes and keep the Unit Set Manager window open. This button is
useful if you aremakingmultiple custom changes.

Unit Set Manager

Add a Custom Unit Set
To add a custom unit set:
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1. ClickPreferences > Configuration > Unit Set Manager to open the Unit Set Manager.
2. ClickAdd to open the Add CustomUnit Set window.

3. Enter a name for your unit set in theDisplay Name box.
4. Enter a description in theDescription box.
5. (Optional) Click the drop-down button to selectUS Customary Units in theUnit System

box as the predefined settings for your custom unit set. This optional step canminimize the
number of individual changes required to customize your unit set. You are not required to
select a unit system type.

6. ClickOK.

Add a Custom Dimension
In the Unit Set Manager window, you can create a custom dimension. After creating a custom
dimension, youmust add at least one custom unit to the dimension. All custom dimensions that you
create are visible in all unit sets.

Youmaywant to create a custom dimension if your testing requires a dimension that does not already
exist in one of the default unit sets. For example, you could create an Inverse Energy per Volume
dimension and then add a default custom unit of 1/lbf*in².

To add a custom dimension:

1. ClickPreferences > Configuration > Unit Set Manager to open the Unit Set Manager.
2. In theDimensions section of the Unit Set Manager, click theAdd a new item icon (+). The

Add CustomDimension window appears.

3. Right-click the dimension and selectEdit. The Edit Dimension window appears.

4. Enter an Internal Name andDisplay Name for the new custom dimension.

5. Click theAdd a new item icon (+) and enter an Internal Name andDisplay Name to
create the a unit for the dimension. By default, this unit will be the default unit, but you can click
the green checkmark icon to set a different unit you add as the default unit. For detailed
information about creating and editing custom units, see “Add a CustomUnit” on page 78.

Add a Custom Unit
In the Unit Set Manager window, you can create a custom unit for a dimension.When you add a new
unit to a dimension, the unit can be used in various places throughout the application the sameway
other units are used. For example, you could configure ameter to display real-time data using the
custom unit on theMeters tab. Additionally, you could configure a variable used in your test procedure
to store data using the custom unit on theVariables tab.

It may be necessary to create a custom unit if your testing requires a unit that does not already exist in
the available unit sets. For example, if you aremeasuring stress, there are several commonly-used
units available (such as lbf/ft²). However, other units of stress (such asN/100cm²) are not available in
any of the default unit sets. Therefore, youmaywant to add a N/100cm² unit to the stress dimension if it
is required for your testing.

To add a custom unit:
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1. ClickPreferences > Configuration > Unit Set Manager to open the Unit Set Manager.
2. In theDimensions section of the Unit Set Manager, select the dimension to which you want

to add a custom unit.

3. Right-click the dimension and selectEdit. The Edit Dimension window appears.

4. Click theAdd a new item icon (+). The Add New Unit window appears.

5. Enter an Internal Name andDisplay Name for the new custom unit.

6. ClickOK to close the Add New Unit window.

7. (Optional) Click the editable fields under the Scale andOffset columns to specify a scale and
offset for the unit.

l The scale determines how the unit scales with respect to other units in the dimension.
To understand how scale works, consider timemeasurements. Seconds are treated
as the base unit, so they have a scale of 1. Minutes and hours are scaled depending
on how many seconds they contain, so their scales are 60 and 3,600 respectively.

l The offset is a positive or negative value that is always applied to the unit. To
understand how offset works, consider temperaturemeasurements. K (Kelvin) is
treated as the base unit, so it has a scale of 1 and an offset of 0. °C also has a scale of
1 because it scales linearly with K (that is, a 1 K change is the same as a 1°C degree
change). However, because converting fromK to °C requires subtracting 273.15,°C
has an offset of -273.15.

8. ClickOK to close the Edit Dimension window. The new unit is added to the dimension.

Remote Server Settings
Access
Preferencesmenu > Configuration > Remote tab

Use theRemote tab to enable and use remote extensions, if available. This tab is used to set upMTS
TestSuite to communicate with MTS Echo.

Item Description

Enable Remote
Services

Enables the use of remotes serviceswith MTS TestSuite.

Server URL If desired, enter the URL of a custom remote server. By default, the built-in
remote server will be used.

Hide Server
Console

Select this option to hide the remote server console window.

Remote Panel Settings
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Working with Resources
Resources Overview
Fastpath:
Define tab > Resources node

TheResources node in the test definition tree of theDefine tab serves as amap between controller
configuration resources and the test definition. TheResources node allows you to define a test
independently, away from the controller, and thenmap the resources to the controller before the test is
loaded. The application stores the resourceswith the test definition. You can re-map the resources to
accommodate particular controller configurations.

Test resources can include:

l Actions

l AnalogOutputs

l Channels

l Digital Inputs

l Digital Outputs

l Float Signals

l Integer Signals

Controller resources
Youmust map the test resources to controller resources before you can load and run the test
procedure on that controller. Resources are stored with the test definition and validated against the
available controller resources the next time the application connects to a controller.

Template resources
You canmap controller resources and then create a test template that includes the controller
resources at the time the template is created. You can then remap any resources as necessary to the
controller the next time the application connects to the controller.

Imported resources
When resources are correctlymapped in a test, you can create other tests offline, and import the
resources between tests. You can alsomanually add andmap individual resources.

Simulated resources
If you are not able to connect to the physical controller, you can use the controller software in
simulationmode and use a pre-configured controller configuration file. In this case, the simulation uses
the controller configuration file as its source for controller resources.
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Internal Name and Display Name

Internal Name
Generally, this is a name that is used internally to the application or by a calculation. These names do
not usually contain spaces and have character restrictions. In some cases, internal names are
assigned by the application and cannot change, and in other cases they are defined by the user and
can change. Because other parts of the system use the internal name, some additional restrictions are
in place tomake sure that changing the internal name does not cause the program to fail. In some
cases (such aswith variables), the name is adjusted where it can be, but in others (like test resources)
it will not allow the change to take place. These strings do not change when the language is changed.

Display Name
This is a display version of a string. It has some restrictions on allowed characters, but ismuchmore
open than the Internal Names. These strings can be changed by the user without changing any other
part of the application. Some character restrictions apply, and some validation is done so two items at
the same level do not have the same name. These strings are translated and will change based on
language if it was saved inmultiple languages (such aswith templates).

Resource Details
Fastpath:
Define tab > Resources node

Item Description

Name Shows the names of the resources that are used in the test procedure activities.

TheShow Internal Names check box toggles internal or display names in the Name
column. Typically, display names are used instead of internal names.

The Name column shows resources in a hierarchical view organization, allowing the
expand-collapse of the individual resource entries. A context right-clickmenu is also
available on the entries in the Name column that allows a variety of operations (add,
delete, and rename) that are specific to each entry.

Internal names are not typically edited and cannot be edited if the resource is in use
somewhere in the test procedure. Display names can be edited whenever the test
definition is editable. Test resources cannot be deleted if they are in use somewhere.
Test resources can be created whenever the test definition is editable.

Dimension The dimension of a test resource is only editable if no other test definitionmodules use
the resource (such as activities and runtime components). If you are connected to a
controller, do not change the dimension because that may invalidate the controller
resource assignment and show an error symbol.

Polarity Use this setting to change the polarity of a float signal. Changing the setting affects the
Effect of Increasing Extension setting. Available settings are:

l Normal

Resources Tab
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Item Description

l Inverted

Use Count Track the use of the test resource by other parts of the test definition. If a test resource
is in use, you cannot delete it.

Controller
Resource

Assign names to the resources that are expected in the configuration when Test
Manager is connected to the controller.

The resource tablemaps theController Name to the testName. The two names can
be different. Only theController Namemust match what is used in the configuration
file. The Name column shows the names of the resources that are used in the test
procedure activities.

TheShow internal names check box toggles internal or display names in the Name
column. Typically, display names are used instead of internal names.

The use of this column is different between online and offlinemodes.

Controller
Resource
(when
connected
to a
controller)

Where a cell is editable in the column, a drop-down list shows the controller resources
that are compatible with a given test resource. Resources are shown in the drop-down
list that match the dimension. The edit line contains the current assignment, whichmay
be in the list. If a displayed resource is not in the list of compatible resources, an error
symbol is shown. You can select a resource from the list, or type the name into the edit
box.

The Controller Resource name contains a red error symbol if a conflict occurs between
the resource in Test Manager and the resource in the controller configuration.

Controller configuration resources can be uniquely identified by either their internal
names or display nameswithout knowing which is being specified. Therefore, you can
type either the display name or internal name into the Controller Resource column.
The box is updated to reflect the appropriate name, based on theShow Internal
Names check box.
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Item Description

Controller
Resource
(when not
connected
to a
controller)

The list is empty because no controller is connected fromwhich to query the valid
resource names. The edit box shows the internal name. If you type a different name, it
is stored as the internal and display name. There is no validation error since there are
no controller resources to validate against.

Capacity ClickCheck to defineMax/Min resource capacity for the signal and initiate a check
against these settingswhen you attempt to run the test.

For example, the Load Cell Capacity configuration item is used to define an optional
minimumand optional maximum capacity for a load cell that is used with a specific
template. A check is performed between the definedminimum/maximum capacity with
the capacity of the load cell being used. If the load cell is inadequate, the test cannot
start.

Effect of
Increasing
Extension

Note: This setting is only available with MTS TestSuite TW or TWS software
running on anMTS Insight Controller.

This setting defines the relationship between the crosshead/displacement channel and
each float signal.

l Select Increases Valuewhen an increase in the crosshead or actuator
extension will increase the value of the signal.

l SelectDecreases Valuewhen an increase in the crosshead or actuator
extension will decrease the value of the signal.

l Select Indefinite for signals (such as time) where there is no direct
relationship to the crosshead or actuator extension.
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Resource Buttons

Item Description

Add
Resource

Add a resource to the table. Right-click the entries in the Name column for amenu that
contains a variety of operations (add, delete, and rename) that are specific to each
hierarchy entry. These operations are necessary if no controller or test resource
information is available to import.

Import
Resources
> Import
all unused
controller
resources

This function only workswhen connected to a controller. Test resources are created
that correspond to all controller resources on the controller that is currently connected.
If the table is empty, this function imports all the resources. If some resources are
mapped already, these are not imported. If conflicts occur between existing and new
test resources, the names aremodified to be unique.

Import
Resources
> Import
selected
controller
resources

This function only workswhen connected to a controller. A window openswhere you
select which resources to import. This function is useful if you have an existing test and
must add a reference to a few resources that were not used previously.

Import
Resources
> Import
resources
from
another
test

Choose another test to import the test resources from.

Delete
Unused

Delete controller resources that are listed in the resources table but are not used
anywhere in the test definition. Typically, a user can add all possible controller
resources, define the test, and delete the unused resourceswhen the test definition is
complete. This approach keeps the resource list to aminimumwith only the required
resources listed for the test, whichmakes the list easier to maintain if controller
resources change in the future.

Use
Controller
Names

Resources currently shown in the Controller Resource column are copied to the test
resource Name column. The resources in the test procedure are changed to reflect the
items in the Name column. Use this feature if you want all resource names tomatch
(between the test procedure and the controller configuration).

Resources Node Buttons
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Import Test Resources
Note: This procedure applies only to the Import Resources button on theResources node.
You can only import test resources from the connected controller or another test in the same
project.

When you import an entire project, the test resources can be included for each test in the project.
Depending on the origin of the information, the imported resourcesmay not map to the controller
resources of the control system networked with your session or workstation.

To import test resources:

1. Open the desired test.

2. If you want to import resources from the test controller, selectController > Connect.
3. Click theDefine > Resources node of the test definition tree.
4. Click the Import Resources button on the work space to show the optionsmenu.

5. To import resources from a connected controller, select one of the following options:

l Click Import the selected controller resources to select which unused resources
you want to add to the test and continue with step 6 below.

l Click Import All Unused Controller Resources to import all the controller
resources that are not currently in use by the test and continue with step 7 below.

6. If you selected Import selected controller resources:
A. Expand the unused resources hierarchy and select the check boxes for the resources

to import, or clickSelect All to select all unused resources.
B. Select theShow Internal Names check box to show the internal names for the

resources in the work area instead of their display names.

C. ClickOK.
D. The table of test resources updates and amessage window indicates that the import

was successful. ClickOK.
E. If all the controller resources are already in use by the test, a correspondingmessage

is shown. ClickOK.
7. To import resources from another test:

A. Click Import resources from another test to overwrite the test resourceswith the
imported resources.

B. In the Select Test for Resource Import window, select the required test, and then click
OK.

C. The table of test resources in the work area is updated and amessage indicates that
the import was successful. ClickOK.
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About Disabled Resources
To add versatility to templates, you can include variables, activities, and resources that you can disable
or enable depending on the specific type of test you wish to perform. This allows one test procedure to
contain resources for the various functions, while allowing the operator to “turn off” portions of the test
procedure as needed. Typically, a combination of variables, activities, and resourcesmight all need to
be disabled in order to effectively turn off a portion of a template.

If a disabled resource is referenced by an enabled resource, variable, or activity, a validation error
occurs for that reference, and the test will not run.

Disabled resources appear grayed out on theResources node and in resource lists in other areas of
the application.

Disable Resources

1. On theResources node, locate the resources that you want to disable. If a validation error
occurs, use the associated error icons to help locate resources that should be disabled.

2. Right-click the resource and selectDisable (resource).

NI M Series Multifunction DAQ
Note:
This feature only applies toMTS Criterion andMTS Insight systems.

Warning:
The information contained in this document should only be used by qualified personnel

Misunderstood, misread, or misapplied information used to set up and operate anMTS test
system can expose personnel and equipment to severe hazards. This can result in damage to
equipment (including test articles) and injury or death to personnel.

Before you use the information in this document, verify your qualificationswith your system
administrator or MTS.

MTS TestSuite supports the National Instruments (NI) MSeriesMultifunction Data Acquisition (DAQ)
driver. It supports Analog Input (AI), Digital Input (DI), and Digital Output (DO) signals.

Analog Input (AI) signals can be configured to single-ended non-referenced, single-ended referenced,
or differential if it is set up as a Voltage or Bridge device (Measurement Type). If it is setup as a
Thermocouple, it has a number of thermocouple types instead. You cannot mix differential and single-
ended signals on a test system. The virtual Transducer Electronic Data Sheet (TEDS) defines the
scaling, dimension, and units of the AI signal. For more information about TEDS, see “TEDS Devices”
on page 89.

The DI and DOsignals are grouped into ports of 8 digital signals which are either all inputs or all
outputs. DO signals support Toggle, Pulse, Set, and Clear.

AI and DI signals can be used in limit detectors.
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For more information about National Instruments Data Acquisition products, see their website at
National Instruments Data Acquisition (DAQ).

Note: Before purchasing NI M series hardware, contact MTS Technical Support to confirm your
requirements.

Configuration
To configure the NI MSeriesMultifunction DAQ for your test, youmust modify the TWDiag
configuration file. Contact MTS technical support for this procedure.

Once configured, the deviceswill appear in your test and can bemodified from the TW application
Resources tab. For more information about theResources tab, see “Resource Details” on page 83.

TEDS Devices
When the TW application is used with anMTS Criterion system, the application requires the storage of
calibration information in a TEDS (Transducer Electronics Data Sheet) device or a virtual TEDS file.
The TEDS assignments and other settingsmade in the TEDS Deviceswindow are saved as controller
resources and appear in each test that is run on that controller.

Note: The following TEDS procedures only apply to MTS Criterion andMTS Insight systems.

TEDS Devices Window
Note: This feature only applies toMTS Criterion andMTS Insight systems.

Access
Controllermenu > TEDS Deviceswindow

The TEDS Deviceswindow shows the calibration source (virtual TEDS file or TEDS device) and
provides access to the calibration settings for the signals that use a virtual TEDS file.

Overview
The TEDS Deviceswindow shows all the signal resources and TEDS assignments associated with
the controller and allows you to:

l Create a virtual TEDS file for a controller resource.*

l Update a virtual TEDS file.*

l Assign a virtual TEDS file to a controller resource.

l Configure a device verification for the selected device.

l Perform a device verification for the selected device.

l View the Device Verification History for the selected device.

* Requires the Edit Calibration Values privilege.

Note: Editing the information for a device that has a TEDS chip can only be performed by an
MTS Field Service Engineer.

http://www.ni.com/data-acquisition
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Display and Edit the Virtual TEDS Information for a Signal
Note: Editing the information for a device that has a TEDS chip is typically only performed by an
MTS Field Service Engineer.

Note: This feature only applies toMTS Criterion andMTS Insight systems.

1. On theControllermenu, clickTEDS Devices.
2. Select a signal (with a TEDS file assigned as a source) from the signal list.

3. ClickDetails. The TEDS Details window appears.

4. Edit the TEDS settings as required.

Note: To create a backup copy of the TEDS file that you can revert to if needed, click
Save As beforemaking any changes.

5. ClickOK to save your changes.

Any changeswill overwrite the settings in the TEDS file that is assigned to the signal.

Create a Virtual TEDS File
This feature only applies toMTS Criterion andMTS Insight systems.

Note: This feature only applies toMTS Criterion andMTS Insight systems.

1. On theControllermenu, clickTEDS Devices.
2. Select a signal.

3. ClickNew.
4. If the selected signal is an encoder, continue to the next step. If the selected signal is _Load, _

Strain1, or _Strain2, select the type of device in the TEDS Selector window:

l Analog Input Device: Bridge-type sensor such as a load cell or strain gage.

l High-Level Voltage-Output Sensor: Non-bridge sensor (such as a string pot) that
provides a high-level voltage output.

5. The TEDS Details window appears with default settings.

6. If necessary, edit the settings and clickOK.
7. In the Save As TEDS window, type a name for the TEDS file and clickSave.
8. The new TEDS file is now listed as the source for the signal.

9. ClickOK.
10. ClickYes to save the settings as a new file.

Assign a Virtual TEDS File to a Signal
Note: This feature only applies toMTS Criterion andMTS Insight systems.
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1. On theControllermenu, clickTEDS Devices.
2. Select a device.

l If a device already has a file assigned to it, clickRemove to remove the source
assignment.

l If a device does not have a file assigned to it, clickNew.
3. ClickOpen.
4. In the Open TEDS window, select a compatible TEDS file.

The default directory for virtual TEDS files is: MTS TestSuite\Devices.

5. ClickOpen.
6. Perform a device verification. For more information about performing device verification, see

“TEDS Device Verification Checks” on page 91.

Add TEDS Information to the Test Run Log
When the Log Type for the test is set to Audit Trail, each time a test is run, the application writes the
TEDSmodel and serial number to the test run log.

Note: This feature only applies toMTS Criterion andMTS Insight systems.

Default Log Type Setting
On thePreferencesmenu, clickConfiguration and then click the Test tab. This setting applies to all
tests.

Test Log Type Setting
Open a test, click theDefine tab, click theSettings subtab, and set the Log Type to Audit Trail. This
setting only applies to the current test.

TEDS Device Verification Checks
TEDS Device Verification Check procedures only apply to MTS Criterion andMTS Insight systems.

Perform a Device Verification Check
A device verification check compares device readings recorded during actual calibration to the
readings recorded during the check to help identify problems associated with a device.

1. On theControllermenu, clickTEDS Devices.
2. Select a signal from the signal list.

3. ClickVerify.
4. Follow the on-screen prompts to verify the device.

View the Device Verification History
TheDevice Verification CheckHistory window shows the history of all the device verification checks
run against the selected signal (device).
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1. On the Controller menu, clickTEDS Devices.
2. Select a signal.

3. ClickHistory.

Device Verification Settings

Device verification prompt
The device verification prompt is used to remind an operator to run a device verification before being
running a test. To configure a device verification prompt:

1. On theControllermenu, clickTEDS Devices.
2. Select a signal from the signal list.

3. In the TEDS Details panel, select the Device Verification Prompt for the device. For example,
if set to Daily, each day, the operator will be prompted to run a device verification before being
allowed to run tests.

Warning/Lock-Out Ranges
During a device verification, the application compares the new signal value obtained during the check
to the value obtained when the device was calibrated. To configure a warning/lock-out range for a
device:

1. On theControllermenu, clickTEDS Devices.
2. Select a signal from the signal list.

3. Set theWarning and Lock-Out ranges.
l If the difference between the new value(s) and the original value(s) is beyond the
Warning Range, a warningmessage appears. The user must determine whether to
proceed with testing or to resolve the problemwith the device.

l If the difference between the new signal value and the original signal value is beyond
the Lock-Out Range, an error message appears. The application will not allow you to
run a test until the problem has been resolved.

About the Devices Window

Access
TheControllermenu > Devices

TheDeviceswindow is available in MTS TestSuite applications connected to a FlexTest controller.
The Deviceswindow allows an operator to review current sensor assignments and change them to
compatible options as necessary.

Note: For systems runningMP version 2.6 and earlier, and Series 793 version 5.7 and earlier,
this functionality is available in the StationManager application > Station Setup window >
Sensor tab.

Clicking theDetails button will show information about the selected device.
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You can assign sensors resources:

l While theMTS TestSuite application is connected to the controller, and

l When changing between previously set-up devices.

Assign Sensor Calibration Files for New Hardware
To assign sensor resources:

1. Click theControllermenu > Devices.
2. Select the device that you want to change, and clickAssign.
3. Select the new .scf file from the drop-downmenu and clickAssign.
4. ClickOK to dismiss the Deviceswindow after all changes aremade.

External Devices
Access
Controllermenu > External Devices

The External Deviceswindow allows you to add and configure external devices as controller
resources. After the resources are configured, they can be used in tests.

Important: Many of the configuration settings are device-dependent. For more information, see
the documentation provided with the device.

Note: The External Devices procedures only apply to MTS Criterion andMTS Insight systems.

Set Up an External Device
Follow this checklist to configure an external device for use in the TWE, TWX, and TWS applications.

1. Select the Device Type you need to configure.

2. Complete the configuration settings for the device.

3. Add the External Device as a Resource in a test.

4. Map External Device commands to Controller Resources.

5. Add an External Device activity to the Test Procedure.

Refer to the topics in this section for detailed reference information and step-by-step
procedures.

Select an External Device Type
The Select Device Type window allows you to select the type of device that is connected to your COM
channel or an Ethernet connection. The TW application automatically configuresmany of the
configuration settingswith default values; however, youmay need to configure additional settings to
install your external device.



Resources

94 MTS TestSuite™ TWEssential User Guide

The TW application provides default configurations for several external devices. If your device is not
listed, you can use either the General Purpose Ethernet Device or the General Purpose Serial Device
option as a starting point.

Access
Controllermenu > External Devices

1. In the Device title bar, click the plus (+) button.

Select Device Type Window

Select from the following device types:

l Advantage Video Extensometer (AVX)—Communicateswith anMTS AVX extensometer.

l Eurotherm 2000 Series Temperature Controller (EI-Bisynch or Modbus RTU
protocols)—Communicateswith a 2000 series thermal controller made by Eurotherm. The
device can read data or set the temperature setpoint.

l FVX Video Extensometer
l General Purpose Ethernet Device—Use to configure an external device that
communicates over an Ethernet connection.

l General Purpose Serial Device—Use to construct a serial device configuration to
communicate with any serial device. Select this option if you need to set up a device that is not
shown in the list.

l LX Series Laser Extensometer—Communicateswith anMTS LX Series laser
extensometer. This device is designed to send commands such as turn the laser on or off to
the laser extensometer.
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l MFL AutoExtensometer
l Mitutoyo
l Sylvac

Create a Controller Resource for an External Device
Note: The following procedure applies toMTS Criterion andMTS Insight systems only.

1. Create the controller resource for the external device.

A. From theControllermenu, clickExternal Devices. The External Device window is
displayed.

B. In the External Deviceswindow, click the plus (+) button. The Select Device Type
window is displayed.

C. In the Select Device Type window, click a device type from the list.

Note: If the device you want to add is not listed, click theGeneral Purpose
Ethernet Device Type orGeneral Purpose Serial Device Type as
appropriate.

Once added, the new external device appears in theDevice list of the External
Deviceswindow.

2. From theDevices list, select the device that you want to configure.
3. Use the tabs in the External Deviceswindow to configure all the settings required for

communicationswith the external device.

Note: After you create the External Device resource, youmust use theResources tab
to add the device to your test and define the device commands.

External Device Configuration Settings
Many of these settings are device-specific. Refer to the devicemanual for information on device
settings.
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Tab Settings

Device
Configuration
(Serial
Devices)

Device Name—TheController Name that appears in the Resources list.

Serial Port - Select the COMchannel for the serial port.

Device
Configuration
(Ethernet
Devices)

Device Name—TheController Name that appears in the Resources list.

IP Address—Enter the unique IP address set up on the device.

Port—Enter a port number to identify the device. If multiple Ethernet devices are
used, each devicemust have a unique port number assignment.

Device
Configuration
(Serial and
Ethernet
Devices)

Read Termination String (ASCII only)—Enter the string that appears at the end
of eachmessage from the external device. For more information, see “ASCII
Control Codes for External Devices” on page 104.

Write Termination String (ASCII only)—Enter the string that will appear at the
end of eachmessage sent to the external device. For more information, see “ASCII
Control Codes for External Devices” on page 104.

Read Timeout—Enter the time the TW application waits for a response after
sending a read command to the external device before a timeout occurs.

Write Timeout—Enter the time the TW application waits for a response after
writing a command to the external device before a timeout occurs.

Error String—Enter the error string returned by the device.

Protocol—Select the protocol used to communicate with the device.

Note: The ASCII protocol does not support device addresses.

l ASCII

l Eurotherm EI-Bisynch - For use with Eurotherm 2000 Series
Controllers that use the EI-Bisynch protocol.

l Modbus RTU (remote terminal unit) - For use with devices that support
this protocol.

Device Address - Enter the device address. This setting is used by the TW
application to identify the device. If multiple devices share the sameCOMport, set
the Device Address to None andmanually enter the device address in device-
specific commands that you create in theCommand Settings tab.

Port Settings
(Serial Device
only)

If necessary, adjust the default serial port settings for the external device:

l Bits Per Second

l Data Bits

External Device Configuration Settings
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Tab Settings

l Parity

l Stop Bits

l Flow Control

l Restore Defaults - Click to restore default settings.

Command
Settings

Use the Command Settings tab to add the commands that the TW application
uses to communicate with the external device.

Command Name—Enter the name of the command. For example, the LX Series
Laser Extensometer uses the Target Distance command name for the Tn
command.

Command—Enter the command required by the device. For example, the LX
Series Laser Extensometer uses a L0 command for “Laser ON” and R for “Read
Data.”

Note: Enter%s (lower case) in theCommand box if the output command
will be determined by a variable defined in an External Device test activity.

Send Byte Data—Select if the command is sent to the device as a byte.

Wait for Acknowledgement—Select to have the TW application wait for a
response after it sends information to the external device.

Supports Return Value—Select if the external device returns an input value.

Important: This check boxmust be selected if the input value will be written
to a variable.

Value Type—Select a value type, such asFloating Point.

Offset—Select to enable an offset on the return value. In the field, enter the offset
to be applied.

Regular Expression—Enter the string that defines how to filter the string (return
value) returned by the external device.

Note: Click the ? button to display the Regular Expression Tool that allows
you to check the expression’s effect on various strings.

For more information on how to use this utility, see “Regular Expression Tool” on
page 98.

Multiplier—Use themultiplier value to scale the return value sent by the external
device into system units.

Signal
Settings

Can Be Streamed check box—Select the check box if the device provides a signal
stream that may be used in a test. Deselect the check box for devices that do not
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Tab Settings

provide a signal stream.

Internal Name—Enter the internal name of the controller resource.

Display Name—Enter the display name (the controller name displayed in the
Resources list).

Dimension—Select the dimension for the external device signal.

Unit—Select the unit for the dimension.

Query Command—Select the command (defined in theCommand Settings
tab) that the TW application sends to the external device to start streaming data.

Time Interval—Defines how often the TW applications sends theQuery
Command to the device to request information.

Device
Verification

Command—Select the command (defined in theCommand Settings tab) to
send for verifying the device is communicating with your PC.

Send Command—Click the Send Command button to verify the device is
responsive.

Response—Displays the response received from sending the command.

Add a Command to an External Device
To add a command to an external device:

1. From theControllermenu, clickExternal Devices. The External Device window is
displayed.

2. In theDevice list, select the device for which you want to add a command.
3. Click theCommand Settings tab.
4. Click the plus (+) button.

5. In the CommandDetails panel, enter theCommand Name andCommand.
6. Make other selections as appropriate for the command and device. For more information, see

“External Devices” on page 93.

Regular Expression Tool
To use the regular expression tool:

1. In the External Deviceswindow, click theCommand Settings tab.
2. Select a command that you want to edit. If necessary, clickAdd to add a new ReadData

command.

3. In the CommandDetails panel, select theSupports Return Value check box. TheRegular
Expression Pattern field becomes available.
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Command Details Window

4. Use the Regular Expression Tool to verify the expression.

A. Click the QuestionMark (?) button next to theRegular Expression text box to
display a pop-up window.

Regular Expression Tool

B. In theRegular Expression text box, enter the expression.
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C. In the Test String text box, enter an example of the string returned by the external
device.

D. ClickMatch and evaluate the filtered result that appears.
E. Change the expression as required until you achieve the desired result.

Device Address Considerations
The configuration for various devices affects the address and the command settings for these devices.

Multiple devices connected to a single COM port
Some device configurations, such as theMTSModel 409.83 Temperature Controller, includemultiple
devices that connect to a single COMport. The collection of devices is given a device name and the
addition of device addresses to the commands allows the application to communicate with a specific
device.

1. On theDevice Configuration tab, set theDevice Address setting to None.
2. On theCommand Settings tab, type the device address in front of each command setting.

For example, if the read-temperature command for a particular controller is PV and there are
three temperature controllers whose device addresses are 1, 2, and 3, you could add three
commands (1PV, 2PV, 3PV) and give the commands descriptive names such asRead
Temperature Device 1, Read Temperature Device 2, and Read Temperature Device 3.

3. When the device is used in an External Device activity, you can select the command for a
specific device.

Single devices connected to a COM port
For devices that are connected to a dedicated COMport:

1. On theDevice Configuration tab, set theDevice Address setting to the device’s address
number.

2. On theCommand Settings tab, enter the desired commands.
When the device is used in an External Device activity, you can select the command and the
application automatically adds the device address to the command.

Add an External Device Resource to a Test
Use this procedure to create a test resource from an external device controller resource.

Method 1

1. Click the Test Definition tab and then theResourcesnode.
2. Click Import Resources to add the external device to the resource list.

All the commands associated with the device appear in the properties table.
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Method 2

1. Add the external device to theResources list for the test.
A. Click the Test Definition tab and then theResources node.
B. ClickAdd Resource and chooseExternal Device.

Choose External Device

2. In the Add External Device Resource window, define the test resource:

Add External Device Resource Window

3. Select the external device from theController Resource list.
4. Configure the controller Resource:

l Display Name - Enter the display name for the controller resource.
l Internal Name - Enter the internal name for the controller resource.
l Dimension - Shows the dimension set in the External Deviceswindow.
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l Show Controller Internal Names - Select this check box if you want the internal
name (defined above) displayed in theResources list.

5. ClickOK. The device now appears in theResources list for the test.
6. Tomap the test resource commands to controller-resource commands associated with this

device, youmust add each external-device command by clicking the + button in the device
properties table.

Map External Device Commands to Controller Resources
You can use the external device properties in theResources node tomap test resource commands to
controller resource commands. This is helpful if you create a test offline and your test resource naming
does not match the controller resource naming.

1. Click the Test Definition tab and then click theResources node.
2. In theResources list, select the external device that contains the command settings that you

want to map.

The properties table for the device has two columns:

l TheName column lists all of the test resource commands.

l TheController Resource column shows the command settings for the selected
device. Each controller resource includes a drop-down list that allow you tomap it to a
test resource.

Properties Window

Note: If you clicked Import Resources to add the external device to the
resource list, all the commands associated with the device appear in the
properties table.

Note: If you clickedAdd Resource to add the external device to the resource
list, youmust add each command by clicking the + button in the device
properties table.
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3. Use the controller resource lists to map test resources to controller resources.

A. In the Properties table, select a test resource.

B. Select a controller resource from the drop-down list.

4. Optional - to create a new test-resource command:

A. On the properties table for the external device, click the plus (+) button.

B. Select the new test resource (added to the bottom of the list).

C. Select a controller resource from the drop-down list.

Device Verification for External Devices
TheDevice Verification tab allows you to send a command to an external device and observe the
response. Use this feature to verify the operation of an external device or to send commands as part of
a calibration procedure.

1. On theControllermenu, clickExternal Devices.
2. On theDevices list, click the device that you want to verify.
3. In the External Deviceswindow, click theDevice Verification tab.

Device Verification Tab

4. From the Command list, select the command that you want to send to the device. The
Command list contains all the commands defined in theCommand Settings tab.

5. ClickSend Command. The response returned from the external device is displayed in the
Response field.

Export and Import External Device Files
You can export the configurations of your external devices for import into another TWworkstation. The
exported device file has the .tsExternalDevice file extension. Device files are exported to theMTS
TestSuite > External Files directory.

Export an External Device File

1. ClickController > External Devices. The External Deviceswindow is displayed.

2. In theDevice list, select the device you want to export.
3. ClickExport. The Export the External Device File window is displayed.



Resources

104 MTS TestSuite™ TWEssential User Guide

4. Enter a File name and clickSave.
5. ClickOK.

Import an External Device File

1. ClickController > External Devices. The External Deviceswindow is displayed.

2. Click Import. The Select External Device File to Import window is displayed.

3. Select the file to import and clickOpen.
4. ClickOK.

Remove an External Device Resource
Note: If the external device is in use as a controller resource within a test, removing the
resource results in a test resource validation error.

1. ClickController > External Devices. The External Deviceswindow is displayed.

2. In theDevices list, select the device you want to remove and click theminus (-) icon. The
device is removed from the list.

ASCII Control Codes for External Devices
The following are the control characters used by serial devices. Themost commonly used are the ^M
(carriage return – CR) and ^J (line feed – LF).

Code Meaning

^@ NULL

^A SOH

^B STX

^C ETX

^D EOI

^E ENQ

^F ACK

^G BEL

^H BS (Backspace)

^I HI

^J LF (Linefeed)

^K VI

Control Characters Used By
Serial Devices
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Code Meaning

^L FF

^M CR (Carriage Return)

^N SO

^Q CS1

^R DC2

^S DC3

^T DC4

^U NAK

^Y EM

^Z STB

^[ ESC (Escape)

^\ FS

^] GS

^^ RS

^_ US

Analog Outputs
You can use analog outputs to control various analog devices including data recorders, external data
subsystems, oscilloscopes, fans, or other devices.When you connect an analog device to theMTS
Insight controller, the controller will send a specified voltage (between 0 and 10 V) to the device based
upon signals from resources in your test, such as force, stress, or strain.

Using calculations to derive an analog signal
You can use calculations to derive the analog output voltage based on one or more resources in your
test. For example, consider a scenario in which you are using two extensometers to test dog bone
specimens. In this case, youmight want the analog output to take themeasurements of both
extensometers into account when deriving the analog output signal. To do this, you would create a
calculation that adds the extensometer signals together and then divides the result by two. This
calculation causes the controller to produce an analog output signal based upon the average of the two
extensometer signals.

Importing analog output resources to a test
MTS Insight controllers allow for up to two analog outputs. Before you can enable an analog output,
youmust import the analog output as a resource in your test. After you import the analog outputs, they
appear on theResources node of the Test Definition tab:
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Analog Outputs on the Resources Node

Configuring Analog Outputs
After you add an analog output, youmust select aDimension,Controller Resource, and calculation
for the analog output. Additionally, you will need to configure a TEDS file, which is used to translate
signals from resources into voltages sent to the analog device.

1. On theResources node of the Test Definition tab, select aDimension (such asForce,
Stress, or Strain). This dimension qualifies the values of the analog output when used by the
analog calculation and the TEDS file.

2. If youmodified the name of the controller resource, select themodified controller resource
name inController Resource. By default, the controller resources used by the two analog
outputs are set toAnalog Out 1 andAnalog Out 2.

3. Create a calculation that will be used to derive the analog output signal:

A. SelectAnalog Output 1 and click the… button next to theCalculation field in the
Properties panel. The Calculation Editor window appears.

B. Enter a calculation for AnalogOutput 1. For example, if you want the analog output
signal to rely on the stress signal, you would simply add the Stress signal. However,
you could create amore complex calculation, if necessary. For example, if you create
a calculation that adds the signals from two attached extensometers together and
divides them by two, the calculation will produce the average of the two extensometer
signals.

4. ClickController > TEDS Devices. The TEDS Deviceswindow appears.

5. Select theAnalog Out 1 device.
6. If theAnalog Out 1 device already has a TEDS Source listed, clickDetails to edit the

existing TEDS file. Otherwise, clickNew to create a new TEDS file.

7. The TEDS Detail (AnalogOutput 1) window appears. For detailed information about
configuring TEDS devices, see “TEDS Devices” on page 89.
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When configuring the TEDS file for an analog output, thePhysical Measurandmust match the
Dimension that you selected forAnalog Output 1 on theResources subtab.When configuring the
minimumandmaximummeasurand values on the TEDS Details (AnalogOutput 1) window, keep in
mind that these values correspond to theMinimum Electrical Value andMaximum Electrical
Value.

For example, consider a scenario in which theminimum force that will be applied during your test is 0
N, and themaximum force will be 100 N. In this case, you would configure the TEDS file as follows:

TEDS File Property Value/Unit

MinimumForce/Weight 0 N

MaximumForce/Weight 100 N

MinimumElectrical Value 0 V

MaximumElectrical Value 10 V

Configuring a TEDS File for an
Analog Output

As a result, the controller will produce 0 V when 0 N of force is applied. When the full 100 N of force is
applied, the controller will produce a full 10 V.When only 50 N of force is applied, the controller will
produce 5V. If the analog device connected to the controller is an oscilloscope, for example, the
oscilloscope will show readings based upon these voltages.
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Tests
Tests Overview

Note: Youmust have the Administrator or Engineer privilege on a TWE system to create or
modify a test procedure.

A test is a file that contains test run data (if test runswere performed), and includes a copy of the
template. You can design your own test or create one from a template. Each test includes:

l A test definition

l Test runs

A test run is a single instance of running the test procedure. The data is stored in a test file with a copy
of the test procedure or template.

Test definition
The following tabbed pages are available for creating or modifying tests.

l Select—Open new, existing, or recently run tests.

l Monitor—Observe Pre-test input values as the test progresses.

l Define > Test flow > Pre-test/Pre-test run Inputs—View the properties of existing
variables and to create new variables.

l Define > Test flow > Test run > Procedure—Construct the sequence of activities
(command, test control, and DAQ) that make up a test.

Note: Variables are an important part of a test, because they represent test values or
other information generated or accumulated during a test run. Variables are defined for
and used with a particular test. Each new test run stores a copy of the variables as
defined when the test run is created.

l Define > Test flow > Report templates—Create templates that are used to generate test
reports. You can also import report templates previously exported from another test. Report
templates are created inMicrosoft Excel.

l Define > Test flow > Report templates—Configure, andmanage the hardware and virtual
resources that are available from the assigned test station. You can import resources
previously exported from another test.

Error list window
The Error List window showsmessages about possible problemswith the configuration or procedure
that is being constructed.

Test run reports
The application can create reports for each test run. The report content and appearance are specified
by the templates you create with theMTS TestSuite Reporter Add-in for Microsoft Excel.
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Test Procedure Overview
A test procedure includes the system actions you want the application to perform during a test. The test
procedure is located on theDefine > Test flow > Test run > Procedure node.

Each test has a single procedure that is stored with the test definition. The procedure is included when
you create test templates. You can define the procedure while connected to hardware resources or
while working offline with the resources stored with the test from an earlier connection.

Procedure design
Whether you work with the Procedure workspace that shows the current test procedure as a flowchart
or the Outline view that shows the procedure as a hierarchy in a tree view, the graphical display
simplifies creating tests.

The Toolbox panel contains activity icons that you drag into the Test Editor and name to build a
procedure. The Properties panel shows the properties that you set for the selected activity. You can
hide or resize the panels to increase the amount of visible workspace.

Navigation
The flowchart view includes Pan and Zoom controls to help youmove around complex text
procedures. TheOutline view provides the Find option for locating activities by name.

Test Procedure Pan and Zoom Controls
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Procedure activities
Activities are the building blocks for test procedures. To add an activity to a procedure, click the activity
in the toolbox and drag it to a location in the proceduremarked with a plus sign. If it is the first activity
being added, drag the icon to theDrop Activities Here area.

The types of procedure activities include:

l Operator messages

l Conditional if/else processing

l Command generation

l Data acquisition

l Auto offset

l External device control

Activity properties
Most activities require you to specify properties to fully define how the activity should perform.When
you add an activity that has parameters you are required to specify, the activity in the procedure
includes an error icon. TheProperties tab identifies the parameters, and the Error list describes the
problem. Youmust correct all errors in the test before you can initialize and run the test.

All activities have aDisplay Name that defaults to the activity name. You can enter a name to display
for an activity. All activities provide an optionalDescription field to document the procedure design.
You can also set the visibility of the activity in the Progress Table.

All activities have theEnabled check box selected by default. You can clear theEnabled check box to
disable an activity.

Creating a Test
From the Filemenu, you can create a new test as follows:

l New Test From Current Test: Creates a new test from the test that is currently open. Any
test runs from the test that is currently open will not be transferred to the new test.

l New Test From Template: Creates a container file called a test that is used to collect data
and contains a copy of the template. Each time you run the template on a physical specimen,
the application creates a test run. The test run is a data set that populates the test.

Note: Only templates for which you are licensed appear in theNew Test From
Template list.

l New Test From Existing Test: Creates a new test that includes a copy of the test without
test run data.

l New Test From File: Creates a new test from an XML file; typically used in automation.

l New Test from TestWorks 4 Import File: Creates a test from a legacy TestWorks 4 import
file.

Saving Test Changes
The application saves test changes in two ways:
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l User-prompted saves

l Automatic saves (background saves)

User-prompted saves
When you create a test, that is, while you are configuring a test on the Test Definition tab, only user
prompted saves are performed. This allows you tomake changes to your test design and then back out
of those changes as long as you do not run the test. To save changes to a test before you run it, you
must selectSave from the Filemenu or choose to save changeswhen prompted upon closing the test
or exiting the application.

Note: You cannot save parts of a test. When you clickYes, the entire test is saved.

Automatic saves
When you run a test, the application automatically saves the test without a user prompt as follows:

l At the beginning of the test run

l Periodically during the test run

l When the test run completes

l When the test run is interrupted (e.g., power loss to the test frame)

l When the test run is stopped (pressing theStop button on the Test Controls panel)
l When the test is unloaded (pressing the arrow button to the right of the Test Controls panel)

Considerations for automatic saves
When you start a test run, the application automatically saves the current state of the test. If you want
to modify a test without saving your changes, that is, experiment with the test, you should perform a
File > Save As of your test, modify as desired, and then run the new test.

If you inadvertently run amodified test and want to back out of the changes youmade to the test before
you ran it (and the application automatically saved it), youmust do somanually.

Saving a Test
To save a test:

1. To save a test without closing it, select File > Save, or click theSave icon.
2. To close the test, select File > Close Test.
3. You are prompted to save the test if you havemade changes to the test.

Deleting a Test
Important:When you delete a test, all test definitions, test runs, test data, and reports are also
deleted.

Using MTS TestSuite software
From the Filemenu, selectDelete Test.
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Using Windows Explorer
If you want to deletemany tests at once, or if you need to remove tests that are corrupt and cannot be
opened, useMicrosoft WindowsExplorer.

Test files have a .test extension, and reside in Project files, which have .project extension.

By default, Project files are located at:C:\MTS TestSuite\Projects.

Test Runs
Test Runs Overview
A test run is the record of a test performed on a single, selected specimen.

Test runs are stored in the test and include:

l A copy of the test definition, including the procedure, at the time the test run is created

l A copy of the name of the selected specimen and its values at the time the test run is created

l A copy of the variable definitions at the time the test run is created

l Variable values during the test run

l Runtime progress (state) information

l Results data

Note: Information that is not saved with the test run includes runtime displaymonitor
information and the test resourcemapping. The test run does not reflect changesmade
after the run concludes.

Test run definition
To create a test run, youmust have a valid test definition that includes:

l One or more specimen definitions

l A test procedure

l Properly-mapped test station resources

l Any required variables

l Optional - Add functionality to generate reports for individual test runs or for all test runs.

Before you can create a test run, youmust resolve any validation errors in the test definition. Click the
test name in the test hierarchy to show a table with a summary of the validation errors for the test
definition.

Test results

Reports
To generate reports for existing test run results, youmust have theMTS TestSuite Reporter Add-In
license.
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Multiple instances of test runs
To avoid possible resource conflicts, do not openmultiple instances of the same test run.

Test Run State Colors on the Review Tab
The color of a test run entry on theReview tab indicates its run state.

Color Description

Black The test run completed successfully.

Dark Blue The test run initialized successfully but has not run.

Red The test run stopped.

Orange The run is running, on hold, or an error occurred.

Test Run State Colors

If a test run name is orange, datamay not be available. If an error occurs while the test runs, no data is
viewable. If an interruption occurs, some datamay be available.

Test Run from an XML File
MTS TestSuite applications can read a user-supplied XML file that defines a number of test runs that
can be run with minimal operator involvement.

The XML file will:

l Create a new test from the template defined in the XML file.

The name of the test is defined in the XML file. Typically, each XML file includes a unique test
name.

l Create a test run for each specimen defined in the XML file.

l Assign values to variables in the test run.

l Assign a name and geometry type to the specimen. The specimen namewill also be used for
the test-run name.

Note: A sample XML file that can be used as a test-from-file template is located in the
C:\MTS TestSuite\External Files directory.

Create a Test Run from an XML File
Note: Test runs imported from an XML file are always performed in the order defined by the
XML file.

1. Start theMTS TestSuite application.

2. Optional - Use the Configuration settings to select a project to store the test.
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3. On the Filemenu, clickNew > Test from File, or on the Select page, clickNew Test and
then double-click theNew Test from File icon.

4. In the file open window, select the XML file that defines the test runs that you want to run and
clickOpen.
TheMTS TestSuite application reads the XML file and creates a list of test runs that appear in
theReview tab. The test runs appear in the order defined in the XML file.

5. Click theReview tab to track the test run progress.

In theReview tab, the text for each test run that has not been run appears in blue italic.

6. Click theRun button.
The test run is executed and the test run results appear in theReview tab. As each test run is
performed, the text changes from blue italic to regular (non-italic) black text to indicate that the
test run is complete.

7. Click theRun button to run the next test run. Repeat until all the test runs are complete.

Pre-Allocating Multiple Test Runs
If you are testingmultiple specimens, you can improve the speed and reliability of your testing by pre-
allocating test runs for each specimen.When you pre-allocate test runs, you can specify unique
variable values for each specimen prior to running tests.

Both test designers and test operators can pre-allocate specimens. The strategy you use to implement
pre-allocation depends upon your lab’s workflow. The following two examples illustrate scenarios in
which either the test designer or operator would use the pre-allocate feature:

l When designing a test, the test designer knows that 10 specimenswill be tested. The test
designer also knows the properties of each specimen. So, the test designer pre-allocates 10
test runs and enters the variable values for each specimen. The test designer then changes
the names of the test runs to Specimen 1, Specimen 2, Specimen 3, and so on for each
specimen. Finally, the test designer marks each specimenwith the corresponding number.
When the operator receives the test and batch of specimensmarked 1-10, he or she selects
the appropriate specimen for each pre-allocated test run.

l The operator often receives batches of specimens that have varying properties. Because of
this, the lab has decided that it is not efficient for the test designer to spend time designing a
new test for each batch of specimens. So, when the operator receives a new batch of
specimens, her or she pre-allocates test runs for each specimen based on the specimen
properties that were recorded on a data sheet or USB flash drive that was sent with the batch
of specimens. Additionally, because it is possible to open theReview tab while a test is in
progress, the operator runs the first pre-allocated test run and then works on configuring the
remaining test runswhile the first test run is in progress. To pre-allocatemultiple test runs,
perform the following:

1. On theReview tab, click theActions button.
2. SelectPreallocate.
3. In the window that appears, enter the number of test runs you want to pre-allocate.
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4. ClickOK. The top-most table on theReview tab is populated with the pre-allocated test runs.

Note:When you pre-allocate test runs, each test run uses the test's default variable
values.When you select a test run, you can edit the variable values for each test run in
the lower table of theReview tab.

Note: Only variables with thePreallocate option selected (in the variable properties)
are shown in the list of preallocated variables.

When you click the green Run button, the top-most test run in the list begins. When it completes, you
can click the green Run button again to begin the second test run in the list, and so on until you reach
the last test run at the bottom of the list. The names of test runs that have not yet been run are italicized.
To run a specific test run as opposed to running tests in the list from top-to-bottom, right-click a test run
and selectRun Test.

Note: If the test definition is changed during test design (for example, variables, resources, and
workflows are edited), any changesmadewill not be applied to existing pre-allocated test runs.
In this case, the test designer must delete the existing pre-allocated test runs and pre-allocate
new test runs.

Templates
Templates Overview

Access
C:\MTS TestSuite\Templates

Templates eliminate the requirement to re-create existing information and provide an easyway to run
standard tests. Test templates can come from one of several sources:

l An existing test—You open a copy of an existing test and assign it a default name (the original
test is not changed). The new test does not contain test runs or analysis runs from the source
test.

l A test that is saved as a template—You can save a test as a test template (File > Save As >
Template). With the exception of test and analysis runs, specimen definitions, and completed
reports, the template contains all other test information.

l A template supplied byMTS—MTS offers a variety of templates designed to comply with test
method standards (such as ASTM). MTS templates provide all the components you need to
run a test, analyze the test data, and create reports of the results.

Test template content
A template can include all or part of the basic test definition information for one test:

l Procedure

l Test run charts or displays

l Variables

l Resources
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Note: Although a template can include test resources, if the template is designed for a
particular controller configuration, the resourcesmay not map to (match) the test station
resources in your system.

Template locations
Tests and templates exist on disk as folders with the .Test folder name extension. They are typically
located at a subdirectory of C:\MTSTestSuite\Projects and C:\MTSTestSuite\Templates, respectively.
Report templates are located in the C:\MTSTestSuite\Report Templates folder.

Note: Do not rename, move, or change the contents of the Projects or Templates folders
outside of theMTS TestSuite applications. To rename an open test, use the Test Information
window in any application.

About saving templates
When you save a template, MTS TestSuite compresses the template and assigns an extension of
.MPTemplate for MP templates and .TWTemplate for TW templates.

Templates can bemanaged with the operating system.

Note: Template files are not fully self-contained; they contain references to other files (such as
Report Templates).

Create a Template
To create a template:

1. Open the test that you want to save as a template.

2. ClickFile > Save As > Template.
3. In the Save As Template window, type a name for the new template.

4. ClickSave.
The current test is saved as a template. All variables and their default values are saved with
the template. The template does not include the test runs or specimens from the source
project.

Delete a Template

Access
C:\MTS TestSuite\Templates

Youmust useMicrosoft WindowsExplorer to delete templates. Delete it as you would any other file.
Template files have either a .MPTemplate or a TWTemplate extension depending on which application
the template is designed for.
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Project
Projects Overview
A project is a collection of settings related to tests. When you open a test, it opens in the context of its
parent project. Files associated with tests, such as external files and reports, are linked to tests with
project settings.

You can use project settings to create logical groupings of tests that contain references to the same set
of external files. You can also open an individual test in a different project, which allows you change the
files referenced by the test without modifying the test itself (files are specified relative to the directories
in the project settings).

Assign Project Names

Access
Preferencesmenu > Configuration > Default Names tab

Use theDefault Names tab to specify default names for newly created:
l Projects

l Tests

l Test Runs

The names you specify are assigned to the itemswhen you first create them. You can change the
name at any time.

File Locations
Note: Do not rename, move, or change the contents of the Projects, Tests, Templates, or
Report Templates folders.

Projects
Projects exist on disk as special file folders with a .Project file extension. Projects are typically located
in the installation directory: C:\MTS TestSuite\Projects.

Tests
Tests exist on disk as special file folders with a .Test file extension. They are typically located in a
directory under a project.

Templates
Test Templates exist on disk as special file folders with either a .MPTemplate or TWTemplate file
extension. They are typically located in the installation directory: C:\MTS TestSuite\Templates.

Report Templates
Report Templates exist on disk asMicrosoft Excel Templates (.xltx) files. They are typically located in
the installation directory: C:\MTS TestSuite\Report Templates.



Managing Tests

120 MTS TestSuite™ TWEssential User Guide

Import Projects
You can import projects stored in a file. The projects have a .tsproj file name extension.When you
select a project to import, the entire project is imported. If the project you have selected is from an
earlier version, the ConversionWizard launches to convert it automatically to the version on disk.

Export and Import
Test Information Export Overview
When you export a test, MTS TestSuite combines the current test and its associated files into one
compressed (and self-contained) file and assigns an extension of “tsproj”.

Exported tests can bemanaged with the operating system. Unexported testsmust bemanaged within
theMTS TestSuite application.

You can selectively export test and test run information.When you initiate an export, you can choose
the item or items from the test hierarchy to export. With tests, for example, you can selectively export
only the information that you want to import into new or existing tests.

Export options
You can use options from the Filemenu or right-click entries in the test hierarchy to export:

l A test

l One or more test runs

l Raw data from a test run

Raw test data export
You can export the raw data for a test run so that you can analyze it with external software
applications. By default, raw data is exported to one or more tab-delimited text files that can be opened
with most external analytical or statistical applications. EachData Acquisition activity in the source
test procedure produces a separate data export file.

Test Information Import Overview
You can import test and test run information from previously exported test and test run files. Export files
have a .tsproj file name extension.When you import an entire test, any test that is currently open closes
and a new test is created from the imported test file. When you import test runs, you can select the test
runs you want to import into the open test.

Import options
You can import:

l A test

l Test runs

l Test resources
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Test resources import
Click the Import Resources button on theDefine > Resources node to import selected resources or
all unused resources from the test station.

You can also import resources from another test. Depending on the origin of the information, the
imported resourcesmay not map to the station resources of the control system networked with your
station. The application lists errors on the Error list andmarks them in the work area when you select
resources. Youmust correct all errors before you can load and run a test. When you use the Import
Resources button, you can only import resources from the connected test station or another test.
Three options become available:

l Import all Unused Controller Resources

l Import the selected controller resources

l Import resources from another test

Export a Test
To export a test:

1. Open the test that you want to export.

2. Select File > Export > Test.
3. In the Export Test window, clickBrowse.
4. In the Save Aswindow:

A. Locate the directory to which you wish to export the file.

B. Enter a name.

C. ClickSave.
5. In the Export Test window:

A. Select the desired specimen and test run content you wish to export with the test.

B. ClickSave.

Import a Test
To import a test:

1. Select File > Import > Test. The application automatically closes any open test and prompts
you to save any changes.

2. In the Import Test window, clickBrowse.
3. In the browser window, locate and click the required test import (.tsproj) file, and then click

Open.
4. ClickOK to close themessage window that indicates the test import was successful.

Exporting a Test Run
To export a test run:
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1. Open the test with the test runs that you want to export.

2. Select File > Export > Test Run.
3. In the Export Test Run window, expand the export items hierarchy and select the check boxes

for the test runs that you want to export.

4. ClickBrowse to open a browser window.
5. If you want to overwrite an existing test run export (.tsproj) file:

A. Locate and click on the file name in the browser window.

B. ClickSave.
C. ClickYes in the Save Aswindow.

6. If you want to create a new test run export file, enter the new file name in the File Name box of
the browser window, and then clickSave.

7. ClickSave in the Export Test Run window. The selected test runs from the source test are
written to the test run export file.

8. ClickOK in the confirmation window when the export is complete.

Import a Test Run
To import a test run:

1. Open the test.

2. Select File > Import > Test Run or right-clickTest Runs for the required test, and then click
Import Test Run. The test must be saved before you can import test runs. ClickYes to save
the test.

3. In the Import Test Run window, click theBrowse button.
4. In the browser window, locate and click on the required test run import (.tsproj) file, and then

clickOpen.
If the selected import file does not contain test runs, the Import Test Run window presents a
message. If necessary, click theBrowse button again and select a different import file.

5. In the Import Test Run window, select the target test from the Test list.
6. Expand the import items hierarchy and select the check boxes for the test runs you want to

import and clickOK. The selected test runs are added to the target test. They aremarked as
“Imported” in the Test Runs list.

Import Test Resources
The procedure applies only to the Import Resources button on theDefine > Resources node.

You can only import test resources from the connected test station or another test in the same project.
When you import an entire project, the test resources can be included for each test in the project.
Depending on the origin of the information, the imported resourcesmay not map to the station
resources of the control system networked with your session or workstation.
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1. Open the required test.

2. If you want to import resources from the test station, clickController > Connect.
3. Click theDefine tab, then click theResources node.
4. Click the Import Resources button on the work area to show theOptionsmenu.
5. To import resources from a connected station, select one of the following options: Click

Import all unused station resources to import all the station resources that are not
currently in use by the test. Click Import selected station resources to select which unused
resources you want to add to the test.

6. If you clicked Import selected station resources:
A. Expand the unused resources hierarchy and select the check boxes for the resources

to import, or clickSelect All to select all unused resources.
B. Select theDisplay internal names check box to show the internal names for the

resources in the work area instead of their display names.

C. ClickOK.
D. The table of test resources updates and amessage window indicates that the import

was successful. ClickOK.
E. If all the station resources are already in use by the test, a correspondingmessage is

shown. ClickOK.
7. To import resources from another test in the current project:

A. Click Import resources from another test to overwrite the test resourceswith the
imported resources.

B. In the Import resources from another test window, select or browse to the source test,
and then clickOK.

C. The table of test resources in the work area is updated and amessage indicates that
the import was successful. ClickOK.
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Selecting Templates and Tests
About Templates
A template is a file that contains all of theMTS TestSuite TWS settings necessary to perform a specific
test. You cannot edit templates directly. When you open a template, MTS TWS creates a test which
contains an editable copy of the template.

If the template is user-defined, you can edit the copy of the template in the test and overwrite the
original template by saving it with the same name.

MTS-defined templates are write-protected. If the template isMTS-defined, you can edit the copy of
the template in the test, but youmust save it with a unique name to create a new template.

About Tests and Test Runs
A test is a file that contains test run data (if test runswere performed), and includes a copy of the
template. A test run is a single instance of running a template.

About Modifying Templates
You typically define tests to suit your specific needs by first locating a template that meets asmany of
your test requirements as possible. Then you open the template (which opens a copy of itself referred
to as a test file), edit the test, and save the test as a template, using the same name as the original
template.

Example: Suppose you want to modify template “EMTension 2014”. To do this:

1. On theSelect tab, navigate and open the “EMTension 2014” template. When you do this,
the application opens a test file, which is an editable copy of the template.

2. Using the functions in theDefine tab, edit the test as desired.
3. Select File > Save As >Template, using “EMTension 2014” as the file name.

This overwrites the existing template with the changes youmade to the test file.

Defining Tests
Use theDefine tab to edit templates to your specific test requirements. The controls on theDefine tab
allow you to:

l Enter custom test description and specimen information.

l Assign pre-test and pre-test run inputs and calculations.

l Select and position command and data acquisition activities in a test flow.

l Define limits to detect events during the test flow.

l Define Post-Test and Post-Test Run inputs and calculations.

l Configure the test run chart, results table, and test reports.

l View and optimize test and controller resources.
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Note: Test designers typically use only a limited number of the controls on theDefine tab to
modify tests. Commonmodifications include changes to default values for test descriptions,
specimen type and dimensions, test and break detection limits, and report specifications.
Significant changes to the calculations or test flow of a standard templatemay compromise the
industrial standard.

Tip: To acquire information from operators that may change between tests and test runs, test
designers typically assign pre-test, pre-test run, post-test run, and post test inputs. Assigned
inputs show default values at the appropriate time in the test for operators to verify and edit as
required.

About the Test Flow
The test definition tree has two navigationmodes. The two navigationmodes areAdvanced Mode
andBasic Mode.Advanced Mode shows the entire test definition tree.Basic Mode shows a
simplified version of the test definition tree. The active navigationmode is switched by the toggle
buttons in the upper right-hand corner of the test definition tree pane.

Navigation mode toggle buttons

Advanced Mode
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Basic Mode

The Test Flow is divided into Pre-Test, Pre-Test Run, Test Run, Post-Test Run, and Post-Test
sections. You can assign inputs, add calculations, and configure actions for each section.

Pre-Test Section
The Pre-Test section is for activities you want the operator or application to perform before test runs
begin, such as:

l Enter values for test inputs common to all test runs.

l Configure the load train (setting up fixtures, and so forth).

l Enter the test name, specimen geometry, lot number, batch name, and so forth.

The Pre-Test section runs only once per test, before the first test run.

Pre-Test Run Section
The Pre-Test Run section is for activities you want the operator or application to perform before each
test run, such as:

l Enter values for nominal specimen dimensions.

l Calculate specimen area.

Test Run Section
The Test Run section is for activities you want the operator or application to perform during each test
run, such as:

l Install the specimen.

l Observe the test as forces are applied to the specimen.

l Monitor limit detection levels.

l Respond to amessage that indicates the framewill move to the return position.

l Remove the extensometer for specific types of extensometers and associated templates.

Post-Test Run Section
The Post-Test Run section is for activities you want the operator or application to perform after each
test run, such as:
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l Enter final values for specimen dimensions.

l Observe the test run information shown on theReview tab.

l Export data.

l Generate and print reports for the test run.

Post-Test Section
The Post-Test section is for activities you want the operator or application to performwhen test runs
are complete, such as:

l Generate and print reports for the test.

l Export data.

The Post-Test section runs only once per test, after all test runs are complete, or when the operator
clicks theRun Finish section button on theReview tab.

Note: It is typical to design tests so that the Post-Test section runswhen test runs are complete.
However, running the Post-Test section does not end the test. If the operator continues to click
theRun button after the Post-Test section is complete, new test runswill be added to the test.

About Post-Test Actions and Ending Tests
Post-Test actionswill occur as a result of following:

l After a test run is complete and theReview page appears, the operator can click theRun the
Finish section button. This is themanual way to run the post-test actions.

l The test designer can enter a value for theMaximum Test Runs variable. When the number
of test runs equals this value, the test will run the Post-Test section. This is the automatic way
to run the Post-Test section.

l Note: By default, thisMaximum Test Runs variable value is set to 9999.

Entering a Test Description
Access
Define tab > Description

Enter a new, or modify the default, test description. The information you enter (and save) appears with
the test names shown on the initial TWS application window and on theSelection tab.

Example: Suppose you want to create a test that uses English Units for rectangular specimens
based on the ASTMA370-2009 template for a specific test sample. By default, the template uses
metric units for round specimens, and the description is “This template conforms to ASTMA370-
2009”. In this case, youmaywant to change the description of your test to “This test is for Sample
ABC based on ASTMA370-2009 with English units.”

Tip: It is good practice to enter custom descriptions. Custom descriptions appear in the
windows used for selecting tests, and help users scan the lists and select the proper test quickly.
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Defining the Specimen
Access
Define tab > Specimen

Choose the specimen's geometry type and enter default parameters. The parameters you enter are
automatically added to the Test Flow > Pre-Test Run > Inputs node, and are shown to the operator
before each test run. This allows operators to verify and update specimen parameters before each test
run.

Pre-Test Section
Assigning Pre-Test Inputs

Access
Define tab > Test flow > Pre-test > Inputs

Pre-test inputs are parameters you want the operator to enter or verify at the beginning of the test,
before the first test run. Typical pre-test inputs are product identification, lot number, test date, and
operator name.

To assign pre-test inputs:

1. Click to show the Add Pre-Test Inputs window.

2. Use the arrow keys tomove the desired inputs in theAvailable list to theSelected list. The
inputs shown pertain to the test, not individual test runs.

3. Use the controls in the various tabs to define the input.

The default values of the pre-test inputs you select appear to the operator before the first test run in an
Input Variables window. This allows the operator to verify or change the input values as required.

Example: Suppose you want the operator to enter the lot number (the number identifying the
collection of specimens to be tested) before the test begins. To do this:

1. Click and use the arrows tomove the Information 1 input from theAvailable list to the
Selected list.

2. Click on Information 1 in theSelected list.
3. On theGeneral tab:

l Optional: enter “LotNumber” for the Identifier.
l Enter “Lot Number” for theDisplay Name.

When the test runs for the first time, the Input Variables window appears containing the Lot
Number prompt.
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Tip: To test changes that youmake to pre-test inputs in a test that already has test runs, delete
the test runs shown on theReview tab (select a test run, then right-click and selectDelete >
All). You can also create a new version of the test by selecting File > Save As or File > Create
Test From the Current Test.

For information aboutPre-test details, see “Input Property Details” on page 131.

Input Property Details

Tab Control Description

General Identifier Uniquely identifies the input among all inputs in the template.

Naming conventions:

l Identifiers can contain only alphanumeric, hyphen (-) and
underscore (_) characters.

l Identifiers cannot begin with a number andmust begin with an
alphabetical character.

l Identifiers cannot contain spaces, periods, or other special
characters.

Display
name

Provides amore operator-friendly way of identifying the same input for
use in displays and reports.

The default display name is the same as the identifier.

Naming conventions:

l Display namesmust be unique; however, they canmatch their
associated identifiers.

l Display names can contain alphanumeric characters, spaces,
and other special characters.

l Display names cannot contain periods andmust not begin with a
number.

Type Specifies the type of input.Number (Default) holds numeric values.Text
holds alphanumeric text.

Default Specifies a default value for the input to use until another value is
provided for the input through either operator entry or as the result of a
calculation.

Enter a value that is consistent with the input type, such as a numeric or
text value.

Note: If you enter a string for a numeric input, the default value is
forced to a numeric value of 0.000.

Input Property Details
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Tab Control Description

If you enter a numeric value for a text input, the number is treated as text
and not as a numeric value.

If you enter a numeric value outside the inputRange, an error message is
generated.

Dimension Specifies the unit dimension. Dimension is used by the application to
determine under which circumstances an input can be used.

The dimension is used to filter out incompatible inputs from being
incorrectly used within theMTS TestSuite application.

Only inputs that have a dimension that matches the dimension of the
signal can be used in an activity. For dimensionless values such as gain
or other multipliers,Dimension andUnit are not required.

Note: TheDimension andUnit properties are not applicable to
the Text input type.

Unit Specifies a unit. The list only shows the set of units that are compatible
with theDimension of the input. This is the unit of measure that you want
to assign to the input value.

Calculation Note: Pertains only to Test Flow nodes that include a
Calculations selection.

Shows the calculation that pertains to the selected input.

Clicking theCalculation icon displays the Calculation Editor window,
which allows you to edit or construct a new calculation for the selected
input.

For information about the Calculation Editor, see “Calculation Editor
Overview” on page 165

Enable Enables or disables the input for use in the test.

Clear Enabled if you do not want the input used in the test.

Inputs that are not enabled appear grayed out in the inputs list and cannot
be used in calculations of enabled inputs.

Use
previous
test run
value

Note: Available only for Pre-test run Inputs andPost-test run
Inputs.

Sets the value of the input to the value used in the previous test run. On
the first test run, the default value is used.

Editable
post-Test

Determines post-test availability:
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Tab Control Description

l When selected, you can edit the input in post-test analysis.

l When cleared, the input is read-only for post-test analysis.
During post-test analysis, you cannot change the input value in
tables or change the value bymoving chart markers.

Preallocate Note: Available only for Pre-test run Inputs andPost-test run
Inputs.

Allows you to pre-define the value of the input for individual test runs on
theReview tab. For more information, see “Pre-AllocatingMultiple Test
Runs” on page 116.

Format Type With Fixed, the number is shown in standard notation.

For example, twentymillion would be shown as 20000000.000 for aDigit
Type ofDecimal with Digits set to 3.

WithScientific, the number is shown in E scientific notation.

For example, twentymillion is shown as 2.000E+007 for aDigit Type of
DecimalwithDigits set to 3. This notation is typically used for number
values too large or small to be shown in standard decimal notation.

Digit Type WithDecimal, specifies the number of digits to the right of the decimal
symbol. For example, zero is shown as 0.000 withDigits set to 3.

WithSignificant, specifies the number of digits that are significant. For
example, zero is shown as 0.00 withDigits set to 3.

Digits Specifies how many digits to use for theSignificant Digit Type.

Range Use Range Forces the value of the associated numeric input to be equal to or
between theMinimum andMaximum limits.

When selected, the application checks the value of the input during the
test to determine if the value is within the specified range.

If the value of the input is not within the range, the application adjusts the
value to be within the range.

If the value of the input does fall inside the specified range, the value
remains unchanged.

Minimum Specifies theminimum value for the input.

If Inclusive is used and the value of the input is less than theMinimum
value, the application sets the input value equal to theMinimum value.

If Exclusive is used and the value of the input is less than theMinimum
value, the application sets the input value so that it equals theMinimum
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Tab Control Description

value plus theResolution value.

Maximum Specifies the largest number the input value can be.

If Inclusive is used, and the value of the input is greater than the
Maximum value, the application sets the input value equal to the
Maximum value.

If Exclusive is used, and the value of the input is greater than the
Maximum value, the application sets the input value so that it equals the
Maximum valueminus theResolution value.

Resolution Sets the value of the input relative to the edge of the range.

If the value of the input falls outside the specified (minimumand
maximum) range, the value will be adjusted to fall within the range. The
adjustment is relative to the closest edge of the range plus or minus the
Resolution value.

For example, if a value of -5 is entered and the range isMinimum 0
Exclusive,Maximum 10 Exclusive, and theResolution is 1, the value
will be set to 1.

However, if a value of 1.75 is entered, the value will not be changed
because it falls within the specified range. If .75 is entered, the value will
be set to 1 because .75 is outside of theMinimum 0 Exclusive limit.

Importing Pre-Test Inputs

Access
Define tab > Test flow > Pre-test > Data import

Youmay import data from an external file or a data base that defines inputs which apply to all test runs
(Pre-Test Inputs).

Important: Ensure the external source of inputs is compatible with theMTS TWS format. For
information about usingMTS TWS with an external file or database, contact MTS Service.

Importing Inputs from a File

1. Select (to enable)Data import, and then select File as the source.
2. Select if you want the operator to be prompted for the file while the test is running, and if you

want the imported Inputs to be shown to the operator.

3. Specify the Folder path and File name of the file.
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4. Note:While assigning Pre-Test Inputs, you can specify the Test ID input as the name
of the file fromwhich you import pre-test inputs.

About Importing Inputs from a Database
TheMTS TWS application can read test input data from a Laboratory InformationManagement
System (LIMS).

The LIMS stores test procedure and test results data in a central database, accessible from a network
directory shared by both systems.

The primary objective of automatically transferring input data from a LIMS/database is to eliminate
human error and improve efficiency.

You can view and select test procedure files available in the LIMS withMTS TWS.When tests are
complete, you can export the test data back to the LIMS.

Importing Inputs from a LIMS

1. Select (to enable)Data import, and then select Database as the source.
2. Select theData source to specify the file format:

l dBASE Files (file.dbf)

l Excel Files (file.xls)
l MS Access Database (multiple file extensions)

3. Add desired variables to theAssign results list using the button.

4. Specifyquery type to specify query format.
5. Enter query.

Example: Suppose you want to import test input data from anMS AccessDatabase using an SQL
query. To configureMTS TWS to read Pre-Test Inputs from this data source:

1. For data label, selectMS Access Database.
2. For query type, selectSQL.
3. Enter query: “SELECT * FROMTestsWHERE Id=@varid”, where “SELECT”, “FROM”

and “WHERE” are SQL keywords.

This query selects a record from the “Tests” table that has an “Id“ that matches the value
contained in the TestSuite TWS variable “varid”.

The “@” in front of the variable namemeans that it takes the variable’s value. The “*” in
“SELECT *” returns all columns for the record.

The variables are populated in the order that they are listed by the columns that are
returned. MTS TWS variables: “Id”, “Name”, and “Description” are the display names of the
variables that will be populated with the columns returned from the query.



Defining a Test

136 MTS TestSuite™ TWEssential User Guide

Adding Pre-Test Calculations

Access
Define tab > Test flow > Pre-test > Calculations

Pre-test calculations are calculations that pertain to global variables. Global variables are variables
associated with the entire test, not individual test runs.

To add a pre-test calculation:

1. Click to show the Add Pre-Test Calculationswindow.

2. Use the arrow keys tomove the variable for which you wish to build a calculation from the
Available list to theSelected list.

3. Click on a variable in theSelected list to show its properties.

4. Click theCalculation icon to show the Calculation Editor window.

5. Build the desired calculation from the available variables, signals, and functions on the
associated tabs. For information about the Calculation Editor, see “Calculation Editor
Overview” on page 165

6. ClickOK.

Example: Suppose you want the Test Name variable, which is used in test reports, to be a
concatenation of the lot number and the test date. To do this:

1. Click and use the arrows tomove theTest Name input from theAvailable list to the
Selected list.

2. ClickTest Name on theSelected list.
3. On theGeneral tab, click theCalculation icon to show the Calculation Editor window.

4. Build the following equation: LotNumber+TestDate, ensuring that theErrors pane
shows “Validation successful.”

Note: See “Assigning Pre-Test Inputs” on page 130 for information about creating an input
for lot number.

When you generate a test report, the Test Name is shown as a concatenation of the Lot Number
and Test Date variables, such as “Lot A1234 8/10/2014 10:10:43 AM”.

Pre-Test Run Section
Assigning Pre-Test Run Inputs

Access
Define tab > Test flow > Pre-test run > Inputs
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Pre-test run Inputs are parameters you want the operator to enter or verify at the beginning of each
test run. Typical Pre-Test Run Inputs are specimen dimensions and specimen identification.

To assign pre-test run inputs:

1. Click to show the Add Pre-Test Inputs window.

2. Use the arrow keys tomove the desired inputs in theAvailable list to theSelected list. The
inputs displayed pertain to the test, not individual test runs.

3. Use the controls in the various tabs to define the input.

The default values of the pre-test run inputs you select are shown to the operator before each test run
in an Input Variables window. This allows the operator to verify or change the input values as required.

Example: Suppose you want the operator to enter the identification number of each specimen
before performing a test run. To do this:

1. Click and use the arrows tomove the Information 2 input from theAvailable list to the
Selected list.

2. Click Information 2 on theSelected list.
3. On theGeneral tab, enter:

l “EnterSpecimenIDNumber” for Identifier.
l “Enter Specimen ID Number” forDisplay Name.

At the beginning of each test run, the application shows the Input Variables window containing the
Enter Specimen ID Number prompt.

For information aboutPre-test run details, see“Input Property Details” on page 131.

Importing Pre-Test Run Inputs

Access
Define tab > Test flow > Pre-test run > Data import

Youmay import data from an external file or a data base that defines inputs which apply to individual
test runs (Pre-Test Run Inputs).

Important: Ensure the external source of inputs is compatible with theMTS TWS format. For
information about usingMTS TWS with an external file or database, contact MTS Service.

Importing Inputs from a File

1. Select (to enable)Data import, and then select File as the source.
2. Select if you want the operator to be prompted for the file while the test is running, and if you

want the imported Inputs to be shown to the operator.

3. Specify the Folder path and File name of the file.
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4. Note:While assigning Pre-Test Inputs, you can specify the Test ID input as the name
of the file fromwhich you import pre-test inputs.

About Importing Inputs from a Database
TheMTS TWS application can read test input data from a Laboratory InformationManagement
System (LIMS).

The LIMS stores test procedure and test results data in a central database, accessible from a network
directory shared by both systems.

The primary objective of automatically transferring input data from a LIMS/database is to eliminate
human error and improve efficiency.

You can view and select test procedure files available in the LIMS withMTS TWS.When tests are
complete, you can export the test data back to the LIMS.

Importing Inputs from a LIMS

1. Select (to enable)Data import, and then select Database as the source.
2. Select theData source to specify the file format:

l dBASE Files (file.dbf)

l Excel Files (file.xls)
l MS Access Database (multiple file extensions)

3. Add desired variables to theAssign results list using the button.

4. Specifyquery type to specify query format.
5. Enter query.

Example: Suppose you want to import test run input data from anMS AccessDatabase using an
SQL query. To configureMTS TWS to read Pre-Test Run Inputs from this data source:

1. For data label, selectMS Access Database.
2. For query type, selectSQL.
3. Enter query: “SELECT * FROMTestsWHERE Id=@varid”, where “SELECT”, “FROM”

and “WHERE” are SQL keywords.

This query selects a record from the “Tests” table that has an “Id“ that matches the value
contained in the TestSuite TWS variable “varid”.

The “@” in front of the variable namemeans that it takes the variable’s value. The “*” in
“SELECT *” returns all columns for the record.

The variables are populated in the order that they are listed by the columns that are
returned. MTS TWS variables: “Id”, “Name”, and “Description” are the display names of the
variables that will be populated with the columns returned from the query.
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Adding Pre-Test Run Calculations

Access
Define tab > Test flow > Pre-test run > Calculations

Pre-test run calculations are calculations the application performs that pertain to test run variables.

To add a pre-test run calculation:

1. Click to show the Add Pre-Test Run Calculationswindow.

2. Use the arrow keys tomove the variable for which you wish to build a calculation from the
Available list to theSelected list.

3. Click on a variable in theSelected list to show its properties.

4. Click theCalculation icon to display the Calculation Editor window.
5. Build the desired calculation from the available variables, signals, and functions on the

associated tabs. For information about the Calculation Editor, see “Calculation Editor
Overview” on page 165

6. ClickOK.

Test Run Section
Working with the Procedure Editor

Access
Define tab > Test flow > Test run > Procedure

A test procedure includes the system actions you want the application to perform during a test. It is
made up of:

l Test activities displayed on the Test Editor showing a graphical representation of the test, and

l Inputs, calculations, and actions you configure in the variousTest Flow nodes.

You can define the procedure while connected to hardware resources or while working offline with the
resources stored with the test from an earlier connection.

Toolbox
The Toolbox panel contains icons for test activities that correspond to commands, data acquisition,
and so on, which are the building blocks for test procedures.

To add an activity to a procedure, click the activity in the Toolbox and drag it to a location in the
proceduremarked with a green plus sign. If it is the first activity being added, drag the icon to theDrop
Activities Here area.

The types of procedure activities include:

l Operator messages

l Conditional if/else processing
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l Command generation

l Data acquisition

l Auto offset

l External device control

l Allow handset control

Note: For detailed information about test activities, see “Test Activities” on page 241.

Test Editor
The Test Editor shows the workflow as a sequence of connected activities, and provides a work area
to edit tests.You can drag test activities from the Toolbox to the workflow.

TheOutline button shows a hierarchical view of the test in the center panel when selected.

Test activities execute from top-to-bottom as they appear on the Test Editor. Other functions you
configure for the Test Flowmay run in parallel to the test activities. For example, Limit Detection
runs in parallel to the command activities in the Test Editor.

The Flowchart view includesPan and Zoom controls to help youmove around complex text
procedures. TheOutline view provides the Find option for locating activities by name.

Properties Panel
TheProperties panel allows you to define or change the information, characteristics, and appearance
of the selected procedure activity. For example, you can use theProperties panel to change theRate
property in theGoTo panel of aGoTo+DAQ+Detection test activity.

To define the properties of an activity, select the activity icon on the Test Editor, and then select the
Properties panel. You can choose to define properties as fixed values or variables.

Error indicators assist property definition. When you add an activity, red error icons appear next to the
properties fields when information ismissing or is incorrect. TheProperties panel identifies the
parameters, and theError List located at the bottom of the display describes the problem. Youmust
correct all errors in the test before you can initialize and run the test.

All activities have aDisplay Name that defaults to the activity name plus a few key parameters that
define the activity. You can enter a unique name for an activity. All activities provide an optional
Description field to document the procedure design. All activities also have theEnabled check box
selected by default. You can clear theEnabled check box to disable an activity.

Test Design Process
The process of test design is iterative. It is good practice to implement your changes iteratively and run
the test after each iteration.

Note: For information about setting up chart parameters for viewing test runs, see “Using
Charts” on page 257.
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Step Activity Description

1 Start TWS and select a test
or template to customize.

Start theMTS TestSuite TWS application and select a
test or template that is as close as possible to the test
you want the operator to perform.

2 Modify the test. Modify the test by enabling disabled activities within the
template, changing file options, adding resources, and
editing the workflow.

3 Select and customize a
report template.

Create or modify the existing test report template by
adding test variables, changing the format, and so on.

Note: Editing report templates requires the
optional MTS Reporter Add-In for Microsoft Excel

4 Run the customized test to
validate its design.

You typically validate test design by running the test
from the operator’s perspective. Youmay choose to
enhance your test with special operator information.

5 Save your test as a
template.

When the test runs as desired, you typically save the
test as a template. When the operator opens the
template, theywill actually be opening a test version of
the template.

6 Deliver the template to the
operator.

When your new templatemeets your requirements,
deliver it to the operator.

Typical Test Design Flow

Selecting Signals for Data Acquisition

Access
Define tab > Test flow > Test run > Signals

The system acquires data from the signals listed for the data acquisition components of allGo To +
DAQ+ Detection andDwell + DAQ + Detection activities in the test.

To add signals:

1. Click to display the Add Signals window.

2. Use the arrow keys tomove the signals for which you wish to acquire data from theAvailable
list to theSelected list.

3. ClickOK.

Editing Test Run Calculations

Access
Define tab > Test flow > Test run > Calculations
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To edit a test run calculation:

1. Click on a variable in the Test run calculations list to show its properties.

2. Click theCalculation icon to show the Calculation Editor window.

3. Build the desired calculation from the available variables, signals, and functions on the
associated tabs. For information about the Calculation Editor, see “Calculation Editor
Overview” on page 165

4. ClickOK.

Working with Limit Detection

Access
Define tab > Test flow > Test run > Events > Limit Detection

Use this feature to configure limit detection according to your test specifications.

Note: The limit detection you configure in this window is independent of the break detection
controls in the command activities (Go To + DAQ + Detection andDwell + DAQ +
Detection) in Test Flow > Test Run > Procedure.

About Limit Detection
Limit detectorsmonitor signals and variables and compare their values against defined upper and
lower limits. Limit detection is active only while command activities (such asGo To + DAQ
+ Detection orDwell + DAQ + Detection) are active.

When a detector triggers, the test stops performing its activities (as shown in the procedure editor) and
skips to the next enabled task. A message indicating the limit triggered is also written to the test log.

Note: In most tests, the next enabled task the system performs after a detector triggers is
typicallyReturn to Zero, (Test Flow > Test Run > Return to Zero).

Controller Limits
Independent of the limit detection feature, theMTS Insight controller continuallymonitors the frame
capacity, the force on the load cell, and the physical limit switches on the frame. The controller issues
an interlock if the frame capacity is exceeded, if themonitored force exceeds 120% of the load cell
rating, or if the limit switches trip.
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Control Description

Signals and variables Select which signals and variables you want the limit detector to
monitor.Primary Extension and Load variables are typically
selected by default.

Click to open the Add Signals and Variables window.

Upper limit/Lower limit Select to enable the type of limit detection you desire for the
selected signal or variable.

Toggle the variable/numeric value icons to select the associated
variable or enter the desired signal value.

Limit Detection Property Details

Limit Detection Examples
You can configure limit detection in a variety of ways. Review the following examples to find the
method that best suits your needs.

Limit Detector Example 1: Suppose you want to set the value of the load limit to 250 N for a
tensile test without using a variable, and without the limit being visible to the operator. To do this:

1. AccessDefine > Test flow > Test run > Events > Limit detection

2. In theSignals and variables panel, click to show the Add Signals and Variables
window.

3. Locate Load Signal in theAvailable list, and use the arrows tomove it to theSelected
list.

4. In the Limits panel, select to enableUpper limit.

5. Toggle the variable/numeric value icon to display .

6. Enter 250 as the numeric value, and selectN as the unit.

When the operator runs the test, the load limit triggers when the load signal reaches 250 N.
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Limit Detector Example 2: Suppose you want to set the value of the load limit to 250 N for a
tensile test using a variable, but without the limit being visible to the operator. To do this:

1. AccessDefine > Test flow > Pre-test run > Inputs

2. In thePre-test run inputs panel, click to show the Add Pre-Test Run Inputs window.

3. Locate and click the Load Limit High input in theAvailable list, but do not use the arrows
tomove it to theSelected list (this prevents the variable from being shown to the operator
during the test).

4. In theGeneral panel, change theDefault to 250, andUnit toN.
5. ClickOK.

When the operator runs the test, the load limit triggers when the load signal reaches 250 N.

Limit Detector Example 3: Suppose you want the operator to have the ability to set the value of
the load limit at the beginning of each test run in a tensile test. To do this:

1. AccessDefine > Test flow > Pre-test run > Inputs

2. In thePre-test run inputs panel, click to display the Add Pre-Test Run Inputs window.

3. Locate the Load Limit High input in theAvailable list, and use the arrows tomove it to the
Selected list.

4. ClickOK.

When the operator runs the test, the Load Limit High input value is shown at the beginning of
reach test run in a Edit Variable Valueswindow. The operator can change the limit value and unit
selection as desired.

Configuring Extensometer Removal

Access
Define tab > Test flow > Test run > Events > Extensometer

Use this feature for tests that use extensometers as their primary source of extension data for the initial
part of the test, and then use the displacement sensor for the remainder of the test. The removal point
is usually set as the full travel of the extensometer. For instance, a 1 inch-50% extensometer can open
0.5 inches, therefore, the removal point for this extensometer is set at 0.5 inches.
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Control Description

What type of extensometer
will you use for the test?

Select the type of extensometer you are using for the test,
ensuring the imagematches the device you are using.

If you select an extensometer that can be removed during the test,
the window expands to show additional options.

If you select an extensometer that cannot be removed during the
test, additional options are not shown.

Note: Extensometers that cannot be removed are typically
non-contacting extensometers, and extensometers that
measure downward deflection in compression testing.

Will you remove the
extensometer before the
specimen breaks?

SelectYes if you want the operator to remove the extensometer
during the test.

SelectNo if you do not want the operator to remove the
extensometer during the test. SelectingNo removes additional
options in the window.

Which signal is the
extensometer monitoring?

Click to open the Add Signals window.

Extensometer Property Details
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Control Description

At what point will the
extensometer be removed?

This is typically set as the full travel of the extensometer.

Youmay enter a value and unit of measurement directly, or select
a variable that specifies the same. Click to toggle between
numeric and variable selections.

Do you want the test to stop
and hold when the
extensometer reaches the
removal point?

Note: The system shows amessage informing the operator
to remove the extensometer when the removal point is
reached, regardless of whether you choose to stop and hold
the test or not.

SelectYes if you want the test to stop and hold when the
extensometer reaches the removal point and the operator
removes the extensometer. This will require the operator to click
theRun button to resume the test.

SelectNo if you want the operator to remove the extensometer
while the test is running, after the extensometer reaches the
removal point.

Note: Removing the extensometer while the test is running
is typically performed only on slow moving tests, where the
operator has adequate time to remove the extensometer.

Configuring Return to Zero

Access
Define tab > Test flow > Test run > Return to zero

SelectReturn extension to the zero position to cause the crosshead or actuator to return to the
zero position at the end of each test run. This performs the same action asmanually clicking the
Return Crosshead control on the Control Panel.

SelectShow confirmation before performing return to zero action to display a prompt to the
operator before the action begins.

When selected, this action occurs even when the test status is stopped.

Note: The return rate is determined by a hardware setting that only anMTS Field Service
representative can access. If the rate requires adjustment, contact MTS.

Post-Test Run Section
Assigning Post-Test Run Inputs

Access
Define tab > Test flow > Post-test run > Inputs
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Post-test run Inputs are parameters you want the operator to enter or verify at the end of each test run.
Typical post-test run Inputs are commentary about specimen condition, and reason or type of failure
(for instance, specimen, adhesive, or basematerial).

To assign post-test run inputs:

1. Click to show the Add Post-Test Run Inputs window.

2. Use the arrow keys tomove the desired inputs in theAvailable list to theSelected list. The
inputs shown pertain to the test, not individual test runs.

3. Use the controls in the various tabs to define the input.

The default values of the post-test run inputs you select are shown to the operator after each test run in
an Input Variableswindow. This allows the operator to verify or change the input values as required.

Example: Suppose you want the operator to enter the reason the test run ended from a predefined
list. You expect that in most cases, the reason the test run will end is because a limit is reached
rather than the specimen failing. To do this:

1. Click and use the arrows tomove theTest Run End Reason input from theAvailable
list to theSelected list.

2. ClickTest Run End Reason in theAvailable List.
3. On theGeneral tab, change theDefault selection fromBreak Detected to Limit

Detected.

After each test run, the Input Variableswindow appears containing the Test Run End Reason
prompt, with a default value of Limit Detected. Based on the circumstances, the operator may also
choose Test Stopped, Procedure Finished,Break Detected,Hardware Status Changed, or
Digital Input State Changed.

For information aboutPost-test run details, see “Input Property Details” on page 131.

Adding Post-Test Run Calculations

Access
Define tab > Test flow > Post-test run > Calculations

Post-test run calculations are calculations that apply to test run variables.

To add a post-test calculation:

1. Click to show the Add Post-Test Calculationswindow.

2. Use the arrow keys tomove the variable for which you wish to build a calculation from the
Available list to theSelected list.

3. Click on a variable in theSelected list to display its properties.
4. Click theCalculation icon to show the Calculation Editor window.
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5. Build the desired calculation from the available variables, signals, and functions on the
associated tabs. For information about the Calculation Editor, see “Calculation Editor
Overview” on page 165

6. ClickOK.

Generating Post-Test Run Reports

Access
Define tab > Test flow > Post-test run > Report

Use this feature to automatically generate a report after each individual test run is finished.

Control Description

Run report Select to run the report after the test run or test.

Name Selects a report template to use for the report. If desired, you can explicitly
override the default template set in theReport Templates tab.

Parentheses indicate theDefault Test Report template orDefault Test Run
Report template.

Note: If you do not select a report template, a warning is shown in the
Error list.

Open report Select to open the report after performing the test run or test.

Report Property Details
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Control Description

Print report Select to print the report after performing the test run or test.

Send report to e-
mail

Allows you to send a copy of the report to one or more e-mail addresses.
Separatemultiple addresseswith semi-colons.

The e-mail is sent right after the report is generated and added to the e-mail as
an attachment.

This feature requires valid syntax for To e-mail and From e-mail addresses.
syntax. Selecting the Send report to e-mail check box expands the panel and
enables the corresponding controls:

To: (Required) Sends an e-mail message to the specified e-mail address or
variable.

Cc: Required) Sends an e-mail message to the specified e-mail address or
variable.

From: Shows the default address fromwhich the e-mail is sent or a variable.
The default From address is configured in Preferences > Configuration > E-
Mail.

Subject: Populates the Subject line of the e-mail. The default is “MTS
TestSuite report”.

Message: Shows themessage in the body of the e-mail. You can use the
default variables, insert custom or other variables, or enter text directly in the
Message text box.

The Insert Variable button opens the Variable Selection window. Selected
variables appear in theMessage box.

About the Report Layout
The report layout is based on the selected report template, which you select in theReport Template
node. By default, the report format is aMicrosoft Excel file. You can also select other report format
options, such as PDF. For more information, see “Working with Report Templates” on page 155.

Sending a Report to an E-Mail Address
You can choose to send the report to one or more e-mail addresses.To send the report attached to an
e-mail, youmust configure the e-mail server settings. ClickPreferencesmenu > Configuration
option > E-Mail tab. If you are unsure of your mail server settings, contact your network administrator.
For more information, see “E-Mail Settings” on page 73

Exporting Post-Test Run Data

Access
Define tab > Test flow > Post-test run > Data export

Youmay export data from individual test runs (Post-Test Run) to an external file or a database.
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Important: Ensure the external source of inputs is compatible with theMTS TWS format. For
information about usingMTS TWS with an external file or database, contact MTS Service.

Exporting Data to a File

1. Select (to enable) Export data.
2. For Export data to, select File.

3. For Select data to export, click the button to show the Variables Selection window.

4. Select the variables with which you wish to export data.

5. Use the arrow keys tomove the selected variables from theAvailable list to theSelected list.
6. ClickOK to dismiss the Variables Selection window.

Note: You can select a variable when selecting theUnit Set and File Name in the next
step. To do this, click , and select the desired variable.

7. Select the desired unit set, specify or navigate to the desired export folder, and enter a file
name.

About Exporting Data to a Database
TheMTS TWS application can read test procedures from and write test data to a.Laboratory
InformationManagement System (LIMS).

The LIMS stores test procedure and test results data in a central database, accessible from a network
directory shared by both systems.

The primary objective of automatically transferring test data to a LIMS/database is to eliminate human
error and improve efficiency.

You can view and select test procedure files available in the LIMS withMTS TWS.When tests are
complete, you can export the test data back to the LIMS.

Exporting Data to a LIMS

1. Select (to enable) Export data, and then select Database as the source.
2. Select the data source to specify the file format:

l dBASE Files (file.dbf)

l Excel Files (file.xls)
l MS Access Database (multiple file extensions)

3. Add desired variables to theAssign results list using the button, and select the desired
Unit set.

4. Specifyquery type to specify query format.
5. Enter query.
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Example: Suppose you want to export test run data to anMS AccessDatabase using an SQL
query. To configureMTS TWS to export Post-Test Run data to this data source:

1. For data source, selectMS Access Database.
2. For query type, selectSQL.
3. Enter query: “INSERT INTOResults(Id,PeakLoadResult) VALUES(@Id,@PeakLoad)””,

where “INSERT INTO” and “VALUES” are SQL keywords.

In this example, the query inserts a new record into the table named “Results”.

The column names of the table are “Id” and “PeakLoadResult”. These columns in the new
record are filled-in from the data in the variables with the internal names of “Id” and
“PeakLoad”. The “@” in front of the variable namemeans that it takes the variable’s value.

The typical use of this export activity is to store test results back into the LIMS/database
under the Id read from the LIMS/database.

Post-Test Section
Assigning Post-Test Inputs

Access
Define tab > Test flow > Post-test > Inputs

Post-test inputs are parameters you want the operator to enter or verify at the end of the test, after all
test runs are finished.

To assign post-test inputs:

1. Click to display the Add Post-Test Inputs window.

2. Use the arrow keys tomove the desired inputs in theAvailable list to theSelected list.
3. Use the controls in the various tabs to define the input.

The default values of the post-test inputs you select are shown to the operator when the test is finished
in the Input Variables window. This allows the operator to verify or change the input values as required.

For information aboutPost-test details, see “Input Property Details” on page 131.

Adding Post-Test Calculations

Access
Define tab > Test flow > Post-test > Calculations

Enter a new or modify the default test description. The Post-Test Calculations are calculations that
pertain to global variables. Global variables are variables associated with the entire test, not individual
test runs.

To add a post-test calculation:
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1. Click to show the Add Post-Test Calculationswindow.

2. Use the arrow keys tomove the variable for which you wish to build a calculation from the
Available list to theSelected list.

3. Click on a variable in theSelected list to display its properties.
4. Click theCalculation icon to show the Calculation Editor window.

5. Build the desired calculation from the available variables, signals, and functions on the
associated tabs. For information about the Calculation Editor, see “Calculation Editor
Overview” on page 165

6. ClickOK.

Generating Post-Test Reports

Access
Define tab > Test flow > Post-test > Report

Use this feature to automatically generate a report when the test is finished. The report includes data
for all of the test runswithin the test.

Control Description

Run report Select to run the report after the test run or test.

Name Selects a report template to use for the report. If desired, you can explicitly
override the default template set in theReport Templates tab.

Parentheses indicate theDefault Test Report template orDefault Test Run
Report template.

Note: If you do not select a report template, a warning is shown in the
Error list.

Open report Select to open the report after performing the test run or test.

Report Property Details
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Control Description

Print report Select to print the report after performing the test run or test.

Send report to e-
mail

Allows you to send a copy of the report to one or more e-mail addresses.
Separatemultiple addresseswith semi-colons.

The e-mail is sent right after the report is generated and added to the e-mail as
an attachment.

This feature requires valid syntax for To e-mail and From e-mail addresses.
syntax. Selecting the Send report to e-mail check box expands the panel and
enables the corresponding controls:

To: (Required) Sends an e-mail message to the specified e-mail address or
variable.

Cc: Required) Sends an e-mail message to the specified e-mail address or
variable.

From: Shows the default address fromwhich the e-mail is sent or a variable.
The default From address is configured in Preferences > Configuration > E-
Mail.

Subject: Populates the Subject line of the e-mail. The default is “MTS
TestSuite report”.

Message: Shows themessage in the body of the e-mail. You can use the
default variables, insert custom or other variables, or enter text directly in the
Message text box.

The Insert Variable button opens the Variable Selection window. Selected
variables appear in theMessage box.

About the Report Layout
The report layout is based on the selected report template, which you select in the Report Template
node. By default, the report format is aMicrosoft Excel file. You can also select other report format
options, such as PDF. For more information, see “Working with Report Templates” on page 155.

Sending a Report to an E-Mail Address
You can choose to send the report to one or more e-mail addresses.To send the report attached to an
e-mail, youmust configure the e-mail server settings. ClickPreferencesmenu > Configuration
option > E-Mail tab. If you are unsure of your mail server settings, contact your network administrator.
For more information, see “E-Mail Settings” on page 73

Exporting Post-Test Data

Access
Define tab > Test flow > Post-test > Data export

Youmay export data from the entire test (Post-Test) to an external file or a database.
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Important: Ensure the external source of inputs is compatible with theMTS TWS format. For
information about usingMTS TWS with an external file or database, contact MTS Service.

Exporting Data to a File

1. Select (to enable) Export data.
2. For Export data to, select File.

3. For Select data to export, click the button to show the Variables Selection window.

4. Select the variables with which you wish to export data.

5. Use the arrow keys tomove the selected variables from theAvailable list to theSelected list.
6. ClickOK to dismiss the Variables Selection window.

Note: You can select a variable when selecting theUnit Set and File Name in the next
step. To do this, click , and select the desired variable.

7. Select the desired unit set, specify or navigate to the desired export folder, and enter a file
name.

About Exporting Data to a Database
TheMTS TWS application can read test procedures from and write test data to a.Laboratory
InformationManagement System (LIMS).

The LIMS stores test procedure and test results data in a central database, accessible from a network
directory shared by both systems.

The primary objective of automatically transferring test data to a LIMS/database is to eliminate human
error and improve efficiency.

You can view and select test procedure files available in the LIMS withMTS TWS.When tests are
complete, you can export the test data back to the LIMS.

Exporting Data to a LIMS

1. Select (to enable) Export data, and then select Database as the source.
2. Select the data source to specify the file format:

l dBASE Files (file.dbf)

l Excel Files (file.xls)
l MS Access Database (multiple file extensions)

3. Add desired variables to theAssign results list using the button, and select the desired
Unit set.

4. Specifyquery type to specify query format.
5. Enter query.
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Example: Suppose you want to export test data to anMS AccessDatabase using an SQL query.
To configureMTS TWS to export Post-Test data to this data source:

1. For data source, selectMS Access Database.
2. For query type, selectSQL.
3. Enter query: “INSERT INTOResults(Id,PeakLoadResult) VALUES(@Id,@PeakLoad)””,

where “INSERT INTO” and “VALUES” are SQL keywords.

In this example, the query inserts a new record into the table named “Results”.

The column names of the table are “Id” and “PeakLoadResult”. These columns in the new
record are filled-in from the data in the variables with the internal names of “Id” and
“PeakLoad”. The “@” in front of the variable namemeans that it takes the variable’s value.

The typical use of this export activity is to store test results back into the LIMS/database
under the Id read from the LIMS/database.

Configuring the Results Table
Access
Define tab > Review > Results Table

The results table on theReview tab allows you to compare one test run to another. The results table is
automatically shown to the operator when a test run is finished. The results table shows parameter
values for each test run in rows, and labels for each parameter in column headings.

Use the and buttons to edit the parameters shown on the results table.

Note: Some parameters include theEditable post-test attribute. If this is selected (checked),
the parameter appears in two locations on theReview tab. It appears in a non-editable form in
the results table, and in an editable form in the variables table. The variable table appears when
you select theReview tabmulti-panel view.

For information aboutResults details, see“Input Property Details” on page 131.

For information about the results table, see“Results Table” on page 291.

Working with Report Templates
Access
Define tab > Report templates

To set the default report template:

1. Locate the list in theReport Templates node that pertains to the part of the test for which
want to generate a report. For instance, if you want to generate a report for individual test
runs, locate the Test Runs list.



Defining a Test

156 MTS TestSuite™ TWEssential User Guide

2. Select the row that contains the report template that you want to make the default, or add new
report templates using theAdd button.

3. Click theMake Default button. TheDefault column showsYes.

To set the default report template properties:

Note: To create a report in the PDF format, select theMicrosoft Excel Workbook format
option and inMicrosoft Excel, use the Save AsPDF feature.

1. Select the desired format from the list in theReport Format column. The default format is
Microsoft Excel WorkbookYoumay also selectComma-Separated Values or Tab
Delimited Text.

2. Select the desired write options from the list in theWrite Options column. The default isNew.
Youmay also selectOverwrite orAppend to File.

3. Select the desired destination for the generated report in theReport Location column. You
may enter a file path directly or enter a variable that defines the file path.

Working with Resources
Define tab > Resources

TheResources node serves as amap between controller configuration resources and the test
definition. It allows you to resolvemapping errors between the controller and the test. It also allows you
to define tests away from the controller, that is, without a controller connection.When you define a test
this way, you canmap the resources to the controller when you connect to the controller.

For detailed information about theResources node, see “Resource Details” on page 83.
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Variable Basics
Variables Overview
A variable is a container that is used to store data values. A variable provides the ability to store and
manipulate data in applications. Variables can represent numeric values or text strings. TheMTS
TestSuite applications use variables in test activities, data acquisition activities, analyzer applications,
and reports.

Note: Variablesmay also be referred to as Inputs, Input Variables, orCalculations.

A simple variable can store a single text string, Boolean, or numeric value. An array variable stores a
series of text, numeric, or Boolean values. Various activities such as calculations, operator inputs, and
data acquisition can be used to set the value stored by the variable.

Variables defined in the test are stored with the test. The definition of a given variable, including its
name and type, remains constant throughout the test run, even though its valuemay change. Each test
run saves a “snapshot” of the test procedure and variable definitions at the time the test run is created.

Typical Uses for Variables
After you create a variable, you can use the variable in activities in the test procedure, test reports, and
calculations.

Note: MTS supplied templates include pre-configured data acquisition activities and variables
that save data for use in various charts and tables that appear in the test, report templates, and
post-test analysis.

Item Description

Test
Activities

Several test activity property settings can be entered as a static value or a variable. You
can configure variables for an operator to enter. Other settings are defined by variables
so that they can be changed during the test and in post-test analysis scenarios. Some
variables only represent one value in a given test.

Charts You can use variables to plot chart data in various places in both theReview and Test-
run chart > Chart nodes of the test definition tree.

Test
Reports

Most information that you want to include in a report must be saved in a variable:

l If you are creating your own tests and want to include test data in reports, you
must create data acquisition (DAQ) activities to collect the data.

l Reports can also include other single-variable values that are not associated
with data acquisition.

Data
Analysis

When the Availability property of variables used in calculations are configured as
Editable Post-Test, you can change these values in post-test analysis to correct
mistakes in operator setup or to create what-if scenarios.

Typical Uses for Variables
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Item Description

Data acquisition activities canmap signals to variables to store the test data that is
displayed in various post-test charts and tables.

Variable Types Overview
TheMTS TestSuite applications provide the ability to create the following types of variables:

l Numeric

l Text

l Calculated

The desired use of the variable dictates the variable type (or combination of types) defined in the
property settings for a variable. Other property settings define variable naming, default values, and so
on.

Some variables are fairly straightforward in their use, such as a numeric variable for an End Point level
defined by an operator at the beginning of a test run. Other variables aremore complex and use a
combination of variable types; for example, numeric variable values that are the result of a calculation.

Numeric Variables Overview
Numeric variables contain a single numeric value. To assign a numeric variable, select theNumber
option under the Type drop-down on thePre-test, Pre-test run, Post-test run, or Post-test node of
the test definition tree.

Numeric Variable Properties

Text Variables Overview
Text variables are used to hold text, such as a test run name, operator name, or Test ID. A text variable
can contain alphanumeric and space characters.
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To specify that a variable hold a string, select Text as the Type. In addition to using text variables to
store text values, you can also include text variables in calculations that use text functions to parse and
manipulate the text values.

Text Variable Properties

Array Variables Overview
An array variable is a variable that holds a list. An array is a collection of data values, and each data
value in an array has an associated index. Array indexes begin with zero. For example, an array with
an identifier of “a” and a size of ten integers contains the following elements:

a[0], a[1], a[2], a[3], a[4], a[5], a[6], a[7], a[8], a[9]

In the preceding example, a[4] refers to the fifth element of the array a.

An array variable in MTS TestSuite holdsmultiple values of the same data type. The available types of
array variables include:

l Array of Boolean

l Array of Numbers

l Array of Text

The elements of an array can be individually referenced or assigned; that is, each element of an array
is a variable of its own, and can bemodified independently of other elements in the array.

Note:While you can view any existing Array of Numbers variables that may exist in an existing
test or template, you cannot create new Array of Numbers variables.

Calculated Variables Overview
Most variable types allow you to define calculations that determine the value of the variable. The
calculation can include operations, functions, and references to other variables. The result of the
calculationmust generate the same type of data that is stored in the variable.



Working with Variables

MTS TestSuite™ TWEssential User Guide 161

Example
For example, you want to create several calculations that include velocity, which itself is a calculation.
You can create a calculation that is used to populate the value of a variable, label it “velocity”, define its
equation, and use it wherever an equation requires a value for velocity.

In the figure below, a Test Name variable uses the calculation TestName=TestDate+TestID:

Calculated Variable Properties

Viewing Variable Properties
To view the properties of a variable:

1. Select the Test Definition tab.

2. In the test definition tree, expand the Test flow node.

3. On either thePre-test, Pre-test run, Post-test run, andPost-test nodes of the test
definition tree, you can view the available Inputs (variables) and Calculations available for the
respective section of the test.

Note: Only global (common) variables can be viewed in thePre-test andPost-test
nodes.

Choice Lists Overview

Access
Properties panel > Choice List panel

You can set multiple values for a variable or text input in a choice list and use them inmany activities.
When you create a variable or text input with a choice list, youmust assign a default value from your list
of values. Choice list values are alphanumeric character strings.
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Example 1
Use choice lists in If-Else conditions andWhile loops. For example, in an If-Else activity, the condition
checks for the value of the variable to be equal to one of the choice list values. If that valuematches, the
test procedure follows the “if” path.

Example 2
You can create a wave shape variable with values of triangle, sine, and square as its values as another
example.

Global choice lists
Use a global choice list if you want to assign the same choice list to multiple variables throughout a test.
This keeps consistency and predictability in your test. A global choice list is defined from the Tools
menu.

Local choice lists
Use a local choice list if you are using one instance of the variable that only contains those values. A
local choice list has no name and is assigned only to one variable. A local choice list is defined directly
in the properties panel of a text variable.

Considerations when deleting choice lists
If you delete a variable that uses a global choice list, only the variable is deleted. The global choice list
remains and is available for use with other variables. If you delete a variable or text input that uses a
local choice list, you also delete the choice list.

Defining a Global Choice List
Prerequisite: Before you can access the Define Global Choice List option, youmust open or create a
New Test.

After you create a global choice list, it is available in theUse Choice List property of any text variable.

1. From the Toolsmenu, choose theDefine Global Choice List option. The Define Global
Choice List window opens.

2. ClickAdd in the top row of buttons to define a new choice list. A new choice list shows under
Display Namewith a default name of “Choice List n”.

3. Enter a name for the choice list. You can use spaces in the name for readability.

4. ClickAdd in the Choice List Items panel. The New Choice List Entry window opens.

A. Enter a name for the choice list entry in the Identifier field. Do not enter spaces or
periods in the name, or start with a number.

B. Enter a display name in theDisplay Name field.
C. ClickOK. To addmore values to your variable choice list, repeat these steps.

5. When you are done adding choice list items, clickOK.

Editing a Global Choice List
You can edit the name of a global choice list, or edit the itemswithin a global choice list.
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1. From the Toolsmenu, choose theDefine Global Choice List option. The Define Global
Choice List window opens.

2. Click a display name or a choice list item to select it.

3. ClickEdit. If you are editing a choice list item, the Edit Choice List Entry window opens. In this
window you can edit the identifier and display name.

4. ClickOK.

Removing a Global Choice List
To remove a global choice list:

1. From the Toolsmenu, choose theDefine Global Choice List option. The Define Global
Choice List window opens.

2. Select the choice list to remove and clickRemove.
3. ClickOK.

Define Global Choice List Window

Access
Toolsmenu > Define Global Choice List

Define Global Choice List Window



Working with Variables

164 MTS TestSuite™ TWEssential User Guide

Item Description

Display
Name

Displays the Name of the global choice list. You can select the name and click Edit or
Remove. Click the up or down arrow in the Display Name heading row to sort the
available lists alphabetically.

Add Adds a global choice list.

Edit Edits the selected global choice list.

Remove Removes the selected global choice list.

Choice List Items

Add Adds a choice list entry to the selected global list.

Edit Opens the Edit Choice List Entry window to change the identifier or display name for the
list entry.

Remove Removes the selected list entry from the selected global list.

Define Global Choice List Window

Adding a Local Choice List
Follow these steps to add a local choice list to a text variable. Unlike a global choice list, a local choice
list is not available to other text variables in a test.

1. Navigate to the Test Definition tab > Variables tab.
2. Click the text variable to which you want to define a local choice list.

3. In the Choice List panel, select theUse Choice List checkbox.
A. ClickAdd. The New Choice List Entry window opens.

B. Enter a name for the choice list entry in the Identifier field. Do not enter spaces or
periods in the name, or start with a number.

C. Enter a display name in theDisplay Name field.
D. ClickOK. To addmore values to your variable choice list, repeat these steps.

4. (Required) In theDefault Value list, select the default value from your list.
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Advanced Variable Information
Variables Calculations

Calculation Editor Overview

Access
Use the Calculation Editor to customize calculations for variables. To access the Calculation Editor,
select either thePre-test, Pre-test run, Post-test run, or Post-test nodes of the definition tree in the
Define tab. Then, click the button next to theCalculation field to open the Calculation Editor and
create a new calculation.

Calculation panel
Use the Calculation panel of the Calculation Editor to build a variable calculation. You can edit text
directly in the panel, or you can use the Variables and Functions panels to insert defined variable and
functions. Note the following on the Calculation panel:

l Variables can use reference signals, other variables, and calculation parameters.

l Names are not case-sensitive.

l Variables and signal labels have identifiers and display names. Use the identifier namewhen
creating a calculation that uses the signal.

When you are satisfied with the calculation, clickOK to add the calculation to the variable selected in
the Variables Editor window.

Note: If adjacent variable names are not separated by a space or function in the Calculation
panel, they are interpreted as a single variable name. This is likely to result in a “...variable...,
was not found” error message.

Errors panel
The Errors panel of the Calculation Editor continually evaluates the calculation as you build it.

Note: Calculations are validated only on syntax and references to variables and functions, not
expected results.

Variables panel
The Variables panel of the Calculation Editor lists all variables defined for the project. Double-click a
variable to add the variable to the calculation. To sort the variables, click a column heading.

Signals/Channels panel
The Signals/Channels panel of the Calculation Editor lists all the signals and channels defined in the
project. Double-click a signal or channel to add the signal or channel to the calculation. The signal or
channel that you added appears at the location of your cursor in the Calculation panel .

To sort the signals or channels, click a column heading.
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Functions panel
The Functions panel of the Calculation Editor contains a list of defined program functions and
operators. Double-click a function to add the function to the calculation.

Click themodify choice lists icon to select specific categories of functions. To sort the functions, click a
column heading.

Square brackets [  ] indicate you can add an optional parameter. Remove the square brackets
regardless if you add an optional parameter. A calculation error occurs if they are not removed.

Parentheses (  ) in the syntaxmeans that youmust add a parameter.

For example, the function below requires two variable parameters that contain the stress and strain
data. The start and end indexes for loading and unloadingmodulus calculations are optional because
they are in square brackets.

CycleModulus(Stress,Strain[, startIndexLoading,endIndexLoading, startIndexUnloading,
endIndexUnloading])

Note: The variable parameters between the parentheses are not the identities of the variables.
They indicate the type of variable that must be placed in the syntax.

Operators and Precedence
The following table shows all the recognized operators organized by group and listed in order of
precedence.Within a group, all operators have the same precedence.

Note: Some programming languages use a semicolon as a list separator instead of a comma. If
you are using one of those languages, the last operator of the table would be replaced with a
semicolon.

Precedence Operator Function Direction

1 [ ] Array Index Left-to-Right

( ) Function Call

. Variable-Specific Information

2 ! Logical NOT Right-to-Left

+ Unary Plus Left-to-Right

- UnaryMinus

~ OnesComplement

3 * Multiply Left-to-Right

/ Divide

% Modulus

Operator Precedence
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Precedence Operator Function Direction

4 + Addition Left-to-Right

– Subtraction

5 << Bitwise Shift Left Left-to-Right

>> Bitwise Shift Right

6 < Less Than Left-to-Right

> Greater Than

<= Less than or Equal

>= Greater Than or Equal

7 == Equal to Left-to-Right

!= Logical Not

8 & Bitwise AND Left-to-Right

9 ^ Bitwise XOR Left-to-Right

10 | Bitwise OR Left-to-Right

11 && Logical AND Left-to-Right

12 || Logical OR Left-to-Right

13 = Assignment Right-to-Left

14 , Comma - List Separator Left-to-Right

Variable-Specific Information
You can reference variables with delimited notation. A dot separates the variable name from the
specifier: <variable_name>.<specifier>

For example, the display name of a variable named PeakLoad is <PeakLoad>.<display name>

Item Description

Display Name Shows the display name of the variable.

Identifier Shows the internal name of the variable.

Units Shows the units of the variable.

Size Shows the array size of the variable. If the variable is not an array, the value is 1.

Specifier Properties
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Functions in Variable Calculations

Functions and Arguments in a Calculation
TheCalculation Editor contains functions that can be inserted into the Calculation panel from the
Functions panel. When an insertion occurs, the function is represented by an identifier followed
immediately by a parenthetical representation of the expected argument or arguments. If multiple
arguments are required, their representatives are separated within the parenthesis using delimiters,
such as commas or semicolons, depending on the local language. The representative arguments are
placeholders for an expected type of data.

Argument types
The types of arguments that can be passed to a function are:

l Number

l String

l Array

l Signal or test input

In all cases, the argument type that is shown in the Calculation window must be replaced by a
meaningful value. Themeaningful value can be an actual value, a variable that contains a value that is
of the correct type for the argument, or another function that produces a result that is of the correct type
for the argument.

For example, if the function cos(number) is added to the Calculation panel, themessage, “The
variable, number, was not found” is shown in the Error panel. The argument “number” must be
replaced with a value, a variable of the correct type, or a function that evaluates to the correct type. In
this case the number 30, the variable CycleCount, or the function cos(sin(30)) validates the calculation.
The Error panel message reads, “Equation is OK” when one of these replacements is used.

Argument syntax
When replacing a representative number or string argument type with an actual number value or a
string value, youmust use the correct syntax for the value.

l A string valuemust be enclosed between double-quotationmarks. For example: the function
ToLower(string), can be replaced by ToLower(“This is a short sentence.”), but not by
ToLower(This is a short sentence.).

l A numeric value is typed without quotationmarks. For example: the function cos(number) can
be replaced by cos(30), but not by cos(“30”).

Arguments can also be replaced with variables of the correct type.

Unique functions
There are unique functions available in the Calculation Editor that do not accept arguments.

l The function e() represents the natural logarithmic base, e.

l The function Pi() represents themathematical constant, pi.

l The function SystemRate() represents the system data rate.
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Understanding Functions Used in Calculations
Each argument shown in the Calculation window must be replaced by ameaningful value. The
meaningful value can be an actual value, a variable that contains a value that is of the correct type for
the argument, or another function that produces a result that is of the correct type for the argument.

To help understand the arguments in a pre-existing variable whose function is already configured with
variables, put the cursor at the end of the expression and pressReturn. Then, use the Functions tab to
reinsert the function. When you do this, the same function will be added to the calculation window.
However, instead of displaying the actual values or the variable values the calculation is using, you can
see the base arguments that the function expects to receive. By doing this, you can better understand
which values are being fed into any specific function that is used in a calculation.

In the example below, the Channel Value function was reinserted at the bottom to provide descriptions
of the arguments. Thismakes it apparent that the function searches the StrainArray (searchChannel)
for the value of StrainPoint01 (search value) and returns the stress value (resultChannel) at a strain
value = StrainPoint01.

Expanded ArrayValue Function

Modulus Calculation Functions
Modulus is calculated from the slope of the Least Squares Fit calculation of the Stress and Strain
arrays between the starting and ending indexes.

LeastSquaresFit
LeastSquaresFit(StressArray, StrainArray, Slope1, Slope2

The slope of the least squares fit of the array that contains Y-axis data and X-axis data between the
start and end indexes. This is typically used when calculatingmodulus in TestSuite TW applications.

Loading Modulus
LoadingModulus(Stress, Strain[, startIndex, endIndex])

The loadingmodulus is themodulus of the portion of the curve where the load on the specimen
increases. This function calculates the loadingmodulus using the Stress and Strain arrays between
the startIndex and endIndex.

If the startIndex is set to -1, the optimum start index is the valley offset by 5 points. If variables represent
this field in the function and the original value is -1, the variable contains the calculated index at the
completion of the function.

If the endIndex is set to -1, you can calculate the optimum endpoint:
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1. Locate a nominal end index at 25% of the stress range and within the linear modulus range.

2. Calculate a nominal modulus at the nominal end index.

3. Expand the nominal end index away from the start index until the new modulus value differs
from the nominal modulus bymore than 2%.

4. The endIndex is set before the newly calculatedmodulus exceeds the nominal modulus.

If variables represent this field in the function and the original value is -1, the variable contains the
calculated index at the completion of the function.

UnLoading Modulus
UnLoadingModulus(Stress, Strain[, startIndex, endIndex])

The unloadingmodulus is themodulus of the portion of the curve where the load on the specimen
decreases. This function calculates the unloadingmodulus using the Stress and Strain arrays between
the startIndex and endIndex.

If the startIndex is set to -1, the optimum starting index is the peak offset by 5 points. If variables
represent this field in the function and the original value is -1, the variable contains the calculated index
at completion of the function.

If the endIndex is set to -1, you can calculate the optimum endpoint:

1. Locate a nominal end index at 25% of the stress range and within the linear modulus range.

2. Calculate a nominal modulus at the nominal end index.

3. Expand the nominal end index away from the start index until the new modulus value differs
from the nominal modulus bymore than 2%.

4. The endIndex is set before the newly calculatedmodulus exceeds the nominal modulus.

If variables represent this field in the function and the original value is -1, the variable contains the
calculated index at the completion of the function.

Cycle Modulus
CycleModulus(Stress, Strain[, startIndexLoading, endIndexLoading, startIndexUnloading,
endIndexUnloading])

CycleModulus returns the average of LoadingModulus and UnloadingModulus.

First Cycle Modulus
FirstCycleModulus(Stress, Strain[, startIndex, endIndex])

The FirstCycleModulus function returns themodulus of the data in the region prior to the first peak or
valley because the first cycle is typically a partial cycle. Themodulus is either a loading or unloading
modulus, based on an increase or decrease in the specimen load during the first cycle.

Fatigue Life Calculation Function

Fatigue Life
FatigueLife(YAxis, XAxis, startIndex, endIndex, percentageDrop)
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The FatigueLife function returns the index of the point where thematerial under test fails. The failure
point is after endIndexwhere the Y-Axis value falls below (percentageDrop) the Least Squares Fit line
of X-Axis and Y-Axis data between startIndex and endIndex. This function provides the drop line for
the Failure Cycle Chart.

Calculated Variable Functions
Calculation Editor

Access

1. Select the Define tab.

2. Depending on the section of the test in which you want to edit a calculation, select either the
Pre-test, Pre-test run, Post-test run, or Post-test nodes of the test definition tree.

3. Select theCalculations node.
4. Select a calculation from the list.

5. Click next to theCalculation field.

Calculation Editor Window
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Number Item Description

1 Calculation
panel

Use the Calculation panel to build a variable calculation. You can edit
text directly in the panel, or you can use the Variables and Functions
panels to insert defined variable and functions. Note the following on
the Calculation panel:

l Variables can use reference signals, other variables, and
calculation parameters.

l Names are not case-sensitive.

l Variables and signal labels have identifiers and display
names. Use the identifier namewhen creating a calculation
that uses a signal.

Note:
If adjacent variable names are not separated by a space
or function in the Calculation panel, they are interpreted
as a single variable name. This is likely to result in a
“...variable..., was not found” error message.

2 Errors panel The Errors panel continually evaluates the calculation as you build it.

Note:
Calculations are validated only on syntax and references to
variables and functions, not expected results.

3 Variables tab The Variables panel lists all variables defined for the project. Double-
click a variable or click a variable and click Insert to add the variable to
the calculation. The cursor location in the Calculation panel shows the
added variable.

To sort the displayed variables, click a column heading to sort the
variables by the values in that column. Click the same column heading
again to reverse the sort order.

Parts of the Calculation Editor Window
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Number Item Description

4 Signal/Channels
tab

Opens theSignals/Channels tab.

5 Function tab Opens the Functions panel.

6 Functions panel The Functions panel contains a list of defined program functions and
operators. Double-click a function or click a function and then click
Insert to add the function to the calculation.

Click the Functions list to select specific categories of functions.

To sort the displayed functions, click a column heading to sort the
functions by the values in that column. Click the same column heading
again to reverse the sort order.

Square brackets [  ] indicate you can add an optional parameter.
Remove the square brackets regardless if you add an optional
parameter. A calculation error occurs if they are not removed.

Parentheses (  ) in the syntaxmeans that youmust add a parameter.

For example, the following function requires two variable parameters
that contain the stress and strain data. The start and end indexes for
loading and unloadingmodulus calculations are optional because they
are in square brackets:

CycleModulus(Stress,Strain[,
startIndexLoading,endIndexLoading, startIndexUnloading,
endIndexUnloading])

Note:
The variable parameters between the parentheses are not the
identities of the variables. They indicate the type of variable that
must be placed in the syntax.

Calculation Unit Conversion Issues

Important: To avoid unit-conversion issues, create a variable to hold any constant value (that
has a dimension and units associated with it) used in a calculation. You can assign any units that
you want to the variable and the application converts them to the base units when the calculation
is performed.

Base units
AlthoughMTS TestSuite applications allow the user to specify variable units, all calculations convert
variable values and constants to a constant set of base units. This can be problematic if you add a
constant to an equation and assume that it will use the same user-assigned units as the other variables
in the calculation.
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Note:When using the Calculation Editor, you canmove themouse over any variable in the
calculation to display a tool tip that specifies the base units used when that calculation is
performed.

Example
For example, the following calculation would yield incorrect results because the test designer has
entered a constant that they assumedwouldmatch the user-assigned units.

y = x +(1)

where: the variable (x) has user-assigned units of feet and the constant (1) is assumed to also have the
same units of feet.

If the value of x=3 feet the assumption is that:

y = 3 ft. + 1 ft. = 4 ft. where: y is a variable with a dimension = “length” and units = feet

But, because the constant (1) is converted to the application’s base units for length (meters in this
example), the equation returns the following:

y = 0.9144 + 1 = 1.9144 so that: the displayed value of y = 6.281 ft. (not 4 ft.)

Notation for Referencing Variables
You can reference variables with delimited notation. A dot separates the variable name from the
specifier:

<variable_name>.<specifier>

For example, the display name of a variable named PeakLoad is:

<PeakLoad>.<display name>

Item Description

Display Name Shows the display name of the variable.

Identifier Shows the internal name of the variable.

Units Shows the units of the variable.

Size Shows the array size of the variable. If the variable is not an array, the value is 1.

Specifier Properties

Adding Pre-Test Calculations

Access
Define tab > Test flow > Pre-test > Calculations

Pre-test calculations are calculations that pertain to Common (global) variables. Common variables
are variables associated with the entire test, not individual test runs.
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A common use for pre-test calculations is concatenating strings to name the file, the test, and the test
run.
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Example: Suppose you want the Test Name variable, which is used as the file name and shown in
test reports, to be a concatenation of the lot number and the test date. To do this:

1. Create a new test.

Click theNew Test from Template button. Select the Simplified Tension test.
2. Add two variables to accept lot number and test date data.

A. In the Explorer window, selectVariables.
B. On the Variables tab, click the + sign to add a variable.
C. In the New Variable window, enter LotNumber. ClickOK.
D. In the Properties window:

a. ChangeDisplay Name toEnter lot number.
b. Change Type to Text.

E. In theVariables tab, click the + sign to add a variable.
F. In the New Variable window, enter TestDate. ClickOK.
G. In the Properties window:

a. Change Display Name toEnter test date.
b. Change Type to Text.

3. Make theName of the Test variable calculated.
A. In the Explorer window, clickVariables.
B. On theVariables tab, clickName of the Test.
C. In the Properties window, click to select Is Calculated.
D. Click the ellipsis (...) in theCalculation tab.
E. In the Calculation Editor, selectEnter lot number from the list, enter +"_"+, and

then selectEnter date from the list. The resulting calculation is LotNumber+"_
"+TestDate. ClickOK.

F. In the Properties window Availability tab, click to selectDuring-Test andResult.
4. Enable the Input Variables andCalculate Variables activities in the Procedure Flow and

add the appropriate variables to them.

A. Navigate to the Procedure Table by selecting theDefine andProcedure tabs.
B. Click the Input Variables icon in theSet Up group of the Procedure Flow.
C. In the Properties window, clickEnable.
D. On theVariable List tab, click + to add a variable.
E. In the Variables Selection window, moveEnter lot number andEnter test date

fromAvailable toSelected. ClickOK.
F. Click theCalculate Variables activity in the Set Up group of the Procedure Flow.
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G. In the Properties window, clickEnable.
H. On theVariable List tab, click + to add a variable.
I. In the Variables Selection window, moveName of the Test fromAvailable to

Selected. ClickOK.
5. Run the test. Notice that the file name changes and that the concatenated Test Name

shows up in theReview tab.

Important: The calculation for this example will occur only the first time you run the
program. This is because the Input Variables andCalculation Variables activities
are in the Set UpGroup. To perform calculations for each test run, use the Run
group for the activities instead.

Tip: The input variables used tomake up the test name could be selected from choice lists.

Calculation Functions Overview
The functions available in the Calculation Editor are tools for calculating the value of a variable. The
functions support computations using arithmetic, logic, and project variables.

If a function hasmandatory parameters, a corresponding value for the parametersmust be supplied.
The value of a parameter is referred to as an argument. The number of parameters of a function, along
with the parameter names form the signature of a function. The function signature describes the
parameters and parameter typeswith which tomake a legal call (that is, properly use) to the function.
The signature contains the name of the function, its parameters and their type, and the return value.

Functions can operate directly on an operand are referred to as operators. Functionsmay require one
or more arguments be passed to them, or may not accept arguments.

Operators
When an operator is added to a calculation, it acts directly on the operands to its left and right by
assigning a value, performing a comparison, or performing amathematical calculation.

However, some operators like the Not (!), OnesComplement (~), and Subtraction when used as a
Negate (-), operate on only one argument to the right.

Functions requiring arguments
In general syntax, functions that require arguments are written as a function name followed
immediately by the required arguments enclosed in parenthesis. For example:

cos(number)

where “cos” is the function identifier and “(number)” is the required argument.
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Functions with no arguments
There are unique functions available in the Calculation Editor that do not accept arguments:

l Function e() represents the natural logarithmic base, e.

l Function Pi() represents themathematical constant, pi.

l Function SystemRate() represents the system data rate.

Inserting Functions with the Calculation Editor
TheCalculation Editor contains functions that you can insert into the Calculation panel from the
Functions panel. When you insert a function, the function is represented by an identifier followed
immediately by a parenthetical representation of the expected argument or arguments. If multiple
arguments are required, their representatives are separated within the parenthesis using delimiters,
such as commas or semicolons, depending on the local language. The representative arguments are
placeholders for an expected type of data.

Argument types
The types of arguments that can be passed to a function are:

l Number

l String

l Array

l Signal or test input

In all cases, the argument type that is shown in the Calculation window must be replaced by a
meaningful value. Themeaningful value can be an actual value, a variable that contains a value that is
of the correct type for the argument, or another function that produces a result that is of the correct type
for the argument.

For example, if the function cos(number) is added to the Calculation panel, themessage, “The
variable, number, was not found” is shown in the Error panel. The argument “number” must be
replaced with a value, a variable of the correct type, or a function that evaluates to the correct type. In
this case, the number 30, the variable CycleCount, or the function cos(sin(30)) validates the
calculation. The Error panel message reads, “Equation is OK” when one of these replacements is
used.

Argument syntax
When replacing a representative number or string argument type with an actual number value or a
string value, youmust use the correct syntax for the value.

l A string valuemust be enclosed between double-quotes. For example: the function ToLower
(string), can be replaced by ToLower(“This is a short sentence.”), but not by ToLower(This is a
short sentence.).

l A numeric value is typed without quotes. For example: the function cos(number) can be
replaced by cos(30), but not by cos(“30”).

Arguments can also be replaced with variables of the correct type.
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Function Categories Overview
MTS TestSuite functions available in the Calculation Editor are organized into the following categories:

l Array

l Controller

l Cyclic

l Date and Time

l Directory

l Fatigue and Fracture

l Geometry

l Index

l Math

l Operators

l Peel-Tear

l Sensor (applicable to TEDS Devices in TWE only)

l String

l Test Definition (custom user-defined functions)

Themost commonly used functions are described in this reference.

Array Functions
This section provides reference information for functions used on arrays.

Compliance
TheCompliance function is used tominimize the effects of frame deflections under high force.

Returns
The amount of the extension that needs to be compensated.

Syntax
Compliance(ForceArray, ComplianceCoefficients)

Parameters
ForceArray - The force array data.

ComplianceCoefficients - The coefficient array generated during the compliance Test Run.

Unit Class
Extension

Example
ExtensionArray - Compliance(ForceArray, ComplianceCoefficients)
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CurveFitValue

Returns
The requested coefficient.

Syntax
CurveFitValue(Order, Coefficient, yArray, aArray, StartIndex, EndIndex)

Parameters
Order—The order of the polynomial fit to calculate using the yArray and xArray data.

Coefficient—The coefficient to return.

yArray—The Y array data.

xArray—The X array data.

StartIndex—The optional start index of the arrays.

EndIndex—The optional end index of the arrays.

Unit Class
Dependent upon equation order, coefficient number, and channels specified.

Example
CurveFitValue(2, 0, yArray, aArray, StartIndex, EndIndex)

This example returns the zero coefficient from the second order polynomial fit on the X and Y arrays
between the indexes specified by StartIndex and EndIndex.

Polynomial
The Polynomial function returns the Y value based on an X value and the coefficients generated with
the PolynomialFit function.

Returns
The Y value associated with the X value.

Syntax
Polynomial(X,Coefficients)

Unit Class
The units associated with the Y data used to calculated the coefficients.

Example
Polynomial(X, coefficients)

This example returns the Y value calculated at the value X.

PolynomialFit
The PolynomialFit function fits a polynomial curve of the specified order to the data arrays.
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Returns
The coefficients as an array. The number of array values returned is one plus the order specified.

Syntax
PolynomialFit(yArray, xArray, Order[, StartIndex, EndIndex, rSquared])

Parameters
yArray—The Y array data being analyzed.

xArray—The X array data being analyzed.

Order—The order of the polynomial fit.

StartIndex—The optional start index of the region to be analyzed.

EndIndex—The optional end index of the region to be analyzed.

rSquared—An optional variable that is used to pass the coefficient of determination (R2)

Unit Class
Dependent on the coefficient.

Example
PolynomialFit(Force, Extension, 1, Slope1, Slope2)

This example returns the coefficients for a straight line through the regions specified by Slope1 and
Slope2.

Controller Functions
This section provides reference information for controller functions.

Note:
The TimePattern depends upon your Windows settings in the Format tab for regional areas.

GetTransitionTime

Returns
Returns the time from the specified channel and transition time type.

Syntax
GetTransitionTime([ timePattern])

Parameters
timePattern

SetTransitionTime

Returns
Sets the time from the specified channel and transition time type.
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Syntax
SetTransitionTime([ timePattern])

Parameters
timePattern

Signal

Returns
Current value from a signal.

Syntax
Signal(SignalName)

Parameters
SignalName

SignalFullScale

Returns
Full scale value from a signal.

Syntax
SignalFullScale(SignalName[, MinimumOrMaximumOption)

Parameters
SignalName

MinimumOrMaximumOption—One of the optional arguments: Minimum; minimum; Maximum;
maximum; Upper; upper; Lower; or lower

SystemRate

Returns
Themaximumdata rate for the controller.

Syntax
SystemRate()

Trace

Returns
Gets the percentage complete of the current segment for a channel.

Syntax
Trace(ChannelName)

Parameters
ChannelName
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Cyclic Functions
This section provides reference information for cyclic functions.

AnalysisRun

Returns
Accesses the variable across analysis runs.

Syntax
AnalysisRun[Index].variable

Block

Returns
Accesses data across blocks.

Syntax
Block[blockName, Index].variable

Parameters
blockName

Cycle

Returns
Accesses the variable in cycles.

Syntax
Cycle[Index].variable

TestRun

Returns
Accesses the variable across test runs.

Syntax
TestRun[Index].variable

Date and Time Functions
This section provides reference information for date and time functions.

The DatePattern and TimePattern depend upon your Windows settings in the Format tab for your
region.

TestCreationDate

Returns
Returns the creation date of the test.
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Syntax
TestCreationDate([ datePattern])

Parameters
datePattern—Formats the date according to the specified pattern. For example, “d” is a short date
pattern (MM/dd/yyyy); “D” is a long date pattern (dddd, MMMMdd, yyyy).

Detailed date and time pattern format specifier information is available from theMSDN resourcesWeb
site.

Examples
TestCreationDate([ “d”])

Returns a test creation date in a short date format, assuming a United States English culture:

4/15/2012

TestCreationDate([ “D”])

Returns a test creation date in a long date format, assuming a United States English culture:

Saturday, March 31, 2012

TestCreationTime

Returns
Returns the creation time of the test.

Syntax
TestCreationTime([ timePattern])

Parameters
timePattern—Formats the time according to the specified pattern. Set the time pattern to the exact
format desired. For example, to obtain the pattern h-mm-ss for hours-minutes-seconds, the function
should specify "hh-mm-ss".

Detailed date and time pattern format specifier information is available from theMSDN resourcesWeb
site.

Example
TestCreationTime([ “hh:mm:ss tt”])

Displays the time as 10:04:01 PM.

Unit Class
String

TestModificationDate

Note:
This function replaces the SampleModificationDate function from the TW4 application.
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Returns
Returns the last modification date of the test run.

Syntax
TestModificationDate([ datePattern])

Parameters
datePattern—Formats the date according to the specified pattern. For example, “d” is a short date
pattern (MM/dd/yyyy); “D” is a long date pattern (dddd, MMMMdd, yyyy).

Detailed date and time pattern format specifier information is available from theMSDN resourcesWeb
site.

Examples
TestModificationDate([ “d”])

Returns a test modification date in a short date format, assuming a United States English culture (us
en):

4/15/2012

TestModificationDate([ “D”])

Returns a test creation date in a long date format, assuming a United States English culture:

Saturday, March 31, 2012

Unit Class
Integer

TestModificationTime

Note:
This function replaces the SampleModificationTime function from the TW4 application.

Returns
Returns the last modification time of the test run.

Syntax
TestModificationTime([ timePattern])

Parameters
timePattern—Formats the time according to the specified pattern. Set the time pattern to the exact
format desired. For example, to obtain the pattern h-mm-ss for hours-minutes-seconds, the function
should specify "hh-mm-ss".

Detailed date and time pattern format specifier information is available from theMSDN resourcesWeb
site.

Example
TestModificationTime([ “hh:mm:ss tt”])
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Displays the time as 10:04:01 PM.

Unit Class
String

TestRunCreationDate

Note:
This function replaces the SampleCreationDate function from the TW4 application.

Returns
Returns the creation date of the test run.

Syntax
TestRunCreationDate([ datePattern])

Parameters
datePattern—Formats the date according to the specified pattern. For example, “d” is a short date
pattern (MM/dd/yyyy); “D” is a long date pattern (dddd, MMMMdd, yyyy).

Detailed date and time pattern format specifier information is available from theMSDN resourcesWeb
site.

Examples
TestRunCreationDate([ “d”])

Returns a test run creation date in a short date format, assuming a United States English culture (us
en):

4/15/2012

TestRunCreationDate([ “D”])

Returns a test run creation date in a long date format, assuming a United States English culture:

Saturday, March 31, 2012

Unit Class
String

TestRunCreationTime

Note:
This function replaces the SampleCreationTime function from the TW4 application.

Returns
Returns the creation time of the test run.

Syntax
TestRunCreationTime([ timePattern])
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Parameters
timePattern—Formats the time according to the specified pattern. Set the time pattern to the exact
format desired. For example, to obtain the pattern h-mm-ss for hours-minutes-seconds, the function
should specify "hh-mm-ss".

Detailed date and time pattern format specifier information is available from theMSDN resourcesWeb
site.

Example
TestRunCreationTime([ “hh:mm:ss tt”])

Displays the time as 10:04:01 PM.

Unit Class
String

Directory Functions
This section provides reference information for directory functions that return information about the
default project, test, test run, external files, and data export directories that are configured in
Preferences > Configuration > Project.

CurrentProjectDirectory

Returns
Returns the current project directory.

Syntax
CurrentProjectDirectory()

Unit Class
String

CurrentTestDirectory

Returns
Returns the current test directory.

Syntax
CurrentTestDirectory()

Unit Class
String

CurrentTestRunDirectory

Returns
Returns the current test run directory. The directory is set in Preferences > Configuration > Project.
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Syntax
CurrentTestRunDirectory()

Unit Class
String

DataExportDirectory

Returns
Returns the directory for exported data. The directory is set in Preferences > Configuration > Project.

Syntax
DataExportDirectory()

Unit Class
String

DefaultReportDirectory

Returns
Returns the default reports directory. The directory is set in Preferences > Configuration > Project.

Syntax
DefaultReportDirectory()

Unit Class
String

ExternalFilesDirectory

Returns
Returns the directory for external files. The directory is set in Preferences > Configuration > Project.

Syntax
ExternalFilesDirectory()

Unit Class
String

TestDirectory

Returns
Returns the directory for the test. The directory is set in Preferences > Configuration > Project.

Syntax
TestDirectory()

Unit Class
String
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Fatigue and Fracture Functions
This section provides reference information about the functions used for Fatigue and Fracture
applications.

CalcInelStrain
Calculated Inelastic Strain.

Returns
TheCalcInelStrain function returns the value:

Strain - Stress/Modulus

The calculation provides the value of the Strain minus the Stress divided by themodulus. If Strain and
Stress are arrays, the result is an array. If Strain and Stress are single numbers, the result is a single
number.

Syntax
CalcInelStrain(Stress, Strain, Modulus)

Parameters
Stress

Strain

Modulus

HysteresisArea

Returns
TheHysteresisArea function returns the area under the curve defined by the Stress and Strain array
data.

Syntax
HysteresisArea(StressArray, StrainArray)

Parameters
StressArray

StrainArray

MeasInelasticStrainMax
Measured Inelastic Strain Maximum. Themeasured inelastic strain range is specific to materials
fatigue testing, especially Low Cycle Fatigue (LCF). The application calculates themean stress from
the stress and strain data that represents one cycle. The two points where themean intersects the
curve determines the strain values. TheMeasInelStrainMax function returns themaximumof these
two strain values. TheMeasInelStrainMin function returns theminimumof these two strain values.

Returns
Returns themaximumof the two strain values as described above.
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Syntax
MeasInelStrainMax(stressVar, strainVar)

Parameters
stressVar

strainVar

MeasInelasticStrainMin
Measured Inelastic Strain Minimum. Themeasured inelastic strain range is specific to materials fatigue
testing, especially Low Cycle Fatigue (LCF). The application calculates themean stress from the
stress and strain data that represents one cycle. The two points where themean intersects the curve
determines the strain values. TheMeasInelStrainMax function returns themaximumof these two
strain values. TheMeasInelStrainMin function returns theminimumof these two strain values.

Syntax
MeasInelStrainMin(stressVar, strainVar)

Returns
TheMeasInelStrainMin function returns theminimumof the two strain values.

Parameters
stressVar

strainVar

StrainA
StrainA(StrainMax, StrainMin)

The StrainA function returns the value:

((StrainMax - StrainMin)/(StrainMax + StrainMin))

StrainR
StrainR(StrainMax, StrainMin)

The StrainR function returns the value:

StrainMin/StrainMax

StressA
StressA(StressMax, StressMin)

StressR
StressR(StressMax, StressMin)

The StressR function returns the value:

StressMin/StressMax
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Index Functions
This section contains reference information about index functions.

Understanding Index Functions
Index functions are used to find array index values. All array variables collected by a data acquisition
activity share the same index values. Once you create a variable that stores an index value, you can
use that variable in an Array Value function to return a value at that index. For example, to find the
strain value at peak load, you would use the following variable calculations:

PeakLoadStrainValue and Peak Calculations

Note:
The “Peak” variable stores the index value for peak load. The “PeakLoadStrainValue” variable
uses the ArrayValueAtIndex function to calculate and store the strain value at the peak-load
index.

Determining Analysis Region
The “min load”, “max load”, and “% strain point arguments” are used to determine the bounding
analysis region for the algorithm. On a successful completion of this function, the index point will be
contained within the bounds of the analysis region. The analysis region is used to focus on important
regions of data and skip anomalous regions.  If neither the starting or ending regions are located, all of
the data in the channels will be analyzed.

Starting Point of Region
To determine the starting point of the analysis region, the algorithmwill select the first point where the
“min load” value is located in the y-channel.  If the “min load” is not found, the algorithmwill attempt to
locate the point where “% strain point” is located in the x-channel.  If this point cannot be determined,
the first data point in the channel is used.

Ending Point of Region
To determine the ending point of the analysis region, the algorithmwill select the first point where the
“max load” value is located in the y-channel data. The search will either begin at the first data point or
the point where the “% strain point” was located in the x-channel.  If the “max load” is not located, the
end point of the region is assigned to the point associated with the peak value on the y-channel.  If all
else fails to locate the end point, the index of the last point of data in the channel is selected.

BreakIndexByDropFromPeak
The BreakIndexByDropFromPeak function is used to calculate the break point using a specified drop
from the peak in the array data.

Returns
This function returns the index point in the array where the break point was detected.
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Syntax
BreakIndexByDropFromPeak(channel, dropValue, [startIndex], [endIndex])

Parameters

Parameter Description

Channel The array data being analyzed for the break point.

DropValue The percentage drop from the peak that signifies a break occurred.

StartIndex The optional starting point in the array. The starting point in the array is used if this
parameter is not provided.

EndIndex The optional ending point in the array. The last point in the array is used if this
parameter is not provided.

BreakIndexByDropFromPeak Parameters

Unit Class
Integer

Example
A test contains the input BreakDrop that is equal to 80%.

BreakIndexByDropFromPeak(_Load, BreakDrop)

This formula:

1. Searches the _Load channel.

2. Looks for the _Load channel to drop 80% from its peak value. 80% is the value of the input
BreakDrop.

If PeakLoad = 100lbs, then the calculation returns the number of the data point when the load has
dropped to 20lbs.

If PeakLoad = 80lbs, then the calculation returns the number of the data point when the load has
dropped to 16lbs.

BreakIndexByDropPerExt
The BreakIndexByDropPerExt function is used to calculate the break point using a specified drop from
the peak in the array data that occurs over a predefined change in the extension data.

Returns
This function returns the index point in the array where the break point was detected.

Syntax
BreakIndexByDropPerExt(dropChannel, dropValue, extensionChannel, extensionValue,
[startIndex], [endIndex])
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Parameters

Parameter Description

DropChannel The array data being analyzed for the break point.

DropValue The percentage drop from the peak that signifies a break occurred.

ExtensionChannel The extension data being analyzed for the change in extension.

ExtensionValue The change in extension value required for the break to be determined.

StartIndex The optional starting point in the array. The starting point in the array is used if
this parameter is not provided.

EndIndex The optional ending point in the array. The last point in the array is used if this
parameter is not provided.

Chart Descriptions

Unit Class
Integer

Example
A test contains the input BreakDrop that is equal to 80% and the input. It also contains the input
BreakElongation that is equal to 0.1in.

BreakIndexByDropPerExt (_Load, BreakDrop, PrimaryExt,BreakElongation)

This formula:

1. Searches the _Load channel and the PrimaryExtension channel.

2. Looks for the _Load channel to drop 80% from its peak value, and for the PrimaryExt channel
to change by 0.1 in.

If PeakLoad = 100lbs, then the calculation returns the number of the data point when the load has
dropped to 20lbs and the PrimaryExt channel has changed by 0.1 in.

If PeakLoad = 80lbs, then the calculation returns the number of the data point when the load has
dropped to 16lbs and the PrimaryExt channel has changed by 0.1 in.

ArrayIndex
The ArrayIndex function is used to locate the index of the data in the array that is closest in value to the
value being searched.

Returns
This function returns the index point in the array of the closest value.

Syntax
ArrayIndex (searchArray, searchValue,[startIndex], [endIndex])
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Parameters
SearchArray—The array data being analyzed.

SearchValue—The value being search for in the array.

StartIndex—The optional starting point in the array. The starting point in the array is used if this
parameter is not provided.

EndIndex—The optional ending point in the array. The last point in the array is used if this parameter is
not provided.

Unit Class
Integer

Example
A test contains the input StrainPoint1 that is equal to 10%.

ArrayIndex (Strain, StrainPoint1)

This formula:

1. Searches the Strain channel.

2. Locates the data point whose value is closest to 10% strain.

If data point #100 has a strain value of 9.8% and data point #101 has a strain value of 10.1%, the
calculation returns the value #101 because this data point is closest to the desired value.

FractureIndex
The FractureIndex function finds the fracture index. A line is drawn at a percentage (the fracture
percent) of the slope of the X-Y curve.

Returns
The fracture index is where this line intersects the curve (Type I) or where it intersects a peak if it
comes before this point (Type II or Type III).
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Fracture Index Examples

Syntax
FractureIndex(fracture percent, slack value, Load Channel, Primary Extension channel,
slope 1 index, slope 2 index)

Parameters
Fracture percent—Determines the slope at which the fracture line is drawn. This slope is a percentage
of the slope of the X-Y curve.

Slack value—The offset used for calculating slack extension. If slack compensation is not used then
this argument should be zero (0).

Load channel—The channel used for the Y-axis of the curve. This should almost always be the Load
channel.

Primary Extension channel—(PrimaryExtension) The channel used for the X-axis of the curve. This
should almost always be the PrimaryExtension channel.

Unit Class
Integer

Example
The following formula will calculate the fracture index using a 95% fracture percent and assumes that
slack compensation is turned off.

FractureIndex(0.95, 0, _Load, PrimaryExt, Slope1, Slope2

LowerYieldIndex
This LowerYieldIndex function is used to calculate the first occurrence of a zero slope after the upper
yield point.
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1. The search for the Lower Yield Point begins after the upper yield index point.

2. The forcemust drop from the upper yield point by the listed tolerance before the lower yield
index can be identified.

3. From this point, the algorithm keeps track of theminimum load point, and stops searching
when the load value increases by the same amount as the drop from the upper yield index.

4. The Lower Yield index is reported as theminimum load point found during the search.

Returns
This function returns the index point in the array of the lower yield point.

Syntax
LowerYieldIndex(y-axis, tolerance, upperYieldIndex)

Parameters
y-axis—The force array data being analyzed for the zero slope.

Tolerance—The percentage drop in force from the upper yield index that must occur before a lower
yield index can be identified.

UpperYieldIndex—The index representing the location of the upper yield index.

Unit Class
Integer

MaxSlopeStartIndex
TheMaxSlopeStartIndex andMaxSlopeEndIndex functions are used to determine a region of data
where the slope of the line isminimized based on the function arguments. The slope of the line is
determined using a Least Squares Fit on the Y and X channel data.

Returns
TheMaxSlopeStartIndex function returns the last point of the region.  If a valid region cannot be
located given the function arguments, a –1 will be returned as the index.

Syntax
MaxSlopeStartIndex (y-channel, x-channel, % segment length, % tolerance, min load, max
load, %strain point)

Parameters
y-channel—This argument is the channel that represents the Y-axis for the Least Squares fit. The
units for this channel are normally in Force units but it is not a requirement. The unit class of themin
load andmax load argumentsmust be the same as the unit class for this argument.

x-channel—This argument is the channel that represents the X-axis for the Least Squares fit. The
units for this channel are normally in Strain units but it is not a requirement. The unit class of the%
strain point argument must be the same as the unit class for this argument.
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%segment length—This argument, which is a percentage, ismultiplied by the value determined as the
endpoint index of the analysis region. This number is not necessarily the total number of points in the
range or in the specimen.

% tolerance—This argument is a comparison factor used to expand the region initially selected by the
algorithm. The initial region identified as having themaximum slope is first determined. The region of
data considered is expanded in small increments while the slope of the new line stayswithin the
tolerance based on the initial region. A value of 100%will not allow the region to expand. A value of
90%will allow expansion while the slope of the data region is within 90% of the initially determined
region.

min load—The argument is used to determine the start of the analysis region. The unit class of this
argument must be the same one used with the y-channel.

max load—The argument is used to determine the start of the analysis region. The unit class of this
argument must be the same one used with the y-channel.

% strain point—The argument is used to determine the start of the analysis region. The unit class of
this argument must be the same one used with the x-channel.

Note: For more information about how the analysis region is determined, see “Determining
Analysis Region” on page 191.

Unit Class
Integer

MaxSlopeEndIndex
TheMaxSlopeStartIndex andMaxSlopeEndIndex functions are used to determine a region of data
where the slope of the line isminimized based on the function arguments. The slope of the line is
determined using a Least Squares Fit on the Y and X channel data.

Returns
TheMaxSlopeEndIndex function returns the last point of the region.  If a valid region cannot be located
given the function arguments, a –1 will be returned as the index.

Syntax
MaxSlopeEndIndex (y-channel, x-channel, % segment length, % tolerance, min load, max
load, %strain point)

Parameters
y-channel—This argument is the channel that represents the Y-axis for the Least Squares fit. The units
for this channel are normally in Force units but it is not a requirement. The unit class of themin load
andmax load argumentsmust be the same as the unit class for this argument.

x-channel—This argument is the channel that represents the X-axis for the Least Squares fit. The units
for this channel are normally in Strain units but it is not a requirement. The unit class of the% strain
point argument must be the same as the unit class for this argument.
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% segment length—This argument, which is a percentage, ismultiplied by the value determined as the
endpoint index of the analysis region. This number is not necessarily the total number of points in the
range or in the specimen.

% tolerance—This argument is a comparison factor used to expand the region initially selected by the
algorithm. The initial region identified as having themaximum slope is first determined. The region of
data considered is expanded in small increments while the slope of the new line stayswithin the
tolerance based on the initial region. A value of 100%will not allow the region to expand. A value of
90%will allow expansion while the slope of the data region is within 90% of the initially determined
region.

min load—The argument is used to determine the start of the analysis region. The unit class of this
argument must be the same one used with the y-channel.

max load—The argument is used to determine the start of the analysis region. The unit class of this
argument must be the same one used with the y-channel.

% strain point—The argument is used to determine the start of the analysis region. The unit class of
this argument must be the same one used with the x-channel.

Note: For more information about how the analysis region is determined, see “Determining
Analysis Region” on page 191.

Unit Class
Integer

MinSlopeStartIndex
TheMinSlopeStartIndex andMinSlopeEndIndex functions are used to determine a region of data
where the slope of the line isminimized based on the function arguments. The slope of the line is
determined using a Least Squares Fit on the Y and X channel data.

Returns
TheMinSlopeStartIndex function returns the first point of the region.  If a valid region cannot be located
given the function arguments, a –1 will be returned as the index.

Syntax
MinSlopeStartIndex (y-channel, x-channel, % segment length, % tolerance, min load, max
load, %strain point)

Parameters
y-channel—This argument is the channel that represents the Y-axis for the Least Squares fit. The
units for this channel are normally in Force units but it is not a requirement. The unit class of themin
load andmax load argumentsmust be the same as the unit class for this argument.

x-channel—This argument is the channel that represents the X-axis for the Least Squares fit. The
units for this channel are normally in Strain units but it is not a requirement. The unit class of the%
strain point argument must be the same as the unit class for this argument.
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%segment length—This argument, which is a percentage, ismultiplied by the value determined as the
endpoint index of the analysis region. This number is not necessarily the total number of points in the
range or in the specimen.

% tolerance—This argument is a comparison factor used to expand the region initially selected by the
algorithm. The initial region identified as having theminimum slope is first determined. The region of
data considered is expanded in small increments while the slope of the new line stayswithin the
tolerance based on the initial region. A value of 100%will not allow the region to expand. A value of
90%will allow expansion while the slope of the data region is within 90% of the initially determined
region.

min load—The argument is used to determine the start of the analysis region. The unit class of this
argument must be the same one used with the y-channel.

max load—The argument is used to determine the start of the analysis region. The unit class of this
argument must be the same one used with the y-channel.

% strain point—The argument is used to determine the start of the analysis region. The unit class of
this argument must be the same one used with the x-channel.

Note: For more information about how the analysis region is determined, see “Determining
Analysis Region” on page 191.

Unit Class
Integer

MinSlopeEndIndex
TheMinSlopeStartIndex andMinSlopeEndIndex functions are used to determine a region of data
where the slope of the line isminimized based on the function arguments. The slope of the line is
determined using a Least Squares Fit on the Y and X channel data.

Returns
TheMinSlopeEndIndex function returns the last point of the region.  If a valid region cannot be located
given the function arguments, a –1 will be returned as the index.

Syntax
MinSlopeEndIndex (y-channel, x-channel, % segment length, % tolerance, min load, max
load, %strain point)

Parameters
y-channel - This argument is the channel that represents the Y-axis for the Least Squares fit. The units
for this channel are normally in Force units but it is not a requirement. The unit class of themin load
andmax load argumentsmust be the same as the unit class for this argument.

x-channel – This argument is the channel that represents the X-axis for the Least Squares fit. The
units for this channel are normally in Strain units but it is not a requirement. The unit class of the%
strain point argument must be the same as the unit class for this argument.
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% segment length – This argument, which is a percentage, ismultiplied by the value determined as the
endpoint index of the analysis region. This number is not necessarily the total number of points in the
range or in the specimen.

% tolerance – This argument is a comparison factor used to expand the region initially selected by the
algorithm. The initial region identified as having theminimum slope is first determined. The region of
data considered is expanded in small increments while the slope of the new line stayswithin the
tolerance based on the initial region. A value of 100%will not allow the region to expand. A value of
90%will allow expansion while the slope of the data region is within 90% of the initially determined
region.

min load – The argument is used to determine the start of the analysis region. The unit class of this
argument must be the same one used with the y-channel.

max load – The argument is used to determine the start of the analysis region. The unit class of this
argument must be the same one used with the y-channel.

% strain point – The argument is used to determine the start of the analysis region. The unit class of
this argument must be the same one used with the x-channel.

Note:
For more information about how the analysis region is determined, see “Determining Analysis
Region” on page 191.

Unit Class
Integer

OffsetYieldIndex
TheOffsetYieldIndex function is used to calculate the index of the data where the X-Y curve intersects
with a line offset from themodulus line by a defined X-Axis offset.

Returns
The index of the first point past where the line would intersect with the X-Y curve.

Syntax
OffsetYieldIndex(y-axis, x-axis, slope1Index, slope2Index, offset[, endIndex])

Parameters
y-axis - The Y-Axis data.

x-axis - The X-Axis data.

Slope1Index - The start of the region of peak slope (modulus line).

Slope2Index - The end of the region of peak slope (modulus line).

Offset - The offset from themodulus line to use in the calculation.

EndIndex - An optional end index that is used to limit the search region. If this parameter ismissing, the
last data point in the array is used as the end.
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Unit Class
Integer

PeakIndex
The PeakIndex function locates the index of themaximum value in the array.

Returns
The index of the array associated with themaximum value of the array.

Syntax
PeakIndex(channel[, startIndex, endIndex])

Parameters
Channel - The array data used in the function.

StartIndex - The optional starting index of the region to evaluate.

EndIndex - The optional ending index of the region to evaluate.

Unit Class
Integer

PeakSlopeIndex
The PeakSlopeIndex function locates the region of peak slope of the X-Y curve.

Returns
This function returns the start or end index of the region of the peak slope of the X-Y curve.

Syntax
PeakSlopeIndex(markerNumber, y-axis, x-axis, segmentLength[, startIndex, endIndex,
tolerance])

Parameters
MarkerNumber - 1 returns the start index; 2 returns the end index.

y-axis - The Y-Axis array data.

x-axis - The X-Axis array data.

SegmentLength - The percentage of the peak Y-Axis used to determine the regions used in the slope
calculations.

StartIndex - The optional start index of the region. If this parameter ismissing, the start is associated
with the first data point in the array.

EndIndex - The optional end index of the region. If this parameter ismissing, the end is associated with
the end of the array data.
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Tolerance - The percentage of the slope used to optimize themaximum slope region. The region can
be optimized by reducing the region and rechecking the slope. The optimization step will be terminated
if the new slope is outside of the tolerance band of the original peak slope. If this parameter ismissing,
no additional optimization is used beyond locating themaximum region.

Unit Class
Integer

RuntimeOffsetYieldIndex
TheRuntimeOffsetYieldIndex function determineswhen anOffset Yield is reached in a test.

Example: You can use this function to switch test speeds after the offset yield points have been
reached. Basically, you start by using oneGoTo activity with a slower speed until the offset yield has
been reached. After the offset yield has been reached, you can use a secondGoTo activity running
at a faster speed.

Using the RuntimeOffsetYieldIndex function, you can calculate the offset yield during a test and
determine when it has been reached. To do this, add a variable using this calculation to the first
GoTo activity. Then, configure the limit detection for the first GoTo activity to monitor this variable
and cause the first GoTo activity to move to the secondGoTo activity when the offset yield point is
reached.

Returns
The index of the data where the x-y curve intersects with a line offset from themodulus line by a
defined x-axis offset when the yield point is reached. The function returns an invalid number before it
locates the yield point.

Syntax
RuntimeOffsetYieldIndex(y-axis, x-axis, offset, numberOfPoints, threshold, slope, intercept
[, startIndex, endIndex])

Parameters
y-axis - The y-axis array variable.

x-axis - The x-axis array variable.

offset - The variable that contains the offset yield goal in x-axis units. It should be set to a slightly higher
value than the actual yield point. For example, if you want a 2% yield, set it to 3% to guarantee that you
actually reached the desired yield point beforemoving on.

numberOfPoints - This variable holds the number of points used in the yield point calculations in
counts.

threshold - This variable is used to set aminimum y-axis value that must be exceeded before looking
for the yield point in y-axis units.

slope - This variable holds the slope of themodulus line.

intercept - This variable holds the intercept of themodulus line.
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startIndex - The optional start index of the region. If this parameter ismissing, the start is associated
with the first data point in the array.

endIndex - The optional end index of the region. If this parameter ismissing, the end is associated with
the end of the array data.

Unit Class
Integer

TestRunNumber

Description
The TestRunNumber function returns the current test run number.

Returns
Returns a 1-based number representing the placement of the Test Run in the list of Test Runs.

Syntax
TestRunNumber()

Unit Class
Integer

ValleyIndex
The ValleyIndex function locates the index of theminimum value in the array.

Returns
The index of the array associated with theminimum value of the array.

Syntax
ValleyIndex(channel[, startIndex, endIndex])

Parameters
Channel - The array data used in the function.

StartIndex - The optional starting index of the region to evaluate.

EndIndex - The optional ending index of the region to evaluate.

Unit Class
Integer

Example
Given a force array whoseminimum value is located at index 100 in the array, this function returns 100.

YieldIndexByZeroSlope
The YieldIndexByZeroSlope function determines the yield index by searching the curve in segments
until the angle of the curve decreases to the specified angle.
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Returns
The function returns the index associated with the Yield point.

Syntax
YieldIndexByZeroSlope(y-axis, x-axis, angle, segmentLength[, threshold, startIndex,
endIndex)

Parameters
y-axis - The Y axis data array used in the calculation of the yield index.

x-axis - The X axis data array used in the calculation of the yield index.

Angle - The angle of the slope used to determine the location of the yield point.

SegmentLength - The number of points to use in each slope calculation.

Threshold - An optional percentage of the peak value of the y-axis data that must be exceeded before
starting the search for the Yield Index. If this field ismissing, 2% is used.

StartIndex - An optional starting index for the yield index search region. If this field ismissing, the
search starts at the beginning of the data.

EndIndex - An optional ending index for the yield index search region. If this field ismissing, the search
ends at the last point of the data.

Unit Class
Integer

Example
Y-Axis = Force array

X-Axis = Extension array

Angle = 0 rad

Segment Length = 10

Threshold = 2 N

Given these values, the algorithm starts looking for the first point in the Force array that exceeds 2 N.

The first Force point that exceeds 2 N becomes the start of the search region.

The slope of the Force and Extension data is calculated using 10 point segments.

The algorithm increments through the data until there is nomore data to check or the slope decreases
to an angle of 0 radians.

YpeEndIndexByIncreasingLoad
The YpeEndIndexByIncreasingLoad function determines the end of the Yield Point Elongation.

Returns
The function returns the index associated with the end of the Yield Point Elongation region.



Working with Variables

MTS TestSuite™ TWEssential User Guide 205

Syntax
YpeEndIndexByIncreasingLoad(ForceArray, YPEStartIndex, Tolerance)

Parameters
ForceArray - The force array used to determine end of the Yield Point Elongation region.

YPEStartIndex - The index associated with the start of the Yield Point Elongation region.

Tolerance - The percentage difference in force at the YPE start index used to detect the YPE end
index.

Unit Class
Integer

Example
YPEStartIndex = 100

Tolerance = 1%

Force at YPE Start = 1000 N

Force Tolerance = 1000 N * 1% = 10N

Assuming the peakwas located at index 200, the algorithm starts at index 200 and go towards index
100. At each point, the force is compared to the force at YPE Start. When the Force of the currently
compared points is within 10 N of the YPE Start value, the YPE end index is located.

Algorithm
This function uses the following algorithm:

1. Find the peak load index after the YPE Start index.

2. Starting at this point search backwards down the curve until the load value is within the
specified tolerance of the load at the YPE Start index.

3. Report the indexwhere this criterion ismet as the YPE End index.

YpeEndIndexByTwoSlopes
The YpeEndIndexByTwoSlopes function located the end of the Yield Point Elongation region by
finding the point of intersection of themaximum slope line and the zero slope line (both after the YPE
Start index).

Returns
The function returns the index associated with the end of the Yield Point Elongation region.

Syntax
YpeEndIndexByTwoSlopes(ForceArray, DisplacementArray, YPEStartIndex,
PeakTolerance, ZeroSlopeSegmentLength, MaxSlopeSegmentLength)

Parameters
ForceArray - The force array used to determine end of the Yield Point Elongation region.
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DisplacementArray - The displacement array used to determine end of the Yield Point Elongation
region.

YPEStartIndex - The index associated with the start of the Yield Point Elongation region.

PeakTolerance - The percentage drop from the of the peak force that must occur before starting the
search for the zero slope region of the curve.

ZeroSlopeSegmentLength - The percentage of the total points used to determine the zero slope
region.

MaxSlopeSegmentLength - The percentage of the total points used to determine themaximum slope
region.

Unit Class
Integer

Algorithm
This function uses the following algorithm:

1. Starting at the peak load index, search the curve backwards until the load drops by the
tolerance amount (tolerance is a percentage of peak load).

2. Using the zero slope segment length argument, search the curve backwards until the slope of
the segment becomes less than zero.

3. Find theminimum load point of this segment, referred to as the zero slope index.

4. Starting at the zero slope index, use themaxSlopeSegLen argument to search up the curve
for the segment with the highest slope value.

5. Draw a line for this segment and draw a horizontal line through the zero slope index.

6. Where these two lines intersect, calculate the value of the extension channel.

7. The YPE End index is the data point whose extension value is closest to this value.

Note:
This value can never be lower than the zero slope index.

Zero Slope Index
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YPE End Index

YpeStartIndex
The YpeStartIndex function finds the start of the Yield Point Elongation region by locating the point
after Yield where the slope of the curve exceeds the specified angle.

Returns
The function returns the index associated with the start of the Yield Point Elongation region.

Syntax
YpeStartIndex(ForceArray, DisplacementArray, Angle, SegmentLength, YieldIndex)

Parameters
ForceArray - The force array being analyzed for the Yield Point Elongation region.

DisplacementArray - The displacement array being analyzed for the Yield Point Elongation region.

Angle - The angle whichmust be exceeded.

SegmentLength - Percentage of points to use in the slope calculations.

YieldIndex - The index point into the array where the Yield Indexwas determined.

Unit Class
Integer

Example
Angle = 0

SegmentLength = 2%

YieldIndex = 85

Total points on the curve = 200

Number of points in segment = 0.02 * 200 = 4 points

1. Start with the segment from point 85 to point 89.

2. Increment points until slope is less than zero. For this example, assume that this occurs at
points 100 to 104.

3. Increment points starting at 100 to 104 until the slope value is greater than zero. For our
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example, assume this occurs at points 105 to 109.

4. Report the YPE Start Index as theminimum load point between the Yield index and the last
point of the search (point 109).

Math Functions
This section provides reference information about themath functions.

abs (Absolute Value)
This function is used to calculate the absolute value of the number specified.

Important:
This function is only used for integer numbers.

Syntax
abs(number)

acos (Arc Cosine)

Syntax
acos(number)

This function is used to calculate the arc cosine of the number specified.

Returns
Angle with a cosine equal to the specified number.

asin (Arc Sine)

Syntax
asin(number)

This function is used to calculate the arc sine of the number specified.

Returns
Angle with a sine equal to the specified number.

atan (Arc Tangent)

Syntax
atan(number)

This function is used to calculate the arc tangent of the number specified.

Returns
Angle with a tangent equal to the specified number.
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Atan2

Syntax:
atan2(y,x)

The angle with a tangent that is the quotient of the two specified numbers.

avg

Syntax:
avg(number1, number2,[numberN])

Returns the average of a series of numbers.

Ceiling
This function is used to round the specified number up to the nearest whole number.

Syntax
Ceiling(number)

The smallest integer greater than or equal to the specified number.

Examples
The following formula returns the value 6: ceiling(5.4)

The following formula returns the value 7: ceiling(6.9)

ArrayValue
The ArrayValue function returns the value of one array that correspondswith the location of a value
found in another array.

Returns
The value from the array at the specified index or NaN (Not a Number) if not found.

Syntax
ArrayValue(resultArray, searchArray, searchValue[, startIndex, endIndex])

Parameters
ResultArray - The array where the result is extracted.

SearchArray - The array used in the search.

SearchValue - The value to search for in the search array.

StartIndex - The optional starting index for the search. If this parameter is not present, the search starts
at the beginning of the array.

EndIndex - The optional ending index for the search. If this parameter is not present, the search ends
at the last point in the array.
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Unit Class
Same as result channel.

Example
ArrayValue(Extension, Load, PeakLoad)

This example returns the Extension value associated with the PeakLoad value located in the Load
array.

cos (Cosine)

Syntax
cos(number)

This function is used to calculate the cosine of the number specified.

Cosine of the specified angle

cosh (Hyperbolic cosine)

Syntax
cosh(number)

Hyperbolic cosine of the specified angle.

e (Natural logarithmic base, e)

Syntax
e()

CurveArea
TheCurveArea function calculates the area under the curve defined by the Y and X axis data.

Syntax
CurveArea(xArray, yArray, startIndex, endIndex)

Returns
The area under the curve.

Parameters
y-axis – The array holding the Y-Axis data.

x-axis – The array holding the X-Axis data.

StartIndex - The start index of the region to analyze.

EndIndex - The end index of the region to analyze.

Unit Class
X-Axis unit / Y-Axis unit
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Example 1
CurveArea (_Load, SlackExt, 0 , SizeOfArray(_Load)-1)

This formula calculates the area under the entire Load versus Extension curve.

Example 2
CurveArea (_Load, SlackExt, 0, Peak)

This formula calculates the area under the Load versus Extension curve up to the peak load.

ElasticStrainValue
The ElasticStrainValue function is used to calculate the portion of strain in a specimen that is
recoverable, or elastic. The point where this is determined is based on some percentage of the peak
load.

Returns
The portion of the strain that is recoverable.

Syntax
ElasticStrainValue(ForceArray, StrainArray, StartIndex, EndIndex, Tolerance)

Parameter
ForceArray – The array containing force data.

StrainArray – The array containing strain data.

StartIndex – The start index of themodulus region.

EndIndex - The end index of themodulus region.

Tolerance – The percentage drop from peak force used to determine the transition point.

Unit Class
Strain

Example
Tolerance = 98% (shown at blue oval)

The point is found where the load value is 98% of the peak load. Then a line parallel to themodulus line
is drawn from this point back to the x-axis. The Elastic strain is the difference in strain values as shown
on the graph.

Note:
Unlike plastic strain, there is no flag to set whether the specified load point should be found after
the peak or before. This is because the Elastic Strain value would be the same in either case.
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Elastic Strain Value

EnergyValue
The EnergyValue function calculates the area under the curve defined by the Y and X axis data. If
using the Force and Extension data, this function returns the amount of energy absorbed by the
specimen during the test.

Returns
The area under the curve.

Syntax
EnergyValue(y-axis, x-axis, startIndex, endIndex)

Unit Class
X-Axis unit / Y-Axis unit

Example 1
EnergyValue (_Load, SlackExt, 0 , SizeOfArray(_Load)-1)

This formula calculates the area under the entire Load versus Extension curve (energy).

Example 2
EnergyValue (_Load, SlackExt, 0, Peak)

This formula calculates the area under the Load versus Extension curve (energy) up to the peak load.

Exp
This function is used to calculate the value of e (2.71828...) raised to the power specified by the
exponent.

Syntax
exp(number)

Returns
A value “e” raised to the specified power.

FindNearestValue
Locate the closest value in an array to the search value.
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Syntax
FindNearestValue(array, searchValue[, startIndex, endIndex])

FindNearestValueIndex
Locate the index of the closest value in an array to the search value.

Syntax
FindNearestValueIndex(array, searchValue[, startIndex, endIndex])

Floor

Syntax
floor(number)

Returns
The largest integer less than or equal to the specified number.

This function is used to round the specified number down to the nearest whole number.

Example 1
Floor(5.4)

This formula returns the value 5.

Example 2
Floor(6.9)

This formula returns the value 6.

IsInvalidNumber

Syntax
IsInvalidNumber(number)

Checks the validity of the supplied value.

Returns
This function returns 1 if the value being tested is invalid; otherwise, 0 (zero) is returned.

Example
IsInvalidNumber(PeakLoad)

Where PeakLoad is a non-array variable.

IsValidNumber
Returns “1” if the number is valid. Otherwise, it returns “0”.

Syntax
IsValidNumber(number)
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Example
IsValidNumber(PeakLoad)

Where PeakLoad is a non-array variable.

LeastSquaresFit
The slope of the least squares fit of the array that contains Y-axis data and X-axis data between the
start and end indexes.

Returns
The slope of the least squares fit line calculated over the specified region.

Syntax
LeastSquaresFit(yVariable, xVariable, startIndex, endIndex)

Parameters
yVariable – The Y-Axis data.

xVariable – The X-Axis data.

StartIndex – The starting index of the region.

EndIndex – The ending index of the region.

Units
Y-Axis unit / X-Axis Unit

Example
LeastSquaresFit(Force, Extension, Slope1, Slope2)

This formula returns the slope of the line between the two indexes of Slope1 and Slope2.

log(number)

Syntax
log(number)

The natural log of a specified number.

log10(number)
The base-10 logarithm of a specified number.

max

Syntax
max(number1, number2[, numberN])

Returns
Themaximumof a series of numbers.
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MaxDouble()

Syntax
MaxDouble()

Returns
Returns themaximum value for the type of number.

MaxLong()

Syntax
MaxLong()

Returns
Returns themaximum value for the type of number.

min
Theminimumof a series of numbers.

Syntax
min(number1, number2[, numberN])

MinDouble()
Returns theminimum value for the type of number.

Syntax
MinDouble()

MinLong()
Returns theminimum value for the type of number.

Syntax
MinLong()

NaN()
Returns an invalid value for the type of number, which is Not a Number.

Syntax
NaN()

PI()
Value of Pi.

Syntax
PI()
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PlasticStrainValue
The PlasticStrainValue is used to calculate the portion of strain in a specimen that is non-recoverable,
or plastic. The point where this is determined is based on some percentage of the peak load.

Returns
The portion of the strain that is non-recoverable.

Syntax
PlasticStrainValue(ForceArray, StrainArray, StartIndex, EndIndex, Tolerance[,
AfterPeakFlag])

Parameters
ForceArray – The array containing force data.

StrainArray – The array containing Strain data.

StartIndex – The start index of themodulus region.

EndIndex – The end index of themodulus region

Tolerance – The percentage of the peak force used to locate the transition point.

AfterPeakFlag – An optional flag to specify looking for transition point after the peak load.

Unit Class
Strain

Example
Tolerance = 98% (shown at blue oval)

The point is found where the load value is 98% of the peak load. Then a line parallel to themodulus line
is drawn from this point back to the x-axis. The Plastic strain is the difference in strain values as shown
on the graph.

Plastic Strain Value

pow(base, exponent)
A number (base) is raised to an exponential power (exponent).

Returns
Returns the value of the base raised to the power specified by the exponent.
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Syntax
pow(base, exponent)

Example 1
Pow(2, 3)

This formula returns the value 8 (2^3, or 2*2*2)

Example 2
Pow(5, 2)

This formula returns the value 25 (5^2, or 5*5)

rem(dividend, divisor)
This function returns the remainder from the division of two numbers. When using this function, the
result is calculated differently than themodulus operator. This function uses the following ANSI/IEEE-
compliant formula:

Remainder = divided - (divisor * round(divided / divisor))

Syntax
rem(dividend, divisor)

round(number)
Rounds a value to the nearest integer.

Syntax
round(number)

sign(number)
Value that indicates the sign of a number.

Returns
This function returns –1 is the number is negative, or +1 is the number is positive. If the number is
exactly 0, the function returns 0.

Syntax
sign(number)

Example 1
sign(-500)

This formula returns the value -1.

Example 2
sign (20)

This formula returns the value +1
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sin(number)

Returns
Sine of the specified angle.

Syntax
sin(number)

sinh(number)
Hyperbolic sine of the specified number.

Syntax
sinh(number)

sqrt(number)
The square root of a number.

Syntax
sqrt(number)

tan(number)
Tangent of the angle.

Syntax
tan(number)

tanh(number)
Hyperbolic tangent of the angle.

Syntax
tanh(number)

truncate
Rounds a value to the nearest integer towards zero.

Returns
The X-Intercept from the least squares fit line.

Syntax
truncate(number)

Parameter
number – The number to be truncated.

Unit Class
Same the number.
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Example
truncate(4.5) = 4

XInterceptValue
The XInterceptValue function returns X-Intercept of the least squares fit line calculated over the
specified region.

Returns
The X-Intercept from the least squares fit line.

Syntax
XInterceptValue (y-axis, x-axis, slope1Index, slope2Index)

Parameters
y-axis – Y-Axis data array.

x-axis – X-Axis data array.

Slope1Index – The start index of the region.

Slope2Index – The end index of the region.

Unit Class
Same asX-Axis data.

Example
With the following function, the circled value on the X-Axis is returned.

XInterceptValue (_Load, _Extension, Slope1, Slope2)

XInterceptValue
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YInterceptValue
The YInterceptValue returns the point where the line determined by the index values crosses the Y-
Axis.

Returns
The index in to the arrayswhere the Y-intercept occurs.

Syntax
YInterceptValue(y-axis, x-axis, slope1Index, slope2Index)

Parameters
y-axis – The Y-Axis data array being analyzed.

x-axis – The X-Axis data array being analyzed.

Slope1Index – The starting index of the region used to calculate the straight line.

Slope2Index - The ending index of the region used to calculate the straight line.

Unit Class
Same asY-Axis data.

Example
The following function returns the Y-Intercept of the line defined by Slope1 and Slope2.

YInterceptValue(_Load, _Extension, Slope1, Slope2)
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YInterceptValue

Operator Functions
This section describesOperator functions and precedence.

Operators and Precedence
The following table shows all the recognized operators organized by group and listed in order of
precedence.Within a group, all operators have the same precedence.

Note: Some programming languages use a semicolon as a list separator instead of a comma. If
you are using one of those languages, the last operator of the table would be replaced with a
semicolon.

Precedence Operator Function Direction

1 [ ] Array Index Left-to-Right

( ) Function Call

. Variable-Specific Information

2 ! Logical NOT Right-to-Left

Operator Precedence
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Precedence Operator Function Direction

+ Unary Plus Left-to-Right

- UnaryMinus

~ OnesComplement

3 * Multiply Left-to-Right

/ Divide

% Modulus

4 + Addition Left-to-Right

– Subtraction

5 << Bitwise Shift Left Left-to-Right

>> Bitwise Shift Right

6 < Less Than Left-to-Right

> Greater Than

<= Less than or Equal

>= Greater Than or Equal

7 == Equal to Left-to-Right

!= Logical Not

8 & Bitwise AND Left-to-Right

9 ^ Bitwise XOR Left-to-Right

10 | Bitwise OR Left-to-Right

11 && Logical AND Left-to-Right

12 || Logical OR Left-to-Right

13 = Assignment Right-to-Left

14 , Comma - List Separator Left-to-Right

Choose

Returns
Returns a value based on the evaluation of the first argument.

Syntax
Choose(Expression, EvaluatedZero,EvaluatedOne[, EvaluatedN])
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Parameters
Expression—The Expressionmust evaluate to an integer.

EvaluatedZero—If the Expression evaluates to a 0 (zero), the EvaluatedZero value is returned.

EvaluatedOne—If the expression evaluates to a 1 (one), the EvaluatedOne value is returned, and so
on.

EvaluatedN —If the Expression is < 0 or > N, the EvaluatedN value is returned.

Note:
The Evaluated argumentsmust evaluate to be either all strings or all numbers

Example
Examples of the Choose function:

Choose(chosen, “Red”, “Blue”, “Green”)

Choose(chosen, 1.0, 2.0, 3.0, 4.0, 5.0)

Choose(chosen, Choice0, Choice1, Choice2, Choice3)

Peel-Tear Functions
This section describes Peel-Tear functions.

AverageMinPeaks
The AverageMinPeaks function calculates the average of theminimumpeaks located in the data using
the specified criterion.

Syntax
AverageMinPeaks(VarArray, peakCriterion, numberOfPeaks[, startIndex, endIndex,
threshold])

Parameters
VarArray - The data array to be analyzed.

PeakCriterion - A percentage of the peakmagnitude used to detect when peaks occur.

NumberOfPeaks - The number of minimumpeaks to include in the calculations.

StartIndex - The optional index into the array used as the starting location for the calculation.

EndIndex - The optional index into the array used as the ending location for the calculation.

Threshold - The optional minimum value, in array units, whichmust be exceeded before the data is
used in the calculation.

Unit Class
Same as array data.

Example
AverageMinPeaks(_Load, LoadMinPeakCriteria, 5, 0, SizeOfArray(_Load)-1,MinimumLoad)
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This formula:

1. Searches the _Load channel.

2. Looks for drops in the value of _Load channel that correspond to the input
LoadMinPeakCriteria.

3. Determines the average of the 5minimumpeaks.

4. Searches between the first data point and the last data point.

5. Calculates the result only if the _Load channel becomes greater than the value of the input
MinimumLoad.

AveragePeaks
The AveragePeaks function calculates the average of themaximumpeaks located in the data using
the specified criterion.

Returns
The average of themaximumpeaks.

Syntax
AveragePeaks(VarArray, peakCriterion[, startIndex, endIndex, numberOfPeaks, threshold])

Parameters
VarArray - The array data being analyzed.

PeakCriterion - The percentage of change from the peak that identifies the valley.

StartIndex - The optional starting index of the region to analyze.

EndIndex - The optional ending index of the region to analyze.

NumberOfValleys - The optional maximumnumber of valleys to identify.

Threshold - The optional threshold that has to be exceeded to start looking for peaks.

Unit Class
Same as the array data.

Example
AveragePeaks(_Load, LoadPeakCriteria, 0, SizeOfArray(_Load)-1)

This formula:

1. Searches the _Load channel.

2. Looks for drops in the value of _Load channel that correspond to the input LoadPeakCriteria.

3. Searches between the first data point and the last data point.

AverageValleys
The AverageValleys function returns the average of all the valleys determined using the peak criteria.
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Returns
The average valley calculated.

Syntax
AverageValleys(VarArray, valleyCriterion[, startIndex, endIndex, numberOfValleys,
threshold])

Parameters
VarArray - The array data being analyzed.

ValleyCriterion - The percentage of change from the valley that identifies the valley.

StartIndex - The optional starting index of the region to analyze.

EndIndex - The optional ending index of the region to analyze.

NumberOfValleys - The optional maximumnumber of valleys to identify.

Threshold - The optional threshold that has to be exceeded to start looking for valleys.

Unit Class
Same unit as the array.

Example
AverageValleys(_Load, LoadMinValleyCriteria)

This formula:

1. Searches the _Load channel.

2. Looks for increases in the value of _Load channel that correspond to the input
LoadMinValleyCriteria.

AverageValue
The AverageValue function returns the average array value over a specified region.

Returns
The average array value.

Syntax
AverageValue(VarArray, startIndex, endIndex)

Parameters
VarArray - The variable being analyzed.

StartIndex - The start index of the region being analyzed.

EndIndex - The end index of the region being analyzed.

Unit Class
Same as the array data.
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Example
AverageValue(_Load, Peak, SizeOfArray(_Load)-1)

This formula calculates the average value of the _Load channel between the Peak load point and the
end of the test.

CombinedExtension
TheCombinedExtension function returns the value of the extensometer or crosshead/actuator based
on the value of the removal point.

Returns
Extensometer value before removal point, crosshead/actuator after removal point.

Syntax
CombinedExtension(extensometer, crosshead, removalPoint)

Parameters
Extensometer - The extensometer array.

Crosshead - The crosshead/actuator array.

RemovalPoint - The value, in extensometer units, used in the determination of what data to return from
the function.

Unit Class
Length (Same as the extensometer, crosshead, and removal point)

Example
CombinedExtension(Strain, Extension, RemovalPoint)

This formula:

1. Reports the value of the Strain channel

2. Checks to see if the value of the Strain channel has exceeded the value of the RemovalPoint
input.

3. Reports the value of the Extension channel when the Strain channel has exceeded the value
of RemovalPoint.

CombinedStrain
TheCombinedStrain function returns the strain value calculated from either the extensometer or the
crosshead/actuator based on the value of the removal point.

Returns
The function returns the extensometer value divided by extGL prior to the removal points or crosshead
divided by gripSeparation.

Syntax
CombinedStrain(extensometer, crosshead, removalPoint, gripSeparation, extGL)
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Unit Class
Strain

Example
CombinedStrain( Strain, Extension, RemovalPoint, GageLength2, GageLength1)

This formula:

1. Reports the value of the Strain1 channel divided by the value of GageLength1.

2. Checks to see if the value of the Strain1 channel has exceeded the value of the RemovalPoint
input.

3. Reports the value of the Extension channel divided by value of GageLength2 when the
Strain1 channel has exceeded the value of RemovalPoint.

MedianPeak
TheMedianPeak function determines themedian of the peaks located in the specified region that meet
the specified peak criterion.

Returns
Themedian peak value.

Syntax
MedianPeak(VarArray, peakCriterion[, startIndex, endIndex, threshold])

Parameters
VarArray - The array data being analyzed for peaks.

peakCriterion - The percentage change from the peak that signifies a peak.

startIndex - The optional start index of the region. The search starts at the first data point if this
parameter ismissing.

endIndex - The optional end index of the region. The search ends at the last data point if this parameter
ismissing.

Threshold - The optional threshold that must be exceeded before searching for peaks.

Unit Class
Same as the array data.

Example
AveragePeaks(_Load, LoadPeakCriteria, 0, SizeOfArray(_Load) - 1, MinimumLoad)

This formula:

1. Searches the _Load channel.

2. Looks for drops in the value of _Load channel that correspond to the input LoadPeakCriteria.

3. Determines themedian of all of the peaks.
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4. Calculates the result only if the _Load channel becomes greater than the value of the input
MinimumLoad.

NumberOfPeaks
TheNumberOfPeaks function determines the number of peaks in a region that meet the specified
peak criterion.

Returns
The number of peaks found in the region.

Syntax
NumberOfPeaks(VarArray, peakCriterion[, startIndex, endIndex, threshold])

Parameters
VarArray - The array data being analyzed for peaks.

peakCriterion - The percentage change from the peak that signifies a peak.

startIndex - The optional start index of the region. The search starts at the first data point if this
parameter ismissing.

endIndex - The optional end index of the region. The search ends at the last data point if this parameter
ismissing.

Threshold - The optional threshold that must be exceed before searching for peaks.

Unit Class
Integer

Example
NumberOfPeaks(_Load, LoadPeakCriteria, 0, SizeOfArray(_Load) - 1 , MinimumLoad)

This formula:

1. Searches the _Load channel.

2. Looks for drops in the value of _Load channel that correspond to the input LoadPeakCriteria.

3. Searches between the first data point and the last data point.

4. Determines the total number of peaks found.

5. Calculates the result only if the _Load channel becomes greater than the value of the input
MinimumLoad.

NextPeak
TheNextPeak function searches the data array specified in array and returns the next peak’s index, as
defined by the peak criteria, after the data point specified by the start index. The values in square
braces, [ ], are optional.

Syntax
NextPeak(array, peakCriteria, startIndex[, endIndex, threshold]))
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Parameters
array—The array data being analyzed for the next peak.

peakCriteria—A percentage of the peakmagnitude used to detect when a peak occurs.

startIndex—The start index of the array used in locating the peak. The first point in the array is used if
this parameter is not provided.

endIndex—The optional end index of the array used in locating the peak. The last point in the array is
used if this parameter is not provided.

threshold—The optional minimum value, in array units, whichmust be exceeded before the data is
used in the calculation.

Dimension
Count

Example
NextPeak(_LoadArray, LoadPeakCriteria, Peak, SizeOfArray(_LoadArray)-1, MinimumLoad)

This formula:

1. Searches the _LoadArray data.

2. Looks for the next drop in the _LoadArray data's value that corresponds to the input
LoadPeakCriteria.

3. Searches between the peak load's point and the last data point.

4. Finds the next peak and returns its array index.

5. Only calculates the result if the _LoadArray data becomes greater than the value of the input
MinimumLoad.

NextValley
TheNextValley function searches the data array specified in array and returns the next valley's index
as defined by the valley criteria, after the data point specified by the start index. The valueswithin
square braces, [], are optional.

Syntax
NextValley(array, valleyCriteria, startIndex[, endIndex, threshold])

Parameters
array—The array data being analyzed for the next valley.

valleyCriteria—A percentage of the peakmagnitude used to detect when a valley occurs.

startIndex—The start index of the array used in locating the valley. The first point in the array is used if
this parameter is not provided.

endIndex—The optional end index of the array used in locating the valley. The last point in the array is
used if this parameter is not provided.



Working with Variables

230 MTS TestSuite™ TWEssential User Guide

threshold—The optional minimum value, in array units, whichmust be exceeded before the data is
used in the calculation.

Dimension
Count

Example
NextValley(_LoadArray,LoadValleyCriteria,Peak,SizeOfArray(_LoadArray)-1,MinimumLoad)

This formula:

1. Searches the _LoadArray data.

2. Looks for the next increase in the _LoadArray data's value that corresponds to the input
LoadValleyCriteria.

3. Searches between the peak load's point and the last data point.

4. Finds the next valley and returns its array index.

5. Only calculates the result if the _LoadArray data becomes greater than the value of the input
MinimumLoad.

StDevValue
Calculates the standard deviation of a variable array between two index points.

Syntax
StDevValue(VarArray, startIndex, endIndex)

Parameters
VarArray - The array data being analyzed.

StartIndex - The start index of the region being analyzed.

EndIndex - The end index of the region being analyzed.

Unit Class
Same as array data specified.

Example
StDevValue(_Load, Slope1, Slope2)

This formula calculates the standard deviation between given by the variables Slope1 and Slope2.

TearIndex
Locates the index of the tear value in an array.

Syntax
TearIndex(VarArray, TearCriteria[, startIndex, endIndex, Threshold])

Parameters
VarArray - The array data being analyzed.



Working with Variables

MTS TestSuite™ TWEssential User Guide 231

Tear Criteria

StartIndex - The start index of the region being analyzed.

EndIndex - The end index of the region being analyzed.

Threshold

Unit Class
Same as array data specified.

Sensor Functions
This section provides basic reference information about the available sensor functions.

CalibrationDate

Returns
Returns the last calibration date of the sensor attached to a signal.

Syntax
CalibrationDate(SignalName)

Parameter
Signal Name—The “SignalName” in signal functions is the internal name of the signal andmust be
quoted or passed in as a string variable. To determine the internal name of a signal, select theShow
Internal Names check box in theResources tab. The Name column shows the internal names.

Example
CalibrationDate(“_Load”)

Unit Class
String

CalibrationDueDate

Returns
Returns the calibration due date of the sensor attached to a signal.

Syntax
CalibrationDueDate(SignalName)

Parameter
Signal Name—The “SignalName” in signal functions is the internal name of the signal andmust be
quoted or passed in as a string variable. To determine the internal name of a signal, select theShow
Internal Names check box in theResources tab. The Name column shows the internal names.

Example
CalibrationDueDate(“_Load”)
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Unit Class
String

ModelNumber

Returns
Returns themodel number of the TEDS device attached to a signal.

Syntax
ModelNumber(SignalName)

Parameter
Signal Name—The “SignalName” in signal functions is the internal name of the signal andmust be
quoted or passed in as a string variable. To determine the internal name of a signal, select theShow
Internal Names check box in theResources tab. The Name column shows the internal names.

Example
ModelNumber(“_Load”)

Unit Class
String

SerialNumber

Returns
Returns the serial number of the TEDS device attached to a signal.

Syntax
SerialNumber(SignalName)

Parameter
Signal Name—The “SignalName” in signal functions is the internal name of the signal andmust be
quoted or passed in as a string variable. To determine the internal name of a signal, select theShow
Internal Names check box in theResources tab. The Name column shows the internal names.

Example
SerialNumber(“_Load”)

Unit Class
String

String Functions
This section provides basic reference information about the available string functions.

CompareStrings
Compares two strings, ignoring case.
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Returns
The result is 0 if the strings are equal; negative if the first string is ordered before the second string, and
positive if the second string is reordered before the first string.

Syntax
CompareStrings(string1, string2)

Parameters
string1-First string

string2-second string compared to string1.

Unit Class
String

FindSubString

Returns
Finds the index of the first occurrence of a substring within a string starting at or after a specified
starting index. Results is the indexwhere the substring begins, or negative if not found.

Syntax
FindSubstring(substring, string, startIndex)

Parameter
substring

string

startIndex

Unit Class
String

left

Returns
Extracts a substring from the left side of a string.

Syntax
left(string, length)

Parameters
string

length

Unit Class
String
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mid

Returns
Extracts a substring from themiddle of a string.

Syntax
mid(string, start[, length]

Parameters
string

start

length

Unit Class
String

NumberToString

Returns
Creates a string from the specified number with the optionally specified digits.

Syntax
NumberToString(number[, digits])

Parameters
number

digits

Unit Class
String

right

Returns
Extracts a substring from the right side of a string.

Syntax
Right(string, start)

Parameters
string

start

Unit Class
String
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StringLength

Returns
The length of the specified string.

Syntax
StringLength(string)

Parameters
string

Unit Class
String

StringToInteger

Returns
Converts a string to an integer number.

Syntax
StringToIntger(string)

Parameters
string

Unit Class
String

StringToNumber

Returns
Converts a string to a floating-point number.

Syntax
StringToNumber(string)

Parameters
string

Unit Class
String

tolower

Returns
Converts a string to all lower case.

Syntax
tolower(string)
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Parameters
string

Unit Class
String

toupper

Returns
Converts a string to all uppercase.

Syntax
toupper(string)

Parameters
string

Unit Class
String

TrimStringEnd

Returns
Removeswhitespace (spaces, tabs, and new lines) from the end of a string.

Syntax
TrimStringEnd(string)

Parameters
string

Unit Class
String

TrimStringStart

Returns
Removeswhitespace (spaces, tabs, and new lines) from the start of a string.

Syntax
TrimStringStart(string)

Parameters
string

Unit Class
String
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varIdentifier.DisplayValue
This construct is implicit in theMTS TestSuite application. Use this syntax in a calculation to return a
string representation of a string variable; including its name, value, and units.

Returns
Returns the string representation of the variable in display units.

Syntax
variableStringName.displayvalue

Replace variableStringNamewith the actual name of the string variable.

Example
Create a string variable in any of the TWE application EM templates and enter the following
calculation:

StrnAtBreak.display+" "+StrnAtBreak.displayvalue+" "+StrnAtBreak.units

The result is similar to the following:

Strain at Break 0.236mm/m

“StrainAtBreak” is the string variable, the display value of the variable is 0.236, and the units are
mm/m.

Compare Tool
TestSuite Compare Tool Overview

Access
Toolmenu > Compare > Variable or Function

Compare Variables or Functions
TheCompare tool shows differences of variable properties or function properties between the
currently opened test or template and other test definitions, test runs, analysis definitions, and analysis
runs. You can identify design differences and build on test definitionswhen you compare definitions
and runs.

You can compare:

l Test definitions

l Test runswith analysis runs (In the TW application, an analysis run includes any changes
made in theReview tab.)

l Default templateswith modified templates

l Specimen variables with other specimen variables
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Merge or Add Changes
TheCompare tool includes anAdd Changes andRemove Changes buttons that copies functions or
variable properties (with the same name) from another test definition, analysis definition, or analysis
runs into the open test or analysis. You can also useAdd Changes to add functions or variables from
another test or analysis to the open test or analysis.

Compare a Variable or Function
To compare a variable or function:

1. In the Toolsmenu, clickCompare and selectVariables or Functions. The Select Groups to
CompareWindow opens.

2. Select the check box next to the name of the test, template, analysis definition, or analysis run
you want to compare and click the arrow tomove them to the box on the right. You can also
clickSelect an External Test button (...) to browse for an external test file.

Note: TheCount column shows the number of variables or functions in each selected
item.

3. Repeat until you have selected what you want to compare.

4. ClickOK. The Comparison window opens to show all the variables or functions in the tests
and indicatesmismatches in red.

5. To view only the differences, select theShow Only Differences check box.
6. Click the plus icon to expand the window and view the properties for the variable or function.

Once expanded, the variable property names appear in the first column followed by a column
that shows the variable properties for the currently open test, and then columns for each item
selected in step 3.

Note: If a part of a calculation for a function does not match, youmust examine the
whole calculation; the Compare tool does not indicate which part of the calculation does
not match.

7. To add the variable or function to your current test, click theAdd Change button below the
appropriate test name and clickApply. After you have added all your selections, clickOK to
close the window.

Change or Add a Variable or Function During a Comparison
To change or add a variable or function during a comparison:

1. In the Toolsmenu, clickCompare and selectVariables or Functions.
2. Select the check box next to the name of the test, test definition, analysis definition, or analysis

run you want to compare.

3. Repeat until you have selected what you want to compare.

4. ClickOK. The next window shows all the variables or functions in the tests and indicates
mismatches in red.

5. Click the plus icon to expand the window and view the properties for the variable or function
that you want to merge into your current test. Once expanded, the variable property names
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appear in the first column followed by a column that shows the variable properties for the
currently open test, and then columns for each item selected in step 2.

6. To change or add variables or functions to the currently open test:

A. Scroll down the list to locate the variable/function that you want to change.

B. Determine the column that contains the variable properties or function that you want
to change or add to the currently open test.

C. ClickAdd Changes. The properties of the function or variable that you want to
merge or add are copied to theUpdate Test column and are shown in blue.

7. ClickApply orOK.
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Editing General Activity Information
Use theGeneral panel to customize theDisplay name and theDescription of the activity.

TheDisplay name is the name that is shown on both the Flowchart View andOutline View of the
test designer. If you leave this entry blank, the default name of the test activity will be used along with a
summary of test activity parameters. For example, anAuto offset activity with two signals will read
Apply offset: 2 Signals by default.

TheDescription is shownwhen you hover the cursor over the activity icon in the test procedure. If you
are designing or modifying a complicated test, youmaywant to enter a detailed description of each
new or modified activity. By doing this, it will be easier for you and others to understand the purpose of
activities and tests in the future.

Example: Suppose you are creating or modifying a test that contains severalGo To + DAQ +
Detection activities. By default, the activity name in the test procedure is accurate, but you know
that someone else at your organization will bemaking changes to your test in the future.

Tomake the test easier to understand for other test designers, you enter a detailed description in
theDescription field of eachGo To + DAQ + Detection activity. This descriptionmight include
notes about the what data is intended to be gathered while the activity executes, which ASTM
standardsmust be satisfied by the activity, or reasonswhy certain break detection parameters were
selected.

Allow Handset Control Activity Overview
TheAllow Handset Control Activity displays a user-definedmessage and allows the operator to
take control of the systemwith the handset while the test is running. If the handset becomes active
while this activity is running, the test control panel is locked.

Note: This activity is not available on systems equipped with anMTS Series 793 controller
(FlexTest).

Example: TheAllow Handset ControlActivitymight be useful when specimen installation is part
of a test procedure.

You can configure the activity to display amessage window that displays instructions for how to
insert the specimen.While this activity is running, the handset is allowed to take control of the
system so the operator can safely position the crosshead or actuator while manipulating a specimen
or fixturing.

To continue the test procedure, the operator must release handset control and dismiss the dialog
displayed by this activity.

For more information about configuring the options available in theAllow Handset Control activity,
see the following topics:

l “Editing CustomMessages” on page 250

l “Resizing CustomMessageWindows” on page 251
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l “Editing CustomMessageWindow Buttons” on page 251

Dwell+DAQ+Detection Activity Overview
Use theDwell + DAQ + Detection activity to maintain a command for a specified duration at either
the current level or a specified level in a specified control mode. By default, the activity dwells at the
current level (when theDwell at current level check box is selected).

For detailed information about configuring the properties of theDwell panel, see “Configuring Dwell
Properties” on page 243. For detailed information about configuring the data acquisition properties on
theDAQ panel and the break detection properties on theBreak Detection panel, see “Performing
Data Acquisition” on page 248 and “Specifying BreakDetection Parameters” on page 247.

Important: If you are commanding this activity using a load or strain control mode, youmay
need to tune the load or strain control mode before using this activity within a test.

Configuring Dwell Properties
Use the settings on theDwell panel to specify the control mode, end level, and end condition of the
Dwell + DAQ + Detection activity.

Dwell Properties
The following properties are available when configuring the options under theDwell panel of theDwell
+ DAQ + Detection activity.

Item Description

Control
mode

Select a control mode for theDwell + DAQ + Detection activity.

Dwell at
current
value

Select this option tomaintain the dwell at the current value as opposed to a specific end
level. If you clear this option, you can enter a specific end level into theEnd level field
below.

End level Enter a value and unit of measurement or input for when the dwell should end. To toggle
between entering an specific value and an input, click or .

When configuring the dwell to maintain a command at a specified level instead of the
current value, the rate at which the command ramps to the specific value is the
maximum rate of the crosshead for the test frame.

Note: This feature appears when you clear theDwell at Current Value check
box.

End
condition

Indicate the condition in which the dwell will end. You can choose to either end the dwell
after a certain period of time or when a signal reaches a specific limit.

l Time
l Duration—Enter the time and unit of measurement. To toggle

Dwell Properties
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Item Description

between entering an specific value and an input, click or .

l Limit

l Signal—Click to open the Select a Signal window. In this window,
select the desired signal and clickOK.

l Comparison—Select the comparisonmetric that will cause the dwell
to end:Becomes Greater Than,Becomes Less Than, Increases
By,Decreases By, orCrosses.

l Value: Enter the value and unit of measurement used in the calculation
at which the dwell will maintain the command. To toggle between
entering an specific value and an input, click or .

Example: Suppose you want to add aDwell + DAQ + Detection activity that dwells at the current
level for 5 seconds.

First, you would set theControl mode toCrosshead. Then, enable theDwell at current value
option. Under End condition, select Time and enter 5 seconds underDuration.

GoTo+DAQ+Detection Activity Overview
Use theGo To + DAQ + Detection activity to command a control channel to move the crosshead or
actuator at a specified rate and direction.

For detailed information about configuring the properties of theGo To panel, see “Configuring Go To
Options” on page 244. For detailed information about configuring the data acquisition properties on the
DAQ panel and break detection properties on theBreak Detection panel, see “Performing Data
Acquisition” on page 248 and “Specifying BreakDetection Parameters” on page 247.

Important: If you are commanding this activity using a load or strain control mode, youmay
need to tune the load or strain control mode before using this activity within a test.

Configuring Go To Options
Use the settings on theGo To panel to specify the control mode, direction, rate, and end condition of
theGo To + DAQ + Detection activity.

Go To Properties
The following properties are available when configuring the options under theGo To panel of theGo
To + DAQ + Detection activity.
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Item Description

Control
mode

Select the type of feedback to use in the control loop for the selected channel.

Use tuning
parameters

If the control mode is set to Load or Strain, youmust enter the tuning parameters for
the control mode. The tuning parameters will be different for different type of
specimenmaterials.

Note: Tuning parameter settings are only available with MTS TestSuite TW
Software running on anMTS Insight Controller.

Direction Select the signal direction used in the control loop for the selected channel for this
activity.

Increase—Move the crosshead or actuator in a direction that will increase the control-
mode feedback signal value.

Decrease—Move the crosshead or actuator in a direction that will decrease the
control-mode feedback signal value.

Auto—The application will use the “Effect of Increasing Extension” resource settings
to determine which direction the crosshead or actuator must travel to reach the
specified end condition.

Note: TheAuto setting will not work with resources that have the “Effect of
Increasing Extension” setting set to Indefinite.

Go To Properties
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Item Description

Rate Enter the rate at which the crosshead or actuator will move. To toggle between
entering an specific value and an input, click or .

End
condition

Select theEnd condition check box if you want to define limits that will end this
activity.

Signal—Select the signal to monitor for the ending condition.

Comparison—Select an absolute or relative comparison, between the actual signal
value and the value entered below, that will end the activity.

Note:When theDirection setting is set toAuto, the Crosses comparison
setting becomes available. WhenCrosses is selected, the activity endswhen
the actual signal equals the set value.

Value—Enter the signal value used by the comparison setting. To toggle between
entering an specific value and an input, click or .

Brake
distance

Control-mode braking slows the command to help avoid overshoot. The brake
distance value is subtracted from the ending condition value to determine where
control-mode braking starts. To toggle between entering an specific value and an
input, click or .

For example, if the ending condition value is 100 N and the brake distance is set to 10
N, at 90 N, the commandwill slow down to 10% of the rate setting and at 99 N, it will
slow down to 1% of the rate setting.

Note: This option is not available when the control mode is crosshead or
extension.

Example: Suppose you want to create aGo To + DAQ + Detection activity that moves in a
direction that causes the signal feedback to become greater than 5mm.

First, you need to set up the command signal. UnderControl mode, you selectCrosshead. Under
Direction, you select Increase. UnderRate, you select the Test Rate input because you want the
crosshead tomove at the default test rate.

Next, you need to set up the end condition. To enable an end condition, you select theEnd

condition check box. Then, under Signal, you click , select theCrosshead signal, and click
OK. Since you want the crosshead to stopmoving when it reaches 5mm, you selectBecomes
Greater Than underComparison. Finally, under Value, you enter 5 mm.

When the activity executes during the test run, the crosshead will increase at the test rate and stop
moving when the crosshead signal becomes greater than 5mm.
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Specifying Break Detection Parameters
Use the options on theBreak Detection panel of theDwell + DAQ + Detection andGo To + DAQ
+ Detection activities tomonitor signals for the occurrence failure events (peak or valley values), and
determine whether the failure eventsmeet the criteria for specimen failure.

When a break is detected in aDwell + DAQ + Detection activity or aGo To + DAQ + Detection
activity, any subsequent activities in theProcedure node of the test definition tree will not be
performed. Instead, the next node in the test definition tree (Return to Zero) is executed.When the
Review tab is shown, the Test Run End Reason columnwill beBreak Detected.

The following properties are available when configuring the options under theBreak Detection panel
of theDwell + DAQ + Detection andGo To + DAQ + Detection activities.

Item Description

Enable Enables the process. (Clear this box to disable the process.)

Display
Name

Specifies the process name displayed on the Procedure or Group processwindow. If
left blank, the software will automatically generate a name based on the selected
signal(s).

Description Enter an optional description to document the procedure design.

Progress
Table
Visibility

Indicateswhether the activity will have a listing in the Progress Table. The Progress
Table is a control that can be placed on the Test-Run Display.

Options are:

l Fixed—The activity will have a listing in the Progress Table that showswhile
the test is executing and persists after the test is complete.

l Transient—The activity will have a listing in the Progress Table only while
the program is executing.

l Never—The activity will not have a listing in the Progress Table.

Completion This control is only pertinent if more than one signal is listed in the Signals list or if the
machine hasmultiple heads (an available option for someCriterionmachines).

Options are:

l All Breaks—The activity completeswhen all signal breaks have been
detected.

l Any Break—The activity completeswhen any one signal break is detected.

Break Detection Properties
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Item Description

Signals Click to open the Add Signals window. In this window, select the signal(s) you wish
tomonitor for a break.

Percent
Change

Specify the percentage of themonitored signal’s referenced value (Peak or Valley)
that represents a specimen failure.

Threshold Select the threshold that the signal must exceed before the activity beginsmonitoring
for breaks.

Example: Suppose you want to detect a break in either yourDwell + DAQ + Detection orGo To
+ DAQ + Detection activity whenever the load signal changes by at least 5%.

In thePercent change box, you enter 5 and set the units to%. Since you do not want the break to
be detected for changes under 20 N, you set the Threshold to 20 N.

Performing Data Acquisition
Use theDAQ panel to customize how data acquisition is performed in both theDwell + DAQ +
Detection andGo To + DAQ + Detection activities. You can customize how data is acquired and the
sample rate that is used to acquire data.

Triggering Data Acquisition
You can trigger data acquisition to occur in one of two ways:

l Timed data acquisition records the values of selected signals at a frequency you define
(sample rate) for a specified duration. This type of data acquisition is useful if you want to
collect data on certain intervals regardless of the feedback received by signals.

Timed DAQ Triggering

l Delta Level data acquisition places the selected signal values in the buffer when the
reference signal changes by a delta value that you define.
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 Delta Level Triggering Example

When a value outside of the delta value is detected, the trigger establishes a new reference
level andmonitors the reference signal for another delta value change from that reference
level.

This type of trigger is useful when the reference signal sometimes changes quickly, and at
other times changes very little. It storesmore data when the signal is changing and lesswhen
it is not changing. If you were to perform timed data acquisition on a very long test run, you
would acquire a large amount of data during the portion of the test run that is not important to
you. However, when using delta level data acquisition, you only acquire data when signal
values start to change by a delta level that you specify.

Configure Timed Data Acquisition
To configure timed data acquisition:

1. SelectAcquire data. If you leave this option unselected, data will not be acquired during the
Dwell + DAQ + Detection orGo To + DAQ + Detection activity.

2. InHow would you like to acquire data?, select Timed.



Test Activities

250 MTS TestSuite™ TWEssential User Guide

3. InSample rate, specify the frequency at which data is acquired. For example, with a sample
rate of 1 Hz, the buffer acquires data points once each second. The sample ratemust be a
sub-multiple of the system rate:

l If you are connected to a controller, the sample rate that you enter is automatically
adjusted to be the closest multiple of the system rate.

l If you are not connected to a controller, you can enter any value; however, when you
do connect to a controller, the application checks the system rate and automatically
adjusts the sample rate to the closest multiple of the system rate.

To toggle between entering an specific value and an input, click or .

Configure Delta Level Data Acquisition
To configure delta level data acquisition:

1. SelectAcquire data. If you leave this option disabled, data will not be acquired during the
Dwell + DAQ + Detection orGo To + DAQ + Detection activity.

2. InHow would you like to acquire data?, selectDelta Level.
3. InSignal, select the signal that will bemonitored for triggering the delta level data acquisition.
4. InDelta value, specify the amount of change that must occur in theSignal before data values

are collected on the selected signals. To toggle between entering an specific value and an
input, click or .

Custom Message Window Activity Overview
TheCustom Message Window activity showsmessages to an operator and records the response
from an operator. This activity is used to alert the operator to perform certain tasks, such as insert or
remove a specimen or remove an extensometer. It can also be used to notify the user that the test is
about to begin or end.

For detailed information about editing themessage using theMessage panel, see “Editing Custom
Messages” on page 250. For detailed information about creating custom buttons using theButtons
panel, see “Editing CustomMessageWindow Buttons” on page 251.

User Input
TheCustomMessage window captures the name of the button you use to acknowledge themessage
window and assigns it to a specified input. You can later use this input in subsequent activities, such as
If-Else Condition activity.

Editing Custom Messages
To edit a message, clickEdit message to show the CustomMessage Editor window.

Themessage window is a basic HTML text editor. You can enter text, images, and hypertext links as
well as specify the text size and color, font family, and background color of themessage. Use the
Preview button to preview themessage appearance. You can import the entire contents of a valid
HTML file aswell as cut, copy, and paste content using the operating system clipboard.



Test Activities

MTS TestSuite™ TWEssential User Guide 251

Note: The editor does not support dynamic content or images stored on a web server. It also
does not support scripting extensions, such as JavaScript. If you import or paste content with
unsupported content, it generates error messageswhen you try to preview themessage.

Variables in Messages
To show the value of test variables in amessage, click Insert Variable located in the Custom
Message Editor. Alternatively, you can reference the variable directly using the following syntax:

For a single-value, enter $var_<variable_name>$

Note: If you change the variable identifier name, youmust manually change the name in the
CustomMessage Editor; otherwise, you will not be able to run the test due to a validation error.

Resizing Custom Message Windows
Use theWindow size panel to customize the size of the custommessage in pixels. You can either
enter a specificHeight andWidth dimension, or you can click the up or down arrows next to the field
to increase or decrease the window size.

Editing Custom Message Window Buttons
Use theButtons panel to add, remove, and customize the buttons that are shown on the custom
message window.

By default, themessage window includes theClose button. Custom button options includeYes,No,
OK, andCancel in several combinations. You can also set up the CustomMessage window to have
no buttonswith theNo Buttons option.

Create one or more custom buttonswith values that you specify either manually or in a predefined
choice list.

The following properties are available when configuring the options on theButtons panel:

Item Description

Buttons Custom button options includeNo Buttons, Yes,No,OK, andCancel in several
combinations. You can also create one or more custom buttonswith labels that you
specify.

ClickNo Buttons to control the CustomMessage window with a parallel activity.
When the controlling activity completes, the CustomMessage window closes.

ClickCustomize to add, modify, and delete custom buttons to the custommessage
window.When you selectCustomize, the area expandswith more options to create
custom buttons, which are described below.

Button
Alignment

Place the buttons on the lower left, center, or right part of themessage window.

Results Select a input from the list to store the text value of the button that you click. Click the list

Buttons Panel Properties
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Item Description

input arrow to see the list of all project inputs defined to hold a string value.

Note: If you choose a input with a choice list, any existing buttons are replaced
with the buttons defined by the choice list.

Add Add a new button to themessage window.

Edit Edit the selected button label. The Edit Button window has two boxes. Enter the return
value for the button in the value field. The value can be a text string or the name of a
string variable that you have previously defined. Enter the text for the button label in the
text box.

Remove Remove the selected button.

Remove
All

Remove all custom buttons.

Add
Separator

Add a separator line between groups of buttons. The buttons align vertically with a
separator between each group.

Up Arrow Move the selected entry toward the top of the list. The entry at the top of the list appears
as the left-most button in themessage window. ClickPreview to see the current button
arrangement.

Down
Arrow

Move the selected entry toward the bottom of the list. The entry at the bottom of the list
appears as the right-most button in themessage window. ClickPreview to see the
current button arrangement.

Auto Offset Activity Overview
Use theAuto Offset activity to apply an automatic offset for a group of selected feedback signals.

For detailed information about configuring the options on theAuto offset panel, see “Applying or
Removing an Automatic Offset” on page 252.

Feedback Offset
Feedback offset alters the feedback signal used by the controller to zero the conditioner output.
External factors such as specimen size, test component forces, and cable length can affect calibrated
sensor outputs. To compensate for these static external factors, you can add an offset to the feedback
signal. Feedback offset alters the feedback signal used by the controller without shifting the conditioner
zero reference. Feedback offset is included in control loop calculations.

Applying or Removing an Automatic Offset
Use theAuto offset panel to customize the signals to which the auto offset is applied. Additionally,
you can specify how the application handles any errors that are encountered during the auto offset.
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Apply New Offset or Remove Existing Offset
The options underDo you want to apply a new offset or remove an existing offset allow you to
select one of the following behaviors for theAuto offset activity:

l Apply offset to zero signals—Select this option to automatically adjust the signal to zero
based on the current signal feedback reading. For example, if you have heavy fixtures
installed on your system, the feedback signal will report a load that is equivalent to the weight
of the fixture. If you select this option, an offset will be automatically applied so that the load
feedback becomes zero with the installed fixtures.

l Remove offset from signals—Instead of applying an auto offset, select this option to clear
any offsets that were previously-applied.

Signals
Specifies the signals to which you want to apply the auto offset. Click to open the Add Signals
window. Click to remove the selected signal.

Note: Applying an offset to an active control mode will generate an error. Depending on the
Error Handlingmethod you select, the process can stop or continue by skipping the control
mode.

Error Handling
Specifies how the processwill respond to an error:

l Continue test and log error

l Stop test and log error

Example: Suppose that you are running a test that requires a heavy grip fixture attached to the
crosshead or actuator.

To compensate for the fixturing, you add anAuto offset activity to the test procedure prior to any
GoTo orDwell activities in the test. In the activity properties, you selectApply offset to zero
signals, and then add the load signal to theSignals table. Since you do not want to stop the test if
an error occurs, you selectContinue test and log error under Error handling. By doing this, you
ensure that theGoTo orDwell activities start from a zeroed load signal.

End Test Activity Overview
Use theEnd Test activity to force the test run to end before completing all stages of the test run.When
the test procedure reaches theEnd Test activity, workflow activities that follow and are parallel to the
End Test activity do not execute, and the procedure immediately proceeds to the end of the test. A
message is written to the test run log indicating that the test run was stopped due to theEnd Test
activity.
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If-Else Condition Activity Overview
The If-Else Condition activity creates two possible paths for a test procedure based on a conditional
expression that evaluates to True or False. If the expression evaluates to True, the test procedure
follows the True path. If the expression evaluates to False, the test procedure follows the False path.

The evaluated condition can be the result of a response from the operator, or it can be an evaluation of
a specific test value or condition.

Note: TheConditionmust evaluate to True or False or else a validation error will appear. Use
logical operators such as “==”, rather than assignment operators such as “=”. The Calculation
Editor provides a list of available variables, operators, and functions.

The two possible paths for the procedure to follow are automatically created when you add the If-Else
Condition activity to the test procedure. Each path can contain zero or more activities, including If-
Then Condition and other activities.

For detailed information about editing if-else conditional expressions on the If-Else Condition panel,
see “Specifying an If-Else Condition” on page 254.

Specifying an If-Else Condition
To specify the conditional expression that evaluates to True or False, click (next to theCondition
field) to open the Calculation Editor. To add activities to either the True or False paths, simply drag
and drop the activity into the desired path from the Toolbox, which is located on the left side of the
Procedure Editor.To specify which path is followed when the expression evaluates is true, select the
path in the If true, follow list.

External Device Activity Overview
TheExternal Device activity is a program action used to execute one of the commands defined for an
external device. These commands can be an output that controls the device or an input that reads data
from a device.

For example:

l An output command can set a furnace to a specific temperature.

l An input command can read data from a laser extensometer.

Note:
The external device controlled by this activitymust first be created and configured using
the External Deviceswindow (available from theControllermenu).

Set up an External Device
To set up anExternal Device activity:

1. Prerequisites—before you can configure theExternal Device activity, youmust perform
these steps:



Test Activities

MTS TestSuite™ TWEssential User Guide 255

A. Use the External Deviceswindow (available from theControllermenu) to add and
configure external devices and their commands.

B. Add the External Device resource to your test.

On theResources node of the test definition tree, clickAdd Resource and click
External Device.

C. (Optional) Create the inputs to use with this activity.

Note: For more information about setting up and configuring external devices,
see “External Devices” on page 93.

2. Add the External Device activity to your test.
3. Define the properties for theExternal Device activity.

For detailed information about configuring theExternal Device activity, see “Configuring External
Devices” on page 255.

Configuring External Devices
The following properties are available when configuring the options under theExternal device panel
of theExternal Device activity.

Item Description

Device Select the external device that you want this activity to control.

Command Select the external device command that this activity will execute. All commands
defined in the External Device window are listed.

Command
Variable
(optional)

Select the input that defines the command value that is written to the device. The list
below only appears if theCommand box for one or more commands in the External
Deviceswindow contains the following characters: {0}, {1}, and so on.

Result
input

(optional)

Select the input where value returned by the device is written. This list only appears if
one or more command settings in the External Deviceswindow has theSupports
Return Value check box selected.

Error
handling

Select an error handling option:

l Continue test and log error

l Stop test and log error

External Device Properties
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Navigating the Review and Test-run Charts
The following two charts are available on the test definition tree:

l Test-run chart—Edit the properties of this chart to configure the display that appears while a
test run is in progress.

l Review > Chart—Edit the properties of this chart to configure the display that appears on the
Review tab after a test run is finished.

The options available for each of these charts are grouped under four icons. Click the links below for
more information about each of the panels available for the charts.

Axis Properties

The following panels are available when you click the button:

l “Configuring the X Axis” on page 259

l “Configuring the Y Axis” on page 260

Test Run Properties

The following panels are available when you click the button:

l “Plotting Previous Test Runs” on page 262

l “Editing Limit or Curve Fit Lines” on page 262

Note: Limit or Curve Fit Line functionality is only available on theReview > Chart node
of the test definition tree.

Chart Navigation Properties

The following panels are available when you click the button:

l “Zooming to Region of a Chart” on page 263

Note: Zoom to region functionality is only available on theReview > Chart node of the
test definition tree.

l “Picking Points on a Chart” on page 264

Chart Color and Title Properties

The following panels are available when you click the button:

l “Customizing the Chart Title” on page 265

l “Customizing Chart Colors” on page 266



Using Charts

MTS TestSuite™ TWEssential User Guide 259

Configuring the X Axis
Access

Define tab > Test-run chart node > button > X Axis panel

Define tab > Review node > Chart node > button > X Axis panel

Overview
Use the options on theX Axis panel to determine what is shown on the X axis of the chart. By using
one of the several different X axis datameasurements available in conjunction with one or moreY
Axis datameasurements, you can easily present the data you acquired from your test run(s) visually.

Example: suppose you want to show a basic load versus extension chart. First, you would select
Extension under theData list on theX Axis panel. Then, in theData field under theY Axis panel,
you would click to add a Load signal. If necessary, you could even view more data
measurements in relation to the X axis by addingmore Y axes to the chart, such as Stress, Strain,
or Time.

For more information about configuring theY Axis options, see “Configuring the Y Axis” on page 260.

X Axis Properties
The following properties are available when configuring the options under theX Axis panel of the
Test-run chart andReview > Chart nodes in the test definition tree.

Item Description

Data Select the datameasurement that will be used for the X axis of the chart. The
options available here are based on the float signal resources that are available in
your test. These resources are listed under the Float Signals drop-down on the
Resources node of the test definition tree.

Units Select the units that will be displayed for the selected X axisDatameasurement.
For information about configuring unit sets, see “UnitsManagement” on page 75.

Minimum /
Maximum

Enter theMinimum andMaximum display range values of the X axis. The values
you enter here will determine the starting point on the left side of the X axis
(minimum) and end point on the right side of the X axis (maximum).

To toggle between entering an specific value and an input, click or .

X Axis Properties
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Item Description

Tip: By entering a lower minimum value and a higher maximum value, you
can effectively zoom out and see a larger amount of data on the chart.
Similarly, by narrowing the range between theminimumandmaximum, you
can effectively zoom into a specific area of the chart.

Automatically
Scale

Select this option to allow the chart to automatically expand so that it
accommodates data outside the display range you specified in theMinimum and
Maximum fields above.

If you disable this option, the chart will not expand to show data that exists outside
of the display range. Therefore, youmay not see all of the data that was acquired
during the test run.

Configuring the Y Axis
Access

Define tab > Test-run chart node > button > Y Axis panel

Define tab > Review node > Chart node > button > Y Axis panel

Overview
Use the options on theY Axis panel to determine what is shown on the Y axis of the chart. Unlike the
X axis, you can optionally addmore than one datameasurement to the Y axis of the chart. This can be
beneficial if you want to comparemultiple datameasurements (such asLoad, Strain, or Stress) in
relationship to an X axismeasurement, such asDisplacement or Time. For more information about
configuring the X Axis options, see “Configuring the X Axis” on page 259.

Y Axis Properties
The following properties are available when configuring the options under theY Axis panel of the
Test-run chart andReview > Chart nodes in the test definition tree.



Using Charts

MTS TestSuite™ TWEssential User Guide 261

Item Description

Data Click to open the Y Axis Data window. On this window, you can select one or
more datameasurements that will be used for the Y axis of the chart. To select a
category of input variables based on the dimension (Length, Stress, Force,
Strain, or Time), click the list underDimension. The available Y axis data
measurements are based on the float signal resources that are available in your
test. These resources are listed under the Float Signals list on theResources
node of the test definition tree.

Note: Theremust be at least one signal in theData list. If there is only one
signal, you will not be able to delete it. If you want to change the last signal,
click and select a different dimension or signals in the Y Axis Data
window.

When you are finishedmoving the desired datameasurements from theAvailable
section on the left side of the Y Axis Data window to theSelected section on the
right side, clickOK. The datameasurements appear under Data on theY Axis
panel.

Units Select the units that will be shown for the selected A axisDatameasurement. For
information about configuring unit sets, see “UnitsManagement” on page 75.

Minimum /
Maximum

Enter theMinimum andMaximum display range values of the selected Y axis
datameasurement. The values you enter here will determine the starting point on
the bottom of the Y axis (minimum) and the end point at the top of the Y axis
(maximum).

To toggle between entering an specific value and an input, click or .

Tip: By entering a lower minimum value and a higher maximum value, you
can effectively zoom out and see a larger amount of data on the chart.
Similarly, by narrowing the range between theminimumandmaximum, you
can effectively zoom into a specific area of the chart.

Automatically
Scale

Select this option to allow the chart to automatically expand so that it
accommodates data outside the display range you specified in theMinimum and
Maximum fields above.

If you disable this option, the chart will only show chart data that exists inside the
Minimum andMaximum axis display range. It will not expand to fit data outside of
this range, so youmay not see all of the chart data.

Y Axis Properties
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Plotting Previous Test Runs
Access

Define tab > Test-run chart node > button > Previous test runs panel

Define tab > Review node > Chart node > button > Previous test runs panel

Overview
Use the options on thePrevious test runs panel to plot one or more test runs that have already been
completed.

When you plot previous test runs on the test-run chart, you can compare the real-time results of your
current test run with the results from previous test runs. By plotting previous test runs on theReview
tab chart, you can easily compare the results of multiple test runs on a single chart, whichmay help you
analyze the results easier.

On the Test-run chart node, you can specify that the results of the first test run (select First test run)
and up to 20 previous test runs (select Last test run(s) and select number) display on the same chart.
To displace themultiple traces, modify the Y-Offset and X-Offset values.

Editing Limit or Curve Fit Lines
Access

Define tab > Review node > Chart node > button > Limit or curve fit lines panel

Overview
Use the options on the Limit or curve fit lines panel to add or edit a limit or curve fit lines.

Limit or Curve Fit Lines Properties
The following properties are available when configuring the options under the Limit or curve fit lines
panel of theReview > Chart nodes in the test definition tree.
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Item Description

Limit type Select one of the following limit types.

l Horizontal

l Vertical

l Slope Intercept, m∙x + b

l General XY (Single Value or Array)

l Indexed Values

l Horizontal at Index

l Vertical at Index

Y
Variable

Select a single value variable or an array variable for which you want data plotted on the
Y axis of the chart.

X
Variable

Select a single value variable or an array variable for which you want data plotted on the
X axis of the chart.

Legend
label

Select this option to add a custom legend label to the chart. In the text box, enter the
name of the legend label.

Limit or Curve Fit Lines Properties

Zooming to Region of a Chart
Access

Define tab > Review node > Chart node > button > Zoom to region panel

Overview
Use the options on the Zoom to region panel to configure regions of the chart that you can easily
zoom into when analyzing the chart on theReview tab. In other words, this feature allows you to set up
shortcuts to important places on your chart.

After you add a region, you can easily zoom to the region by right-clicking the chart on theReview tab,
hovering over Zoom to Region, and selecting the region.

Add a New Region
To add a new region:

1. On the table in the Zoom to region panel, click . The Zoom to Region window appears.

2. Enter aDisplay name for the new region. This display namewill appear when you right-click
the chart on theReview tab and hover over Zoom to Region.
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3. In thePoints After andPoints After fields, enter the number of data points (between 1 and
5) before and after the Indexes that you want to zoom into when selecting the region. For
example, if you enter 5 for both of these fields, the region will contain the index and 5 data
points on each side of the index.

4. In the Indexes table, click .

5. In the window that appears, use the arrow buttons tomove the desired indexes from the
Available column to theSelected column.

6. ClickOK to close the Variables Selection window.

7. ClickOK to close the Zoom to Region window.

Edit an Existing Region
To edit an existing region:

1. On the table in the Zoom to region panel, click . The Zoom to Region window appears.

2. Edit thePoints After, Points Before, and Indexes settings as desired. For more information
about these properties, see “Add a New Region” on page 263.

3. ClickOK to close the Zoom to Region window.

Delete a Region
To delete a region:

1. On the table in the Zoom to Region panel, select the region you want to delete.
2. Click .

Picking Points on a Chart
Access

Define tab > Test-run chart node > button > Point pick panel

Define tab > Review node > Chart node > button > Point pick panel

Overview
Use the options on thePoint pick panel to customize point picking options. You can usePoint pick to
select traces in the scope and view the delta and slope of the line drawn through those two points.

Point pick Properties
The following properties are available when configuring the options under thePoint pick panel on the
Test-run chart andReview > Chart nodes in the test definition tree.
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Item Description

Show highlight
circle

Select to show a crosshair, circle, and data point value when selecting a data
point in the chart.

Show delta and
slope Labels

Select to show the values of two points, the difference between their values, and
the slope of a line drawn through the two points.

Number of rows
of values and
slope

Enter the number of rows used to arrange the labels, delta, and slope. Click the
up arrow or down arrow to increase or decrease the number of rows. The value
range is 1 - 6.

Point Pick Properties

Customizing the Chart Title
Access

Define tab > Test-run chart node > button > Chart title panel

Define tab > Review node > Chart node > button > Chart title panel

Overview
Use the options on theChart title panel to customize the title that appears on the chart.

l The title that you set on the Test-run chart node is the title of the chart on theMonitor tab
(shownwhile the test run is in progress).

l The title that you set on theReview node also appears as the chart title on theReview tab,
which is shown after the test run is complete. Additionally, this is the title of the chart if you
generate a report that contains the test run’s chart.

Chart Title Properties
The following properties are available when configuring the options under theChart title panel on the
Test-run chart andReview > Graph nodes in the test definition tree.
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Item Description

Title Enter the title of the chart. For example, if the chart is a load versus extension chart, the
title “Load versus Extension” may be appropriate.

If the title field is gray and you cannot enter a title, de-select theAutofill title checkbox
(see below).

Autofill
title

Select this check box and the application will automatically populate the chart title based on
the X and Y axes. For example, if you create a chart with Extension as the X axis and
Stress as the Y axis, the chart title will automatically becomeStress versus Extension.

Clear this check box if you want to enter a custom chart title.

Font
size

Enter a font size for the title of the chart.

Chart Title Properties

Customizing Chart Colors
Access

Define tab > Test-run chart node > button > Chart color panel

Define tab > Review node > Chart node > button > Chart color panel

Overview
Use the options on theChart color panel to customize the color of the chart title. For information
about customizing the chart title, see “Customizing the Chart Title” on page 265.

Chart Color Properties
The following properties are available when configuring the options under theChart color panel on
the Test-run chart andReview > Chart nodes in the test definition tree.
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Item Description

Foreground Select the foreground color of the chart. This color is used to draw the chart title,
legend, and border of the chart.

Background Select the overall background color of the chart.

Tip:When selecting a background color for the chart that appears on the
Review tab, keep inmind that the background color you select here will also
appear if you print reports that contain the chart. For example, if you select a
very dark color, muchmore ink will be used to print the chart.

Chart Color Properties
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Crosshead Controls Panel for Electromechanical and
Static Hydraulic Test Systems
The controls described in this section are only available with MTS Criterion andMTS Insight systems.

Crosshead Controls Panel
TheCrosshead Controls provide buttons that allow you tomove and position the crosshead: up and
down (Jog) buttons, a Return button that moves the crosshead to the Crosshead Return position, and
aGo To button that allows you to specify a position and thenmove the crosshead to that position.

Crosshead Controls Panel

Number Control Description

1 Direction Indicates the direction of crossheadmovement.

2 Clutch
indicator
(not
shown)

This only applies to electromechanical systems that have a clutch;
servohydraulic and static hydraulic systems do not have a clutch. This
indicator shows the clutch that your frame/machine is currently using. If the
indicator points up, themachine is in high clutch. If the indicator points down,
themachine is in low clutch. If your system has a clutch and the indicator is
not visible, openMTS TestSuite Insight Diagnostics, and in the Select
Controller pane, select anMTS Insight Renew frame, and select the
checkbox to indicate a clutch is being used.

3 Down Jog
button

Click tomove the crosshead downward. To configure the Jog Mode and
Ramp Rate, click the down arrow in the lower right corner of theCrosshead
Controls area.

Crosshead Controls
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Number Control Description

4 Up Jog
button

Click tomove the crosshead upward. To configure the Jog Mode andRamp
Rate, click the down arrow in the lower right corner of theCrosshead
Controls area.

5 Move the
crosshead
to the
return
position

Click tomove the crosshead to the Return to Zero position.

6 Move the
crosshead
to a
specified
position

Click to specify a position and thenmove the crosshead to that position

Note: The crosshead can also be controlled with a handset. For more information on using a
handset, see the product manual that camewith your system.When control is provided by a
handset, the crosshead controls will be locked and overlaid by the handset exclusive control
icon:

Mechanical Crosshead Limits
There aremechanical crosshead limit switches located above and below the crosshead of your
machine. The crosshead stopsmoving when it encounters amechanical limit. Adjust these limit
switches so that theywill stop the crosshead before it damages the grips and other fixtures.

For more information
For detailed instructions on how to set themechanical crosshead limit switches, see the Product
Manual provided with your system.

Caution:
Unintended force can be applied to amounted specimen, grips and fixtures, or other objects in
the crosshead path.

Unintended force can injure anyone in its path and damage amounted specimen, grips and
fixtures, or other objects in the crosshead path.

Before youmove the crosshead, make sure that themechanical crosshead limits are set to help
prevent the crosshead from damaging grips and fixturing andmake sure to clear the crosshead
area to help prevent personal injury.

Set the Zero Crosshead Position
To display and configure the Crossheadmeter:
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1. Display the Crossheadmeter if it is not already visible. To display the Crossheadmeter, click
theMeter tab on the bottom of the window. Right-click on ameter, selectAdd Meter, and
clickCrosshead.

2. Click the Jog buttons tomove the crosshead to the position that you want to establish as zero.

3. Right-click on the Crossheadmeter and on the pop-up window, clickZero signal. To remove
this offset, clickClear zero.

Crosshead Meter Zero Signal

Move the Crosshead Up and Down

Caution:
Unintended force can be applied to amounted specimen, grips and fixtures, or other objects in
the crosshead path.

Unintended force can injure anyone in its path and damage amounted specimen, grips and
fixtures, or other objects in the crosshead path.

Before youmove the crosshead, make sure that themechanical crosshead limits are set to help
prevent the crosshead from damaging grips and fixturing andmake sure to clear the crosshead
area to help prevent personal injury.

1. Display the Extensionmeter to provide a real-time indication of the crosshead position.

2. Use themouse to click and hold the Up or Down button tomove the crosshead up or down.

Keep themouse button depressed for as long as you want the crosshead tomove.

3. When the crosshead reaches the desired position, release themouse button to stop the
crosshead.
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Move the Crosshead to the Return Position
The crosshead return position is the position the crossheadmoves to when you click theMove
Crosshead to Return Position button. This position is typically set to a position that allows you to attach
a specimen.

Note: Only anMTS FSE can adjust the ramp rate for the Crosshead Return to Zero with the
MTS Insight/Criterion (electromechanical) controller. Contact your MTS service representative
for assistance.

Caution:
Unintended force can be applied to amounted specimen, grips and fixtures, or other objects in
the crosshead path.

Unintended force can injure anyone in its path and damage amounted specimen, grips and
fixtures, or other objects in the crosshead path.

Before youmove the crosshead, make sure that themechanical crosshead limits are set to help
prevent the crosshead from damaging grips and fixturing andmake sure to clear the crosshead
area to help prevent personal injury.

1. Set themechanical crosshead limit switches to help prevent the crosshead from damaging the
grips and fixtures.

2. Click theMove Crosshead to Return Position button tomove the crosshead to the Return
position.

Move the Crosshead to a Specified Position
Follow these steps tomove the crosshead to a specific position. For example, if the crossheadmeter
reads 6 inches, and you specify 3 inches as theGo To position, the crossheadmoves down until the
meter reads 3 inches.

Caution:
Unintended force can be applied to amounted specimen, grips and fixtures, or other objects in
the crosshead path.

Unintended force can injure anyone in its path and damage amounted specimen, grips and
fixtures, or other objects in the crosshead path.

Before youmove the crosshead, make sure that themechanical crosshead limits are set to help
prevent the crosshead from damaging grips and fixturing andmake sure to clear the crosshead
area to help prevent personal injury.

1. Set themechanical crosshead limit switches to help prevent the crosshead from damaging the
grips and fixtures.
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2. Click theMove crosshead to the specified position button to display the Go Towindow.

Move Crosshead Go To Window

3. In the Go Towindow, select the appropriate units and type the desired crosshead position.
ClickOK to move the crosshead to the specified position.

The Crossheadmeter updates as the Crossheadmoves to the specified position. The
Direction arrow flashes and indicates the current direction the crosshead ismoving, and the
Move crosshead button flashes until the crosshead reaches its specified target.

4. When the crosshead reaches its destination, amessage indicates the specified target has
been reached. ClickOK.

Status Panel
Note: The following information only pertains toMTS Criterion andMTS Insight.

The Status portion of the control panel indicates the status of various fault indicators, such asUpper
and Lower limits and the Enclosure Open switch. A red light indicates a fault indicator has been tripped
andmust be reset. Hover your cursor over the red light in the Status panel and amessage will appear
that states which fault indicator has been tripped. To open the Statuswindow and see a list of all fault
indicators, click the OpenWindow icon on the Status panel.
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Fault Status Indicator Window
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Review Tab Features
TheReview tab shows the results of test runs and provides features that allow you to display and
analyze data. The amount of data collected for each test run is determined by theDAQ (data
acquisition) activities included in your test.

Note: Use theDefine > Review node of the test definition tree to configure which parameters
(inputs) appear on the Results table of theReview tab when test runs are complete. For more
information about configuring these parameters, see “Configuring the Results Table” on page
155.

Views and layout features
TheReview tab has a number of features that define how data appears in theReview tab:

l Set the number of display panels that appear in theReview tab.

l Add views (charts and tables) to display panels.

l Customize the appearance of charts and tables.

l Select the test run data that appears in charts and tables.

l Create and save displays (settings of the panels and associated views) that you can select.

Data analysis and report features
The review tab includes features that allow you to change variable values used to run tests and
recalculate the results. These features can be used to correct incorrect operator entries (for example,
specimen dimensions) or to create what-if scenarios in R&D applications.

l Select the statistics calculations that are applied to the test.

l Change variable values to recalculate statistics.

l Change chart markers to recalculate statistics.

l Tag test runs (manually or by using the Autotag feature) to remove specific test runs from the
test statistics calculations.

l Manually generate test run and test reports.

l Copy data or chart images to the clipboard for use in other applications.

l Enter post-test variables to complete test analysis.

Review Tab Layout
TheReview tab displays after a test run ends showing test run statistics, charts, and so on.
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Review Tab Layout

Number Item Description

1 Toolbar Provides icons that allow you skip to the activities in the Finish section of the
test, revert and recalculate variables, generate and print reports, and
configure and save the layout of the Review tab.

2 Test run
results
table

Shows test results from individual test runs, allows you to compare one test
run to another, and allows you to exclude (referred to as tagging) individual
test runs from statistical computations.

Each test run row in the Results table includes a Compare check box that
controls which test run data appears in the charts and tables.

3 Test run
information
table

Shows information about each test run, such aswhat test run information is
available in the charts and tables on the Review tab, what test run data is
included in calculations, and additional comments for each test run (if
available).

Review Tab Description
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Number Item Description

4 Test
statistics
table

The statistics table shows statistical data compiled from all of the test runs
that are not tagged (excluded). The statistics calculations are user-defined
by right-clicking the statistics area and clickingConfigure Statistics.

5 Graph The graph shows a graphical representation of test run or test results. You
can add, remove, and edit markers on the graph.

Views
A view is chart or table that you can place in a panel on the Review tab. A panel can contain multiple
views but only one view can be active (visible) at a time. The following views are available (the cycle-
based views are not shown in the drop-down list if the test does not contain cycle data):

Variable Table Table that shows non-array-variables (in a single active test-run) and their
properties. For more information, see “Variable Table” on page 283.

Variable Table for
Multiple Runs

Table that shows data from two or more analysis runs selected as an analysis
set. This table is activated, along with theVariable-Column Table for
Multiple Runs, when an analysis set is created.

Array-Variable
Table

Table that shows array-variables (in a single active test-run) and their
properties. For more information, see “Array-Variable Table” on page 286.

Fixed-Column
Boundary Table

Table that shows the value and other properties for each cycle (or boundary)
of each non-array-variable in a single active test-run.

Data Acquisition
Variable Table

Table that shows values for each cycle (or boundary) and each array index of
each non-array-variable in a single active test-run.

Variable-Column
Boundary Table
for Multiple Runs

Table that shows values for each cycle (or boundary) of each variable in the
multiple selected test runs. This table is activated, along with theVariable
Table for Multiple Runs, when an analysis set is created.

Array-Variable
Marker Chart for
Multiple Runs

Chart that shows array-variable values versus the array index or another
array-variable with optional markers.

Description of Views
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History Marker
Chart for Multiple
Runs

Chart that shows values of variables versus the cycles (or boundaries) with
optional markers.

Cycle Marker
Chart for Multiple
Runs

Chart that shows array-variable values versus the array index or another
array-variable at specific cycles (or boundaries) with optional markers.

Cycle Time
Marker Chart for
Multiple Runs

Chart that shows array-variable values versus a time array-variable (where
the time values are shifted so the first index is at zero to allow overlaying data)
at specific cycles (or boundaries) with optional markers.

Add a View to a Panel
To add a view to a panel:

1. Right-click on a panel.

2. On theViewsmenu, clickAdd View.
3. Select a view type from the pop-upmenu.

Switch Views Within a Panel
To switch viewswithin a panel:

1. Right-click on a panel.

2. On theViewsmenu, clickSwitch toView.
3. Select the view that you want to display.

Select Test Runs to Appear in Charts and Tables

Active test run
The active test run in the results table will appear in each chart and table. The active test run is
indicated by a black triangle in the left column of the results table.

Compare check boxes
The results table includes aCompare check box for each test run. These check boxes determine if the
data for a test run appears in a chart or table view. If multiple Compare check boxes are selected, a
Test Run drop-down list appears at the top of each table.

Right-click options
You can right-click on the results table for other test run selection options.

Delete View
To use the DisplayManager window to delete a view:

Important: You cannot delete active (visible) displays. Any view that you delete will not appear
in any display that included that view.



Reviewing and Analyzing Test Results

282 MTS TestSuite™ TWEssential User Guide

1. Make sure that the view that you want to delete is not visible.

2. On theActions drop-down list, clickDisplay and then clickOpen Display Manager.
3. In theView list, select the view you want to delete and clickDelete.

View Test-Run Data in Chart and Table Views
As each test run is completed, it becomes the active test run in the Results table and its data is shown
in the various charts and tables.

Tomake additional test run data available to view, use theCompare check boxes that appear next to
each test run in the Results table.

l If none of theCompare check boxes are selected, the active test run determines the test run
for which data is shown in each table and chart.

l If more than oneCompare check box is selected, the data for each test run is displayed in all
charts.

l If theCompare check box for more than one test run is selected, a test-run list (containing all
test runs) appears at the top of each table. Use this list to select the test-run data that you want
to display in the table.

Note: If the view supportsmultiple test runs, the data for each test run is displayed in
the table or chart.

Copy and Paste Views from One Test to Another
If you create a custom view for a test (for example, a table that only includes certain columns presented
in a particular order), you can use the DisplayManager window to copy that view from the test and
paste it into another test.

1. Use the DisplayManager window to copy the view.

A. Open the test that contains the view that you want to copy.

B. Click theReview tab.

C. Click theActions drop-down arrow, hover overDisplay, and selectOpen Display
Manager.

D. In theViews column, select a view, right click and clickCopy.
E. Close the DisplayManager window and close the test.

2. Open another test and paste the view into the DisplayManager window’sView column.

A. Open the test to which you want to add the copied view.

B. Click theReview tab.

C. Click theActions drop-down arrow, hover overDisplay, and selectOpen Display
Manager.

D. Right-click in theView column and clickPaste.
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Table Views

Add and Configure Table Views
To add and configure table views:

1. Add a table to the current display.

A. Right-click in the chart/table area and clickViews and thenAdd View.
B. Select the type of table that you want to add.

2. Customize the columns that appear in the table.

A. Click theColumn Chooser icon.
B. In the ColumnChooser window, select the check box for each column that you want

to appear in the table.

3. Optional - Rearrange the column order by clicking on a column heading and dragging it to the
desired location.

Note: Rearranging columns in the Statistics table is temporary. The next time you run
the test, the order will revert to the order that the test designer set in the application Set
VariablesOrder window.

Add Variables to Statistics and Results Table
Variables whose properties have theResults check box selected will appear as columns in the
Statistics table and as rows in the Results table.

1. Click the Test Definition tab.

2. Click theVariables tab.
3. Select the variable that you want to include in Statistics and Results tables.

4. In the Properties panel for the selected variable, select theResults check box.

Variable Table
The Variable Table shows the current value of the selected analysis run variables. The table supports
direct value overrides that can be used for error correction or “what if” speculation.

You can override values for data not measured from a signal directly in the Value column. However,
you cannot override and recalculate calculations, unless you type a number in the Value column. In
that case, the calculation is handled as an assigned constant value.
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Changesmade in the Variable Table are processed only in the current analysis run.

Variable Table

By default, the One Panel View is shown. If you click the Two Panel View button, the second panel for
the Variable Table is pre-configured to show the columns selected in the following figure, by default.

Default Columns for Variable Table

In these tables, You can filter the results that appear in any column. The funnel turns blue when filtering
is on; click the funnel to see a drop-down list of filtering options.
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Column Filtering

You can configure the columns to be shown for the variables and variable array values in the table by
clicking the ColumnChooser icon, as shown in the following figure.

Column Chooser Button

You can override values for data not measured from a signal directly in the Value column. However,
you cannot override and recalculate calculations, unless you type a number in the Value column. In
that case, the calculation is handled as an assigned constant value.
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Array-Variable Table
The Array-Variable table shows you the element values in one or more selected array variables. Click
theArray Variables button to open the Variables Selection window. Use the arrows tomove
Available Variables to theSelected Variables box and clickOK.

Variables Selection Window

l Right Arrow button—Click this button to add a variable that you have selected on the Available
Variables panel to the Selected Variables panel.

l Double Right Arrow button—Click this button to add all variables to the Selected Variables
panel.

l Left Arrow button—Click this button to delete a single variable from the Selected Variables
panel.

l Double Left Arrow button—Click this button to delete all the variables from the Selected
Variables panel.

The default left-hand column of the table is the Array Index. Subsequent columns contain the values of
the array variables.
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You can see the units for each selected array variable using theColumn Chooser button.

Variable-Column Boundary Table
The Variable-Column Boundary table shows the current values of the selected variables. The number
of possible table columns depends on the number of data-collection variables and types of indexes.
Each row contains data from one cycle or data group.

Variable Table for Multiple Runs
The Variable Table for Multiple Runs shows data from two or more analysis runs.

Values and calculations cannot be changed or recalculated in the table. Values that have been
previously changed in an analysis run are indicated by a checkmark in theModified column of the table
row.

The table columns available for the table are determined by the analysis definition. For display,
columns are removed or added using the ColumnChooser.

The number of rows for each analysis run is determined by the number of identifiers in the analysis run.
Rows can be grouped, sorted, and filtered for ease of comparison.

The Variable Table for Multiple Runs cannot be saved for future use.

Variable-Column Table for Multiple Runs
TheNew Variable-Column Table for Multiple Runs shows data from two or more analysis runs
selected as amulti-run analysis. The table is typically used for comparing the data of the analysis runs.
This table is activated with the Variable Table for Multiple Runswhen amulti-run analysis is created.

The table has one row for each analysis run. The table columns are determined by the analysis
definition. For display, table columns are added or removed using theColumn Chooser button.

The New Variable-Column Table for Multiple Runs cannot be saved for future use. However, data can
be printed and exported.
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Chart Views

Active Test Run
Charts can display data for multiple test runs but activities such as adding and removingmarkers,
movingmarkers, and adding text annotations are only applied to the active test run in the results table.
The active test run is indicated by a black triangle in the left column of the results table.

Add Text to a Chart
To add text to a chart, move text, or attach text to a different data point:

Add text

1. In the Results Table at the top of the Review window, select the test run that you want to
annotate with a text callout.

The black triangle on the left of the Results table indicates the active test-run selection.

2. Right click on the chart near the point of the curve where you want to attach a text box and
arrow and clickAdd Text.

3. Use the Edit window to define the text and line attributes.

The default text is the name of the test run that you selected (the active test run) in the Results
table.

Move text
Click and drag the text to reposition it on the chart.

Attach text to a different data point

1. Right-click on the text and clickAttach to different data point.
2. Move the cross hairs to a point on the curve where you want to attach the text and click.

When the cross hair is positioned on the test-run curve associated with the text, the color of
the cross hair circle will match the color of the box.

3. After the text is attached to the desired data point, right-click on the text box and deselect
(uncheck) theAttach to different data point option to hide the cross hair.

Add and Configure a Chart
To add and configure a chart:

1. Add a chart to the current display.

A. Right-click in the chart/table area and clickAdd View.
B. Select the type of chart that you want to add.

2. Right-click and clickConfigure Chart.

Note: For more information about configuring charts, see “Using Charts” on page 257.
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Array-Variable Marker Chart for Multiple Runs
The Array-VariableMarker Chart for Multiple Runs shows array-variable values versus the array index
of another array-variable. You can also add optional markers.

Array-Variable Marker Chart for Multiple Runs

To configure the chart, right-click on the chart and selectConfigure Chart.

History Marker Chart for Multiple Runs
TheHistoryMarker Chart for Multiple Runs allows you to addmarkers and lines to history charts.

Example History Marker Chart for Multiple Runs

Right-click on the chart and selectConfigure Chart.

Markers
Right-click on amarker to open Add or RemoveMarkers, Edit Marker, Edit Variable, andMove
SelectedMarker.
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Item Description

Add or
Remove
Markers

Opens the Variables Selection window where you can use the arrows to add or remove
variables. When you add a variable to the Selected Variables box, it appears on the
graph.

To remove amarker, right-click on themarker to be removed and selectAdd or Remove
Markers. In the Variables Selection window, move the variable to be removed from the
Selected Variables box to theAvailable Variables box. Themarker is removed from
the chart.

Edit
Marker

Select to change theDisplay Name andSymbol Color of themarker.

Edit
Variable

Select to open the Edit Variable window where you canmodify various aspects of the
selected variable.

Move
Selected
Marker

To reposition themarker, right-click on themarker to reposition and select theMove
Selected Marker. Move your cursor along the curve.When the cursor touches a data
point, an orange circle surrounds the point and shows the X and Y values. To set the
marker, click the curve at the data point. The orange circle changes to an orange diamond
shape. Right-click and selectMove Selected Marker to clear themove action. The
marker changes to a purple diamond shape.

Tomove themarker to the original location, right-click on themovedmarker and select
Reset Marker.

Marker Properties

Cycle Marker Chart for Multiple Runs
TheCycleMarker Chart for Multiple Runs on theReview tab panel, shows array-variable values
versus the array index or another array-variable at specific cycles (or boundaries). You can also add
optional markers.

To add the chart, right-click on the panel and selectViews > Add View. To configure the chart, right-
click on the chart and selectConfigure Chart.

Cycle Time Marker Chart for Multiple Runs
TheCycle TimeMarker Chart for Multiple Runs on theReview tab panel shows array-variable values
versus a time array-variable, where the time values are shifted so the first index is at zero to allow
overlaying date, at specific cycles (or boundaries). You can also add optional markers.

To add the chart, right-click on the panel and selectViews > Add View. To configure the chart, right-
click on the chart and selectConfigure Chart. The Configure Chart window opens.
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Analyze Test Results
Results Table
TheResults table shows the results of each test run and user-selected statistical calculations that
include all non-tagged test runs.

Test runs
Each test run appears as a row in the Results table.

Statistics
At the bottom of the results table are calculated statistical values (such asMean and Standard
Deviation) for the test. The types of statistics displayed and their order is user defined. Statistics
calculations include data from all the test runs that are not tagged (excluded) from the test.

Note: The list of available statistics calculations is hard coded and cannot be edited.

Results columns
Each variable whose Results properties check box is selected will appear as a column in the results
table. Once a column is added, the value calculated from the test runs appears and is included in any
statistical calculations.

Add and Configure Statistics Calculations in Results Table

1. Right-click the statistics portion of the results table and clickConfigure Statistics.
2. Use the Configure Statistics window to add or remove statistics calculations and change the

order in which they appear.

Add Columns to Results Table
To add columns to the results table:

1. Click the Test Definition tab.

2. Click theReview > Results table node of the test definition tree.
3. In the Results list, add the variables that you want to appear in the results table.

Change Test Variable Values for Post-Test Analysis
The procedures in the following section assume that you have added theVariable Table view to the
panels section on theReview tab. This table allows you to create what-if analysis scenarios by
changing test variable values and observing the test results.

Change Test Variable Values

Important: Only variables whose properties have theEditable Post-Test check box selected
can be changed in theReview tab.
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1. Click theReview tab.

2. On the Results table, select a test run.

A black arrow appears to the left of the selected test run.

3. In the Variables table, click in the Value cell of the variable that you want to change and type
the new value.

If necessary, right-click and add a Variable Table view to the display.

4. Click outside the cell to replace the current variable value with the new value.

l In the Results table, any statistical calculation that includes themodified variable
changes to reflect the new value. Any charts that are affected by the new value will
also reflect the changes.

l In the Variable Table, aReset button appears next to the changed variable in the
Reset Value column. Click this button to undo any changesmade to the variable.

l In the Variable Table for Multiple Runs, theModified column check box for the
variable that you just changed is selected.

5. Optional - Generate a report that shows the changes or use the Export Raw Data function to
analyze the data in another application.

Revert Changes to Test-Run Variable Values
TheReview tab provides a number of ways to revert changes that youmake to test run variable
values.

Reset Value column
When a variable value is changed in a variable table, aReset button for that variable appears in the
Reset Value Column.

Click theReset button to revert any changes to the variable.

Revert and Recalculate the Test Variables button
Click theRevert andRecalculate the Test Variables button to revert all variable changes (in all test
runs) and recalculate the statistics in the Results table.

Note: This button can also be used to apply changesmade to the Auto Tag rules.

Revert and Recalculate the Test-Run Variables button

1. Click on a test run to select it.

Note: In the Results table, the selected test run is indicated by a black arrow to the left
of the test run.

2. Click theRevert andRecalculate the Test Run Variables button to revert all variable
changes in the selected test run and recalculate the statistics in the Results table.
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Tag Test Runs
At the end of each test run, theReview tab displays to allow you to evaluate the data to ensure that the
test run is valid.

l Tagging a test run removes the test run results from the statistics calculations.

l The Autotag feature allows you to create rules that determine when a test run is automatically
tagged. The Autotag rules are applied as each test run is executed or can be defined and
applied post-test.

Exclude Test Run from Statistical Calculations
To exclude the data of a test run from statistics calculations:

1. Select the test run.

2. Select the Tagged check box for the selected test run.When tagged, the test run results are
removed from statistics calculations.

Configure Autotag Rules
To configure an autotag rule:

1. Right-click the Results table and clickConfigure Autotag Rules.
2. Use the Configure Autotag Ruleswindow to define rules that will result in a test run being

automatically tagged.

A. In theRule list, click + to add an autotag rule.
B. In theCalculation list, use the Calculation Editor to define rules that will result in a

test run being automatically tagged.

When the calculation is true for a particular test run, the test run is
automatically tagged.

C. In theError Message box, enter themessage that will appear on theReview tab
when youmove themouse over an autotagged test run.

D. When done, clickClose to apply the autotag rule. (You do not need tomanually
recalculate.)

Important: If you get unexpected results, it may be because the autotag rule uses system
variable units as opposed to project variable units. Make sure that your rule uses system units.
You can find the system units by looking on theVariables tab provided at the bottom of the
Configure Autotag Ruleswindow as shown in the following illustration.
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Example
Suppose you want to automatically exclude test runswith grip slippage. For this example, assume that
peak loads less than 1.8 kN indicate grip slippage. Setting up an autotag rule will automatically tag
those test runs so that they do not affect your statistical results and reports. The following procedure
shows how to set up an autotag rule.

1. Open the autotag window by right-clicking anywhere in the leftmost panel and selecting
Configure Autotag Rules.
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2. Set up a rule.

A. Add a rule.

Click the green + sign in the upper right corner of the Configure Autotag Rules
window.

B. Enter a variable.

Click theVariables tab, and then selectPeakLoad from the list. PeakLoad appears
in theCalculation panel.

C. Enter a function and a value.

In theCalculation panel, enter <1800 immediately followingPeakLoad.
D. Enter an error message.

Enter PeakLoad is less than 1.8kN in theError Message text box.
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E. ClickClose.

Notice that Test Run 3 is autotagged.While autotagging can conveniently tag test
runswith numerical data, it will not tag test runswithout numerical data. Always
review autotagging results to ensure the results are as expected.

Apply Autotag Rules
Autotag rules can be changed and applied before or after test runs.

1. Change or add autotag rules.

2. Click theRevert andRecalculate the Test Variables button to apply themodified auto-tag
rules to all test runs.

User-defined Variables in Auto-Tag Calculations Overview
If your Auto Tag rules contain calculations that contain constant(s) that could change for different
specimen or material types, you can create a variable to represent the constant.

For example, if you want to autotagmodulus calculations that fall outside of an acceptable range, you
could create two variables, one for the lower limit and one for the upper limit and create two auto-tag
rules.

Rule Number One: Calculation: Modulus<(Lower Limit Variable) Error Message: “Modulus is below
the lower limit.”

Rule Number Two: Calculation: Modulus>(Upper Limit Variable) Error Message: “Modulus is above
the upper limit.”

Optional - If you set each variable availability property to Pretest, the operator can enter the value for
each variable in the Setup Variables window that appears for each test run.
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Important: To avoid unit-conversion issueswith calculations, it is good practice to create a
variable to hold any constant value (that has a dimension and units associated with it) used in a
calculation. You can assign any units that you want to the variable and the application converts
them to the base units when the calculation is performed.

Use User-Defined Variables in Auto-Tag Calculations

1. Create variables to represent the constants that you want to use in the auto-tag calculation.

If you want the operator to enter a value for the auto-tag variable in a Setup Variables window
at the beginning of a test: In the variable properties, select thePretest check box.

2. Configure the Auto Tag Rules for the test.

In the Configure Auto Tag Ruleswindow, the auto-tag variable that you just created appears
in theVariables list. This variable can be inserted into any calculation that you create.

Markers
Amarker is a variable that defines a data point in a test run. Selectedmarkers appear in charts as a
symbol placed on a data point.

A marker variable can be defined by a calculation or when a run-time event occurs. In either case, the
marker variable saves an index into a data array. When themarker is added to a chart, its position
represents the x and y axis values associated with the index.

l Calculated - Marker values are typically derived from a calculation and are often used in a
calculation. For example, the least squares calculation for themodulus line uses two
calculatedmarker variables (Slope1 and Slope2) that appear on a chart.

l Run-time events- Markersmay also be assigned during a test by an operator through a digital
input to provide a visual cue that an event has occurred. For example, an operator may create
markers by pressing a key on the handset during a pull test to mark an event. A digital input
triggered during a test run can alsomark an event.

Marker Variables
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How are markers used?
Markers are primarily used in post-test analysis, reports, and calculations.

l Run-timemarkers provide a visual cue that an event has occurred during a test run.

l Yield, break, and peak load are examples of calculatedmarkers that mark events and whose
values are used in other calculations.

Can markers be moved?
Marker variables that are configured as Editable Post-Test can bemoved to a different location on the
curve.

For example, if there is an anomaly in test-run data at amarker data point, you canmove themarker to
a different location.

Because themarker represents an index value, moving themarker changes its index value and will
automatically change the value of any calculation that includes themarker.

Note:
To revert any changes caused bymovingmarkers, click the Revert and Recalculate the Test
Variables icon in the Review tab toolbar.

How do you create markers?
Manymarkers are predefined as part of anMTS template. For example, tensile templates include
predefined yield, break, peak-loadmarkers. In addition to predefined templatemarkers, there are
other ways to createmarkers:

l Create a new variable and configure it as amarker.

l Add run-timemarker capability to your test so that an operator or digital input can addmarkers
to a test run.

Note:
You can createmarkers after a test run to annotate a chart.

How do you display markers?
Each chart in theReview tab has a right-click option to Add or RemoveMarkers.

Rules for marker calculations
Calculation results for marker variablesmust return an index value.

For example the break IndexMarker expression BreakIndexByDropPerExt( _Load, BreakDrop,
PrimaryExt, BreakElongation) returns the peak index of the specified channel (in this instance, the _
Load channel).

In the following example, the break indexmarker (F) returned an index value of 74.When the break
indexmarker is added to the Load versus Extension chart, the value for index 74 from the load and
extension arrays are used to plot themarker.
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Marker Calculations

Marker examples
Peel tests - Move the start and endmarkers (usually a calculation that calculates the average value
between these twomarkers). You canmove themarkers to compensate for anomalies that occurred
during the test run.

Modulus calculations - Place B andMmarkers in the chart, the slope of themodulus line is calculated
using a least squares algorithm.

Run-Time Markers Overview
Run-timemarkers are user-initiatedmarkers used tomark an event that occurs while a test segment is
performed. For instance, if a specimen begins to tear before it fails, youmaywant to use a run-time
marker to mark the point when the tear began. To use run-timemarkers, youmust modify your test.

Run-timemarkers are typically set by a digital input triggered by one of the F keys (F1 or F2) on the
handset. You can also use hardwired digital inputs to trigger amarker.

Add or Remove Markers from a Chart
To add or remove amarker from a chart:

1. Right-click on a chart and selectAdd or Remove Markers.
2. Use the Variable Selection window to add or removemarkers.

3. ClickOK.
The changes youmade to themarkers do not affect themarkers in the other charts.

Move Markers in a Chart
You canmove chart markers to recalculate statistics and results.

1. Right-click on amarker and selectMove Selected Marker.
2. Move the cross hairs to the point on the curve where you want to move themarker to and click.

The circle and the coordinates indicate the position.

3. After themarker ismoved to the desired position, right-click themarker and deselect theMove
Selected Marker selection to turn off the cross hair feature.
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Note: To revert any changes caused bymovingmarkers, click theRevert and
Recalculate the Test Variables icon in theReview tab toolbar.

Edit Chart Markers
To edit a chart marker:

1. Right-click amarker and selectEdit Marker.
2. Use theMarker window to change the display name or themarker color.

3. ClickOK.

Invalid Markers Overview
An invalid (or missing) marker has a value that causes themarker to not appear on a chart.

Moving Invalid Markers
Tomove an invalid marker:

1. Right-click on the chart that has an invalid marker and clickMove Invalid Markers and select
themarker that you want to move.

2. Move the cross hairs to the point on the curve where you want themarker to and click.

3. After themarker ismoved to the desired position, right-click themarker and deselect theMove
Selected Marker selection to turn off the cross hair feature.

Extract Test Results
Create Test Reports

Reports Overview
TheReview tab toolbar can be used tomanually generate a report for a single test run or for a test (all
test runs).

To generate a report, youmust select a report template file that defineswhat information is shown in a
test report and how that information is formatted. The report template and the resulting report are
Microsoft Excel files.

TheMTS TestSuite application creates a test report by opening the report template, populating it with
the data from the test run, formatting the data, and saving the report as a separate report file.

Note: A report can be generated without Excel installed. The Reporter Add-In option is required
to create report templates.

Report Templates Overview
A report template is an Excel template file that defineswhat information is shown in a test report and
how that information appears. Report templates are created andmodified using theMTS TestSuite
Report tab that appears in theMicrosoft Excel application when the Reporter Add-In option is
installed.You can design report templates to generate reports for a single test run or for a test (all test
runs).
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Because the report template defines the information that appears in the report, different test types
(with unique sets of variables and other information) may require their own custom report templates.
Another use of report templates is to customize the type of information shown for a specific audience.

For more information
For more information on how to create report templates, see theReporter Add-In User Guide.

Select Default Report Template and Report Directories
To select default report template and report directories:

1. From thePreferencesmenu, clickConfiguration.
2. Click theProject tab and select the Project that you want to configure.
3. Select the default directories for storing report templates and generated reports.

Important: If you leave theReport Directory setting blank, test run reports are saved
with the test run.

Open, Print, Rename, or Delete Report
To open, print, rename, or delete a report:

1. On theActions drop-down list, clickView Reports.
2. The Reports window lists all of the reports generated for the current test.

3. Right-click any of the listed reports and select the appropriate action to open, print, rename, or
delete the report.

Generate a Report for a Test Run
To generate a report for a test run:

1. Select the test-run template that you want to use to create the report.

A. Click the drop-down arrow next to the Generate a report for the selected test run(s)
icon.

B. Click the report template that you want to use.

2. Click the Test Run Report icon.
The Excel application automatically starts and the test data for the test run is read into the
template.

Important: If you select (highlight) multiple test runs and click the report icon, you will
generate a separate report for each selected test run.

Generate a Single Report for the Test (all test runs)

1. Select the test-run template that you want to use to create the report.

A. Click the drop-down arrow next to the Generate a report that includes all test runs
icon.

B. Click the report template that you wish to use.
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2. Click the Test Report icon.
The Excel application automatically starts and the test data for the test run is read into the
template.

Extract Data and Images

Copy and Paste Rows
To copy and paste rows from the Results table to another application:

1. Click theReview tab.

2. In the Results table at the top of theReview tab, highlight the rows that you want to copy.

If you want to copy all the test runs, right-click on the Results table and clickSelect all Rows.
3. Right-click on the Results table and clickCopy.
4. Paste the copied cells into another application, such asMicrosoft Excel.

Copy Chart Data to Clipboard
To copy chart data to the clipboard:

1. Click theReview tab.

2. Right-click on a chart and clickCopy Values.
3. Paste the copied cells into another application, such asMicrosoft Excel.

Copy Chart Image
To copy a chart image:

1. Click theReview tab.

2. Right-click on a chart and clickCopy Image.
3. Paste the copied image into another application.

Save Chart Image
To save a chart image:

1. Click theReview tab.

2. Right-click on a chart and clickSave as Image.

Export Raw Data
You can export raw test-run data as tab- or comma-delimited text (.txt) files that can be used by other
applications.

Export Raw Data for a Test Run
To export raw data for a test run:

1. Click theReview tab.

2. In the Test Run table, right-click a test run and selectExport Raw Data.
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3. In the Export Raw DataWindow, define theExport Raw Data Properties. For property
definitions, see “Export Raw Data Properties” on page 304.

4. ClickOK.

Export Raw Data Properties

Item Description

Folder
Path

Defines the path to the directory in which the application writes the data file. The
default directory path is: “<Data Files>”. By default, “<Data Files>” points to C:\MTS
TestSuite\Data Files.

You can set the default directory path in the Configuration window (Preferences >
Configuration > Project > Data Export Directory).

Folder
Save

Defineswhether the application saves the data file in a new folder or overwrites an
existing folder.

Format Defineswhether the data is written as tab delimited text or comma separated values.

Unit Set Defines the unit set in which the data is written.

Data
Acquisition
List

Defines the DAQ (data acquisition) activities whose data will be included in the data
export. Each data export activity selected will result in a separate export file.

Signal List Defineswhich signal data will be included in the data export file.

Combine
Peak-
Valley on
One Line

Writes peak and valley values side-by-side in different columns on the same line to
facilitate comparison.

Filter
Minimum-
Maximum
Data

Writes a singleminimumand a singlemaximum value to the data file. This feature is
useful if you want only the single-most minimumand the single-most maximum values
in instanceswhere the application producesmultiple values for each (due to looping
or restarting the test).

If this feature is not enabled, the data file will contain aminimumand amaximum value
for each time activity run during the test

Export Raw Data Properties

Displays
A Display is a convenient way to save the layout of theReview tab including the number of panels,
panel sizing, and the views associated with each panel. Once saved, use the DisplayManager window
to select andmanage displays.

Save a Display
To save a display:
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1. Arrange the layout and appearance of the charts and tables in theReview tab.

2. Click theActions drop-down list and clickDisplay and thenSave Display As.

Switch to Previously Saved Display
To switch to a previously saved display:

1. Click theActions drop-down list and clickDisplay and thenSwitch to Display.
2. On theDisplaymenu, click a previously saved display.

Delete a Display
To delete a display:

1. Click theActions drop-down list and clickDisplay and thenOpen Display Manager.
2. Use the DisplayManager window to delete a previously saved display.

Note: You cannot delete the active display.
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Converting TestWorks 4 Methods and Sample Files
Fastpath:
Start menu > All Programs >MTS TestSuite > TestWorks 4 Converter

The TestWorks 4 Converter allows you to convert TestWorks 4methods and sample files, or entire
folders, so they can be used with theMTS TestSuite TW application.

There are differences in file formats and pre-set parameters (such as safety parameters) between the
two programs, therefore, youmust review each converted template or test to confirm the accuracy of
the conversion. Although the intent of the converter is to provide a completely converted file, MTS does
not guarantee that it can or will permit complete conversion of your TestWorks 4method or sample file
into anMTS TestSuite TW template or test.

Converting a TestWorks 4 Method or Sample File

TestWorks 4 Method and Sample File Converter
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1. Open the TestWorks 4 converter fromStart menu > All Programs >MTS TestSuite >
TestWorks 4 Converter.

2. Click the radio button for Test or Template conversion.
3. If applicable select any of the following options:

A. Convert for TW Essential—Creates a template that is editable in the
MTS TestSuite TWE application.

B. Omit disabled segments—Any disabled test segments in the TW4method will not
be converted into the resulting template.

C. Omit disabled inputs and formulas—Any disabled input or formula int he TW4
method will not be converted into the resulting template

4. Save to the default file location, or clickChange and browse for a different folder.
5. Drag your method or sample file or folder onto the converter window.

6. After the conversion process is complete, you will see amessage indicating success or failure.
Once converted, the test or template is stored in a sub-folder with the same name in the
default file location.

7. Open the converted test or create the test from the converted template and verify the
conversion results.

Importing TestWorks 4 Text Files
Fastpath:
Start menu > All Programs >MTS TestSuite > TestWorks 4 Converter
TheMTS TestSuite applications allow you to import information from a TestWorks 4 text file, such as a
LIMS file, into a TW test template to create a TW test file. You can use the TestWorks 4 conversion
utility to first convert your TestWorks 4method to a TW template.

After importing the text file, the TW test template will be populated with the imported information for the
correct number of test runs, global variable values, test run variable values, and the correct number of
points in array variables in the test runs. Aswith all import and conversion procedures, you should
review and/or run the test after the import process to verify that all information was imported properly.

Note:When you import the file, the imported resourcesmay not map to the controller resources
of the control system networked with your session or workstation. You will have to correct these
resource validation errors before using the test. For more information about resources, see
“Working with Resources” on page 82.

Before you import the file, verify the following:

l TheMTS TestSuite templatemust have the same name as the TestWorks 4method and be
placed in the templates folder (by default, it is C:\MTS TestSuite\Templates).

l TestWorks 4Global variablesmust be found in the Common variables section in the loaded
template or an error will be generated and the import processwill stop.
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Importing a TestWorks 4 Text File
1. On the TW application, select Filemenu > New > Test from TestWorks 4 text file. The TW

File Open window opens.

2. Select a TestWorks 4 text file. ClickOpen. A progresswindow appears as the new test is
created. Some errors or warningsmay be generated during the import process, which will be
logged at the end of the process. If one or more errors is found in the Global Variables section
of the text file, the test will not be created. If one or more errors is found in the Specimen (Test
Run) section of the text file, the corresponding Test Run will not be added to the test.

3. After the new MTS TestSuite test has been created, it opens in the TW application workspace
where you can test its validity.
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Overview
ConfiguringMTS TestSuite TW to communicate with a Eurotherm 2000 Series Temperature
Controller consists of five steps.

1. Connecting to the computer

2. Configuring the external device file

3. Importing controller resources

4. Addingmeters

5. Adding temperature control to the test flow

Note: To communicate with a single Eurotherm 2000 Series Temperature Controller, use
Configuring the External Device File for EI-Bisynch Single Zone. To communicate with
more than one Eurotherm 2000 Series Temperature Controllers, useConfiguring the
External Device File for EI-Bisynch Multi-Zone. Configured external device files can be
exported and imported onto a different system.
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Connecting to the Computer
Connect the serial cable from the Eurotherm 2000 Series Temperature Controller to a serial port on
your computer. If you are connecting to your computer through a B&B USB-to-Serial Converter such
asMTS Part Number 100-306-657, see the following instructions.

To connect to your computer using a B&B USB-to-Serial Converter:

1. Before connecting the B&B USB-to-Serial Converter (B&B) to the computer, insert the USB
Serial Driver CD.

2. Install the serial driver

3. Remove the USB Serial Driver CD

4. Open DeviceManager inWindows.

5. Plug in the B&B.

6. Right-click the port with the B&B connection to configure theProperties.

7. Verify that the B&B is working properly.
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8. Change theData bits to 7, theParity to Even, and clickAdvanced.

9. Verify that the advanced settingsmatch the following image.
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10. Verify that theDriver tab is similar to the following image.

11. Verify that theDetails tab is similar to the following image.
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Configuring the External Device File for EI-Bisynch
Single Zone
To configure an external device file to communicate with a single Eurotherm 2000 Series Temperature
Controller using the EI-Bisynch serial communication protocol:

1. On theControllermenu, clickExternal Devices.

2. In the External Deviceswindow, click the plus sign to add an external device file.

3. In the Select Device Type window, selectEurotherm 2000 Series Temperature
Controller EI-Bisynch.

4. On theDevice Configuration tab, use the drop-downmenu to select the appropriate serial



Appendix: Eurotherm 2000 Series Temperature Controller

318 MTS TestSuite™ TWEssential User Guide

port. Verify theDevice Address. Typically, for a single zone system theDevice Address is
1.

5. On thePort Settings tab, use the default values.

6. On theCommand Settings tab, use the default commands.
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7. On theSignal Settings tab, verify that theUnit selection is the same as the Eurotherm units.
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8. On theDevice Verification tab, select theRead Temperature command and clickSend
Command to verify communication.
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Configuring the External Device File for EI-Bisynch
Multi-Zone
To configure an external device file to communicate with multiple Eurotherm 2000 Series Temperature
Controllers using the EI-Bisynch serial communication protocol:

Note: Each Eurotherm 2000 Series Temperature Controller controls one temperature zone.

1. On theControllermenu, clickExternal Devices.

2. In the External Deviceswindow, click the plus sign to add an external device file.

3. In the Select Device Type window, selectEurotherm 2000 Series Temperature
Controller EI-Bisynch.
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4. On theDevice Configuration tab, use the drop-downmenus to select the appropriate serial
port and set theDevice Address to <none>.

5. On thePort Settings tab, use the default values.

6. On theCommand Settings tab, add commands to read temperature and set setpoint using
variable for each temperature zone. The command to read temperature is PV. The command
to set setpoint using variable is SL{0}. The address of the device for each temperature zone
precedes the command: 1PV, 1SL{0}, 2PV, 2SL{0}...

For the read temperature commands, add a descriptiveCommand Name, add the
Command, checkSupports Return Value, and add theRegular Expression Pattern: ^
[-]?\d+[.]?\d*$
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For the set setpoint using variable commands, add a descriptiveCommand Name, add the
Command, and select theWait for Acknowledgment check box.
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7. On theSignal Settings tab, add a signal for each read temperature command added on the
Command Settings tab.
Add a descriptive Internal Name andDisplay Names. Use the drop-downmenus to set the
Dimension to Temperature, to setUnit to match the units used by the Eurotherm, and to
select the appropriateRead Temperature command forQuery Command.
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8. On theDevice Verification tab, use the drop-downmenu to select eachRead Temperature
command and clickSend Command to verify communication.
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Importing Controller Resources
To import Eurotherm 2000 Series Temperature Controller controller resources into anMTS TestSuite
TWS test or template:

1. In the test or template on theDefine page selectResources, click Import Resources >
Import the selected controller resources

2. In the Import Controller Resourceswindow, expandExternal Devices and check
Eurotherm 2000 Series Temperature Controller, and expand Float Signals and check
the read temperature signals configured on theSignal Settings tab of the external device file.
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Note: Ensure that you select the read temperature signals and not the read
temperature Command signals.
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Adding Meters
To addmeters for temperature float signals from a Eurotherm 2000 Series Temperature Controller:

1. Right-click ameter and selectAdd Meter >More.

2. In theMeter Configuration window, clickSource to show the signals first. Scroll down to the
temperature signals. Click the arrow to add the temperature signals to the list of meters. Click
Apply to add themeters. ClickOK to close theMeter Configuration window.
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Adding Temperature Control Activity to Test Flow
To add temperature control to theMTS TestSuite TWS test flow to bring the system to a target
temperature, wait for a hold time, andmonitor the temperature through the test:

1. In the test or template on theDefine page in the test definition tree, selectAdvanced Mode
navigationmode and select Temperature.

2. ClickEnable, set the Target temperature, and set theHold Time.

3. Configure the Temperature Zones by using the drop-downmenus to select anExternal
Device, Setpoint Command, and Temperature Signal. Add additional temperature zones
if necessary.

4. Configure the Temperature Warning Limits. Only theMaximum Fluctuation and
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Warning Action are required. The Zone Gradient becomes active when a second
temperature zone is added.

5. Select theMonitor temperature through the test check box.
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Tuning Template Example Overview
The Load and Strain control modes added by the Advanced Rate Control software option require
correct PID and tuning parameter values. Determining the correct PID and tuning parameter values
for a test setup is an iterative process.

ThisMTS EMTuning Template Example can aid in determining the correct PID and tuning parameter
values for the Load control mode. A test created from this template repeatedly runsCommand
activities while you adjust PID and tuning parameter values.

The Test-Run Display shows two scopes and theCommand activity variables. The top scope shows
the Load signal and Load Command. The bottom scope shows the Load Error, that is, the difference
between the Load signal and Load Command. TheCommand activity variables are the Go To rates,
Go To end levels, and Dwell duration.

The test Procedure Run section contains twoWhile Loops in parallel. The firstWhile Loop contains
theCommand activities. TheCommand activities are aGo To, aDwell, and anotherGo To. The
secondWhile Loop contains an Input VariablesOperator Entry and a Tuning ParametersControl
Setting. While theCommand activities run repeatedly, the Input Variables window shows. You adjust
the PID and tuning parameter variables in the Input Variables window and apply then when you click
OK. The Input Variables window shows repeatedly so you can further adjust the PID tuning parameter
variables. The scopes show how the system responds to the new PID and tuning parameter values.

Once the correct PID and tuning parameter values are determined, use the Exit Variable in the Input
Variables window to exit theWhile Loops. After the test exits theWhile Loops, the PID and tuning
parameter variables are written to an XML file in the Data Export Directory of TestSuite. You can read
this XML file into a different test requiring the same PID and tuning parameter values.

ThisMTS EMTuning Template Example can be used inMTS TestSuite TWE, TWS, and TWX.
However, MTS TestSuite TWE is required tomakemodifications to theMTS Procedure/Test Flow.
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Tuning Template Example Key Features
TheMTS EMTuning Template Example:

• Can be used inMTS TestSuite TWE, TWS, and TWX. However, MTS TestSuite TWE is required to
makemodifications to theMTS Procedure/Test Flow.

• Can be used on either anMTS Insight or MTS InsightPlus based system.

• Provides an interface to determine the PID and tuning parameter values for a test setup running in
the Load control mode added by the Advanced Rate Control software option.

• Can be used for load rate or constant load.

• Can be changed from tension to compression by inverting the polarity on the Load and Crosshead
Float Signals.

• Writes PID and tuning parameter values to an XML file in the Data Export Directory. The resulting
XML file can be read into a different test requiring the same PID and tuning parameter values.

• Provides an interface to adjust PID and tuning parameter valueswhile the test is running.

• Shows scopeswhile the test is running, so the effects of the PID and tuning parameter value
adjustments can be observed.

• Shows the command and feedback signals from the test run in the review chart.
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How to Use the Tuning Template Example
TheMTS EMTuning Template Example is configured for a tension test using the Load Control Mode.
To run a compression test, invert the polarity on the Load and Crosshead Float Signals.

1. Verify that the Advanced Rate Control software option is installed:

A. Go toStart > All Programs >MTS TestSuite > License Administrator.
B. UnderOther Features, ensure that Custom.AdvancedRateControl appears.

2. Open theMTS TestSuite application.

3. Go toMTS Templates > TW-EM > Tuning >MTS EM Tuning Template Example.
4. Double-click theMTS EM Tuning Template Example to create a new test.

5. Install the specimen.

6. Clear the interlocks.

7. Click the run button.

8. Enter values for theMaterial Name, specimen dimensions, andCommand activity variables.
TheMaterial Name is used to name the XML file containing the PID and tuning parameter
values. Subsequent test runswill overwrite this file if theMaterial Name is not changed. To
run a constant load test, set End Level 1 andEnd Level 2 to the same value and increase
theDwell Duration.

9. Observe that initially the Load (blue line) does not respond to the Load Command (red line)
until the kP_Load variable is increased.

Note: Themaximum speed for metals is about 1mm/min. Themaximum speed for
rubber is about 10 to 100mm/min.

10. Increase the value of kP_Load by a factor of 10 and clickOK until a response is seen. Then
increase the valuemore gradually.

For example: 0.0010OK; 0.010OK; 0.1OK, 0.2OK...
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11. Increase kI_Load.

12. Increase kD_Load if necessary.

13. When tuning is complete, change theExit Variable to “Done” and clickOK to exit. The values
and chart are results on theReview page. The PID and tuning parameter values are saved to
an XML file in the Data Export Directory.
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Modify a Template to Import Tuning Parameters from
an XML File

1. Open the template to bemodified.

2. If necessary, import theControl Mode.
3. Select thePre-test run Data import. ThePre-test run Data importwill prompt before

every test run unless theData import is disabled.
4. Configure theData import as follows:

5. Select theCommand activity that is using the Advanced Rate Control or HD Control mode.

6. In theCommand activityProperties panel, select the control mode and checkUse Tuning
Parameters and click the Tuning Parameters icon.
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7. In the PID Parameters window, change the tuning parameters to variable selection.

8. To create variables for each tuning parameter, use the drop-downmenu and select <new
variable>.

9. Change the Identifier andDisplay Name. Ensure that the Identifiermatches exactly the
Identifier of the corresponding variable in the XML file.

10. Repeat Step 9 for the rest of the tuning parameters.

11. To use the same tuning parameters for multiple test runs, checkUse previous test run value
for each variable.

12. Go to File > Save As > Template...
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Using the Modified Template
1. Navigate to the XML file containing the applicable tuning parameters.

The imported valueswill display:

2. Click theClose button and the test continues as normal.
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